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Preface

This document describes and provides instructions for using the 
Hitachi Navigator 2 Advanced Settings.

Please read this document carefully to understand how to use this 
product, and maintain a copy for reference purposes.

This preface includes the following information:

Intended audience

Product version

Release notes and readme

Document revision level

Changes in this revision

Document organization

Document conventions

Convention for storage capacity values

Accessing product documentation

Getting help
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Intended audience
This document is intended for personnel who will schedule, manage, and 
perform the tasks required to prepare your site for installing a Hitachi AMS 
2000 Family storage system.

Product version
This document applies to Hitachi Storage Navigator Modular 2 version 12.69 
or later and Hitachi AMS 2000 Family firmware version 08C5/D or later.

Release notes and readme
Read the release notes and readme file before installing and using this 
product. They may contain requirements or restrictions that are not fully 
described in this document and/or updates or corrections to this document.

Document revision level

Revision Date Description

MK-97DF8039-00 May 2009 Initial Release

MK-97DF8039-01 June 2009 Revision 1, supersedes and replaces MK-
97DF8039-00

MK-97DF8039-02 August 2009 Revision 2, supersedes and replaces MK-
97DF8039-01

MK-97DF8039-03 November 2009 Revision 3, supersedes and replaces MK-
97DF8039-02

MK-97DF8039-04 December 2009 Revision 4, supersedes and replaces MK-
97DF8039-03

MK-97DF8039-05 January 2010 Revision 5, supersedes and replaces MK-
97DF8039-04

MK-97DF8039-06 April 2010 Revision 6, supersedes and replaces MK-
97DF8039-05

MK-97DF8039-07 June 2010 Revision 7, supersedes and replaces MK-
97DF8039-06

MK-97DF8039-08 August 2010 Revision 8, supersedes and replaces MK-
97DF8039-07

MK-97DF8039-09 September 2010 Revision 9, supersedes and replaces MK-
97DF8039-08

MK-97DF8039-11 November 2010 Revision 11, supersedes and replaces MK-
97DF8039-09 (Revision -10 was not released.)

MK-97DF8039-12 December 2010 Revision 12, supersedes and replaces MK-
97DF8039-11

MK-97DF8039-13 February 2011 Revision 13, supersedes and replaces MK-
97DF8039-12

MK-97DF8039-14 May 2011 Revision 14, supersedes and replaces MK-
97DF8039-13

MK-97DF8039-15 May 2011 Revision 15, supersedes and replaces MK-
97DF8039-14

MK-97DF8039-16 May 2011 Revision 16, supersedes and replaces MK-
97DF8039-15
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Changes in this revision
The following information has been added for this release:
• New note describing security vulnerability CVE-2014-3566 in SSLv3 in 

Setting the Server Certificate and Private Key on page 3-17.

Document organization
Thumbnail descriptions of the chapters are provided in the following table. 
Click the chapter title in the first column to go to that chapter. The first page 
of every chapter or appendix contains links to the contents.

MK-97DF8039-17 March 2012 Revision 17, supersedes and replaces MK-
97DF8039-16

MK-97DF8039-18 February 2015 Revision 18, supersedes and replaces MK-
97DF8039-17

MK-97DF8039-19 March 2015 Revision 19, supersedes and replaces MK-
97DF8039-18

Revision Date Description

Chapter/Appendix
Title Description

Chapter1, Overview This chapter provides information on installing Navigator
2 under different platforms, including installing, updating,
and removing

Chapter 2, Getting 
Started

This chapter provides a functional overview of Navigator
2.

Chapter 3, Launching the 
Application

This chapter details the launch process on the Host and
Client side, port number information, and SSL
information.

Chapter 4, Advanced 
Settings

This chapter provides details on how to start advanced
settings java applet and access the available functions.

Chapter 5, Hitachi 
Storage Navigator 
Modular 2 on 9500 
VIAMS/WMS Arrays

This chapter provides information on how to use
Navigator 2 to view and manage legacy Hitachi storage
systems.

Appendix A, Collecting 
Navigator 2 Diagnostic 
Information

This appendix provides details on how to obtain Navigator
2 diagnostic information.

Appendix B, 
Performance Output Text 
File Information

This appendix provides details of the performance output
text file.
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Document conventions
This document uses the following symbols to draw attention to important 
safety and operational information.

The following typographic conventions are used in this document.

Symbol Meaning Description

Tip Tips provide helpful information, guidelines, or suggestions for 
performing tasks more effectively.

Note Notes emphasize or supplement important points of the main 
text.

Caution Cautions indicate that failure to take a specified action could 
result in damage to the software or hardware.

WARNING Warnings indicate that failure to take a specified action could 
result in loss of data or serious damage to the hardware.

DANGER The Danger symbol warns users of possible injury or death if 
instructions are not followed. 

cv ELECTRIC 
SHOCK 
HAZARD!

This symbol warns users of electric shock hazard. Failure to 
take appropriate precautions such as not opening or touching 
hazardous areas of the equipment could result in injury or 
death.

Electrostatic 
Sensitive

The ESD symbol warns users that the equipment is sensitive 
to electrostatic discharge (ESD) and could be damaged if users 
do not take appropriate precautions such as using a grounded 
wrist strap when touching or handling the equipment.

Burn Hazard HOT SURFACE! Turn off power and allow to cool before 
touching.

Sharp Edges 
or Corners

WARNING! Sharp edges or corners. Avoid touching or wear 
gloves.

Convention Description

Bold Indicates text on a window, other than the window title, including 
menus, menu options, buttons, fields, and labels. Example: Click OK.

Italic Indicates a variable, which is a placeholder for actual text provided by 
the user or system. Example: copy source-file target-file
Angled brackets (< >) are also used to indicate variables.

screen/code Indicates text that is displayed on screen or entered by the user. 
Example: # pairdisplay -g oradb

< > angled 
brackets

Indicates a variable, which is a placeholder for actual text provided by 
the user or system. Example: # pairdisplay -g <group>

Italic font is also used to indicate variables.

[ ] square 
brackets

Indicates optional values. Example: [ a | b ] indicates that you can 
choose a, b, or nothing.

{ } braces Indicates required or expected values. Example: { a | b } indicates that 
you must choose either a or b.
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Convention for storage capacity values
Physical storage capacity values (e.g., disk drive capacity) are calculated 
based on the following values:

Logical storage capacity values (e.g., logical device capacity) are calculated 
based on the following values:

Accessing product documentation
The AMS 2000 Family user documentation is available on the Hitachi Data 
Systems Portal: https://portal.hds.com. Please check this site for the most 
current documentation, including important updates that may have been 
made after the release of the product.

This documentation set consists of the following documents.

Release notes
• Adaptable Modular Storage System Release Notes
• Storage Navigator Modular 2 Release Notes

| vertical bar Indicates that you have a choice between two or more options or 
arguments. Examples:
[ a | b ] indicates that you can choose a, b, or nothing.
{ a | b } indicates that you must choose either a or b.

underline Indicates the default value. Example: [ a | b ]

Convention Description

Physical capaciy unit Value

1 KB 1,000 bytes

1 MB 1,000 KB or 1,0002 bytes

1 GB 1,000 MB or 1,0003 bytes

1 TB 1,000 GB or 1,0004 bytes

1 PB 1,000 TB or 1,0005 bytes

1 EB 1,000 PB or 1,0006 bytes

Logical capaciy unit Value

1 block 512 bytes

1 KB 1,024 (210) bytes

1 MB 1,024 KB or 10242 bytes

1 GB 1,024 MB or 10243 bytes

1 TB 1,024 GB or 10244 bytes

1 PB 1,024 TB or 10245 bytes

1 EB 1,024 PB or 10246 bytes

Please read the release notes before installing and/or using this product. 
They may contain requirements and/or restrictions not fully described in 
this document, along with updates and/or corrections to this document.

https://portal.hds.com
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Installation and getting started

The following documents provide instructions for installing an AMS 2000 
Family storage system. They include rack information, safety information, 
site-preparation instructions, getting-started guides for experienced users, 
and host connectivity information. The symbol ? identifies documents that 
contain initial configuration information about Hitachi AMS 2000 Family 
storage systems.

AMS2100/2300 Getting Started Guide, MK-98DF8152
Provides quick-start instructions for getting an AMS 2100 or AMS 2300 
storage system up and running as quickly as possible.

AMS2500 Getting Started Guide, MK-97DF8032
Provides quick-start instructions for getting an AMS 2500 storage 
system up and running as quickly as possible.

AMS 2000 Family Site Preparation Guide, MK-98DF8149
Contains site planning and pre-installation information for AMS 2000 
Family storage systems, expansion units, and high-density expansion 
units. This document also covers safety precautions, rack information, 
and product specifications.

AMS 2000 Family Fibre Channel Host Installation Guide, 
MK-08DF8189

Describes how to prepare Hitachi AMS 2000 Family Fibre Channel 
storage systems for use with host servers running supported operating 
systems.

AMS 2000 Family iSCSI Host Installation Guide, MK-08DF8188
Describes how to prepare Hitachi AMS 2000 Family iSCSI storage 
systems for use with host servers running supported operating systems.

Storage and replication features

The following documents describe how to use Storage Navigator Modular 2 
(Navigator 2) to perform storage and replication activities.

Storage Navigator 2 Advanced Settings User’s Guide, MK-97DF8039
Contains advanced information about launching and using Navigator 2 
in various operating systems, IP addresses and port numbers, server 
certificates and private keys, boot and restore options, outputting 
configuration information to a file, and collecting diagnostic information.
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Storage Navigator Modular 2 User’s Guide, MK-99DF8208
Describes how to use Navigator 2 to configure and manage storage on 
an AMS 2000 Family storage system.

AMS 2000 Family Dynamic Provisioning Configuration Guide, 
MK-09DF8201

Describes how to use virtual storage capabilities to simplify storage 
additions and administration.

Storage Navigator 2 Storage Features Reference Guide for AMS, 
MK-97DF8148

Contains concepts, preparation, and specifications for Account 
Authentication, Audit Logging, Cache Partition Manager, Cache 
Residency Manager, Data Retention Utility, LUN Manager, Performance 
Monitor, SNMP Agent, and Modular Volume Migration.

AMS 2000 Family Copy-on-write SnapShot User Guide, MK-97DF8124
Describes how to create point-in-time copies of data volumes in AMS 
2100, AMS 2300, and AMS 2500 storage systems, without impacting 
host service and performance levels. Snapshot copies are fully read/
write compatible with other hosts and can be used for rapid data 
restores, application testing and development, data mining and 
warehousing, and nondisruptive backup and maintenance procedures.

AMS 2000 Family ShadowImage In-system Replication User Guide, 
MK-97DF8129

Describes how to perform high-speed nondisruptive local mirroring to 
create a copy of mission-critical data in AMS 2100, AMS 2300, and AMS 
2500 storage systems. ShadowImage keeps data RAID-protected and 
fully recoverable, without affecting service or performance levels. 
Replicated data volumes can be split from host applications and used for 
system backups, application testing, and data mining applications while 
business continues to operate at full capacity.

AMS 2000 Family TrueCopy Remote Replication User Guide, 
MK-97DF8052

Describes how to create and maintain multiple duplicate copies of user 
data across multiple AMS 2000 Family storage systems to enhance your 
disaster recovery strategy.

AMS 2000 Family TrueCopy Extended Distance User Guide, 
MK-97DF8054

Describes how to perform bi-directional remote data protection that 
copies data over any distance without interrupting applications, and 
provides failover and recovery capabilities.
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AMS 2000 Data Retention Utility User’s Guide, MK-97DF8019
Describes how to lock disk volumes as read-only for a certain period of 
time to ensure authorized-only access and facilitate immutable, tamper-
proof record retention for storage-compliant environments. After data is 
written, it can be retrieved and read only by authorized applications or 
users, and cannot be changed or deleted during the specified retention 
period.

Storage Navigator Modular 2 online help
Provides topic and context-sensitive help information accessed through 
the Navigator 2 software.

Hardware maintenance and operation

The following documents describe how to operate, maintain, and administer 
an AMS 2000 Family storage system. They also provide a wide range of 
technical information and specifications for the AMS 2000 Family storage 
systems. The symbol ? identifies documents that contain initial configuration 
information about Hitachi AMS 2000 Family storage systems.

AMS 2100/2300 Storage System Hardware Guide, MK-97DF8010
Provides detailed information about installing, configuring, and 
maintaining an AMS 2100/2300 storage system.

AMS 2500 Storage System Hardware Guide, MK-97DF8007 — this 
document

Provides detailed information about installing, configuring, and 
maintaining an AMS 2500 storage system.

AMS 2000 Family Storage System Reference Guide, 
MK-97DF8008

Contains specifications and technical information about power cables, 
system parameters, interfaces, logical blocks, RAID levels and 
configurations, and regulatory information about AMS 2100, AMS 2300, 
and AMS 2500 storage systems. This document also contains remote 
adapter specifications and regulatory information.

AMS 2000 Family Storage System Service and Upgrade Guide, 
MK-97DF8009

Provides information about servicing and upgrading AMS 2100, AMS 
2300, and AMS 2500 storage systems.

AMS 2000 Family Power Savings User Guide, MK-97DF8045
Describes how to spin down volumes in selected RAID groups when they 
are not being accessed by business applications to decrease energy 
consumption and significantly reduce the cost of storing and delivering 
information.
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Command and Control (CCI)

The following documents describe how to install the Hitachi AMS 2000 
Family Command Control Interface (CCI) and use it to perform TrueCopy 
and ShadowImage operations.

AMS 2000 Family Command Control Interface (CCI) Installation 
Guide, MK-97DF8122

Describes how to install CCI software on open-system hosts.

AMS 2000 Family Command Control Interface (CCI) Reference 
Guide, MK-97DF8121

Contains reference, troubleshooting, and maintenance information 
related to CCI operations on AMS 2100, AMS 2300, and AMS 2500 
storage systems.

AMS 2000 Family Command Control Interface (CCI) User’s Guide, 
MK-97DF8123

Describes how to use CCI to perform TrueCopy and ShadowImage 
operations on AMS 2100, AMS 2300, and AMS 2500 storage systems.

Command Line Interface (CLI)

The following documents describe how to use Hitachi Storage Navigator 
Modular 2 to perform management and replication activities from a 
command line.

Storage Navigator Modular 2 Command Line Interface (CLI) Unified 
Reference Guide, MK-97DF8089

Describes how to interact with all Navigator 2 bundled and optional 
software modules by typing commands at a command line.

Storage Navigator 2 Command Line Interface Replication Reference 
Guide for AMS, MK-97DF8153

Describes how to interact with Navigator 2 to perform replication 
activities by typing commands at a command line.
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Dynamic Replicator documentation

The following documents describe how to install, configure, and use Hitachi 
Dynamic Replicator to provide AMS Family storage systems with continuous 
data protection, remote replication, and application failover in a single, 
easy-to-deploy and manage platform.

Dynamic Replicator - Scout Release Notes, RN-99DF8211

Dynamic Replicator - Scout Host Administration Guide, MK-98DF8212

Dynamic Replicator - Scout Installation and Configuration Guide, 
MK-98DF8213

Dynamic Replicator - Scout Quick Start Guide, MK-98DF8214

Dynamic Replicator - Scout Host Troubleshooting Guide, 
MK-98DF8215

Dynamic Replicator DR-Scout ICAT Utility Guide, MK-98DF8216

Dynamic Replicator - Scout RX Server Deployment Guide, 
MK-98DF8217

Dynamic Replicator VX Solution for Oracle (Solaris), MK-98DF8218

Dynamic Replicator - Scout Solution for SharePoint 2007, 
MK-98DF8219

Dynamic Replicator - Scout Solution for MySQL (Windows), 
MK-98DF8220

Protecting Citrix XenServer Using Hitachi Dynamic Replicator - 
Scout, MK-98DF8221

Dynamic Replicator Quick Install/Upgrade Guide, MK-98DF8222

Dynamic Replicator - Scout Protecting MS SQL Server, MK-98DF8223

Dynamic Replicator - Scout - Protecting Microsoft Exchange Server, 
MK-98DF8224

Dynamic Replicator - Scout File Server Solution, MK-98DF8225

Dynamic Replicator - Scout ESX - Protecting ESX Server (RCLI), 
MK-99DF8226
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Getting help
If you need to contact the Hitachi Data Systems support center, please 
provide as much information about the problem as possible, including:
• The circumstances surrounding the error or failure.
• The exact content of any messages displayed on the host system(s).
• The exact content of any messages displayed on Storage Navigator 

Modular 2.
• The Storage Navigator Modular 2 configuration information. This 

information is used by service personnel for troubleshooting purposes.

The Hitachi Data Systems customer support staff is available 24 hours a 
day, seven days a week. If you need technical support, please log on to the 
Hitachi Data Systems Portal for contact information: https://portal.hds.com

Comments
Please send us your comments on this document:doc.comments@hds.com. 
Include the document title, number, and revision, and refer to specific 
section(s) and paragraph(s) whenever possible.

Thank you! (All comments become the property of Hitachi Data Systems.)

https://portal.hds.com
doc.comments@hds.com
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1
Overview

This chapter provides important notes regarding the installation 
environment and OS platform support.

Notes on Using Hitachi Storage Navigator Modular 2

Environment

Installing Hitachi Storage Navigator Modular 2
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Notes on Using Hitachi Storage Navigator Modular 2
When using Hitachi Storage Navigator Modular 2, consider the following:
• All of the output files from Applet screens of Hitachi Storage 

NavigatorModular 2 are sent to the host side. Specify all of the files that 
Applet screens of Hitachi Storage Navigator Modular 2 inputs Hitachi 
Storage Navigator Modular 2 activates as files on the host side.

• Hitachi Storage Navigator Modular 2 functions of cannot be used unless 
a TCP/IP communication is made between the array unit and the host. 
Verify that the TCP/IP is set correctly.

• Some Hitachi Storage Navigator Modular 2 functions are not available 
while the array unit is online with a host.

• When a high I/O load exists, the functions that are available while 
online might cause a command time-out in the host or a recovering 
fault in Hitachi Storage Navigator Modular 2. Hitachi recommends that 
these functions be executed while offline.

• When Hitachi Storage Navigator Modular 2 is installed in the host 
connected to an array unit, I/O loading from a host might cause a 
command time-out on the host side or an abnormal termination on 
Hitachi Storage Navigator Modular 2 side.

• Installing Hitachi Storage Navigator Modular 2 in a host that does not 
connect an array unit is recommended.

• When the host enters the suspension status (low power mode) while 
Hitachi Storage Navigator Modular 2 is running, Hitachi Storage 
Navigator Modular 2 might not operate correctly after the host is 
released from the suspension status.

• When you operate Hitachi Storage Navigator Modular 2, disable power 
management through Windows® so that the host will not enter the 
suspension status.

• Hitachi Storage Navigator Modular 2 allows Array unit screens to open 
for one array unit. When performing operations by opening Array unit 
screens for one array unit, operations may terminate abnormally. Open 
only one Array unit screen for one array unit to operate an array unit.

• If Hitachi Storage Navigator Modular 2 does not succeed in connecting 
to the array unit, the following message may display:

An invalid response was received from the subsystem

This message indicates that Hitachi Storage Navigator Modular 2 may 
have been connected to the array unit while the array unit automatically 
rebooted. Reconnect to the array unit after 3 minutes.

• Hitachi Storage Navigator Modular 2 may hang up in the following 
cases:
• The communication with the connected array unit fails due to 

controller blockage, array unit failure, disconnected LAN 
connection, or the array unit receives a Reset/LIP from the host.

• Other applications are working concurrently and memory utilization 
or a CPU use rate is high.

• Disconnecting LAN connection of the host and client sides.
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If Hitachi Storage Navigator Modular 2 hangs up, check the array unit 
status and the connection status of the LAN, terminate Hitachi Storage 
Navigator Modular 2, and restart Hitachi Storage Navigator Modular 2. 
When not recovered, stop the SNM2 Server service (daemon process), 
check the array unit status and the connection status of the LAN, restart 
the SNM2 Server service (daemon process).

• In the following case, display time of Hitachi Storage Navigator Modular 
2 may be longer while operating Hitachi Storage Navigator Modular 2.
• The communication with the connected array unit fails
• Failures of the array unit (controller blockade, etc.)
If display time gets longer in Hitachi Storage Navigator Modular 2, check 
the status of the array unit and the connection status of the LAN, 
terminate Hitachi Storage Navigator Modular 2, and restart Hitachi 
Storage Navigator Modular 2. If the array unit has a failure, operate by 
registering the array unit as the controller of one side. If the controller 
is blocked, you cannot connect to Hitachi Storage Navigator Modular 2. 
Operate it by registering the normal controller side until the controller 
blockade is recovered.

• The Java™ Applet Window may be displayed at the bottom of a screen 
item (such as a dialog box, popup menu, combo box) on a Hitachi 
Storage Navigator Modular 2 panel on versions before 6.0. This is not 
an error.

• When Hitachi Storage Navigator Modular 2 connects the array unit over 
a LAN, it uses the TCP/IP port number of 2000. The TCP/IP port number 
of the array unit is set as 2000 by default.

• The restrictions listed in Table  exist if Hitachi Storage Navigator 
Modular 2 is used in combination with other programs for one array 
unit:

Host Interface Number of Ports (total) Cache (total)

Hitachi Storage Navigator 
Modular 2

• SNMP Function 
• Disk Array -built-in 
WebServer Function

• Hitachi Storage 
Navigator Modular 2
• Storage Navigator 
Modular for Web

Storage Navigator Modular 
Web

• SNMP Function 
• Disk Array -built-in 
WebServer Function

• Hitachi Storage 
Navigator Modular 2
• Storage Navigator 
Modular for Web

SNMP Function

• Hitachi Storage 
Navigator Modular 2
• Storage Navigator 
Modular for Web
• SNMP Function 
• Disk Array -built-in 
Web Server Function

N/A
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To operate other programs, refer to their respective user’s guides, which 
are provided with the program products
It is necessary to change a port number to specify in Hitachi Storage 
Navigator Modular 2 installation to install it in the host same as Storage 
Navigator Modular (for Web). Storage Navigator Modular (for Web) uses 
1099 in default. Set a port number to specify from 1099 of the default 
to the recommended value 25000 or more in Hitachi Storage Navigator 
Modular 2 installation. If the same port number is set, Storage Navigator 
Modular (for Web) or Hitachi Storage Navigator Modular 2 does not run 
normally.
When connecting the array unit with Hitachi Storage Navigator Modular 
2 over a LAN, the array unit may not be able to connect because a time-
out of the data transfer occurs. This will depend on the LAN 
environment. When Hitachi Storage Navigator Modular 2 cannot be 
connected with the array unit, verify that the connection is correct using 
the ping command. If a response to the ping command is normal, the 
LAN environment may affect the data transfer. The length of data to be 
transferred can be changed with the “lanconf.inf” file in the directory in 
which Hitachi Storage Navigator Modular 2 is installed. The default 
setting is “32768”. Change the setting to “16384” or “8192”, in this order 
or to a multiple of 1024, and then retry. The new setting becomes 
effective from the next operation. A restart of Hitachi Storage Navigator 
Modular 2 is not required. Operation of Hitachi Storage Navigator 
Modular 2 may take some time, depending on the setting. If the 
connection cannot be made regardless of the setting change, review the 
LAN environment.

Disk array built-in Web 
Server Function

• Hitachi Storage 
Navigator Modular 2
• Storage Navigator 
Modular for Web
• SNMP Function 
1. Disk Array -built-in 
Web Server Function

N/A

Host Interface Number of Ports (total) Cache (total)

NOTE: You can have two concurrent instances of Hitachi Storage 
Navigator Modular 2, provided that they are not connected to the same 
array system. If one instance terminates forcibly, that may affect the other 
instance
Additionally, if one Hitachi Storage Navigator Modular 2 terminates forcibly 
while using two Hitachi Storage Navigator Modular 2 products 
simultaneously, another Hitachi Storage Navigator Modular 2 may 
terminate abnormally. If this occurs, operate Hitachi Storage Navigator 
Modular 2 that has abnormally terminated again,
If you run a combination of programs in which concurrent use is not 
allowed, when a program with a usage restriction placed on it has been 
started, start another program with that combination after terminating the 
running program.
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If you execute the command during the firmware updating or controller 
recovery, the LAN becomes unusable and the operation may fail. In this 
case, execute it again after completing the firmware updating or 
controller maintenance.
If an array unit failure is detected, contact the Hitachi Customer 
Engineer. 
Do not use the reserved words prescribed for each OS and device names 
that indicate the input/output destinations as a file name when a file is 
output. Windows includes “con”, “pm”, “aux”, etc. For example, when 
con is specified as an output file name, an error message displays.
If Google Toolbar is installed in the browser, some functions may not run 
normally. Do not install Google Toolbar in the browser to display Hitachi 
Storage Navigator Modular 2.
Do not use the character size other than that of the display. The screen 
maynot be displayed correctly by changing the browser setting. When 
you change the screen, operate Hitachi Storage Navigator Modular 2 
screen. If you operate it with the Back Space key, the screen may not 
be displayed correctly.
Hitachi Storage Navigator Modular 2 does not support the screen 
transition function of the Web browser. For Internet Explorer, the 
following operation methods are available for returning to the Web 
screen displayed just before. However, if you execute those methods in 
Hitachi Storage Navigator Modular 2, the screen may not change.
• Pressing the Back Space key.
• Pressing the right arrow (->) key while holding down the Alt key.
• Operating the mouse wheel while holding down the Shift key. 
• Selecting Back of the menu displayed by right-clicking, etc.
If you execute any of the above operations (1), (2), and (3) in the screen 
displayed by clicking the Create or Edit button, the screen Now 
loading is displayed and it may not change. In this case, close the 
screen by pressing the X button on the upper right of the screen and 
execute the operation again. If you have executed it in the other screen, 
display the screen by selecting the other tree or close the screen by 
pressing the X button on the upper right of the screen and execute the 
operation again.

• Do not delete it by selecting the installation directory of Hitachi Storage 
Navigator Modular 2. If you delete the installation directory, not only 
the operation of the operation becomes impossible but also installation 
and uninstallation become impossible, and reinstallation of the OS may 
be required.

• If without installing JRE and operate it from the client of Hitachi Storage 
Navigator Modular 2, the Applet screen and ACE tool screen are 
displayed as shown in the figure below. Terminate Hitachi Storage 
Navigator Modular 2, install JRE correctly, and then execute Hitachi 
Storage Navigator Modular 2 again.
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Figure 1-1:  Applet screen and ACE tool screen

• A problem such that Hitachi Storage Navigator Modular 2 screen is not 
displayed correctly and pressing the button does not work depending 
on the setting of the browser security. When using Internet Explorer 6 
as a client, register the IP address of the server of Hitachi Storage 
Navigator Modular 2 or a host name in the “Trusted sites”. Besides, 
check that the following items are enabled in the setting of the “Trusted 
sites” security. (They are enabled in the default setting.)
• Run ActiveX controls and plug-ins
• Script ActiveX controls marked safe for scripting
• Active scripting
• Submit nonencrypted form data

• When Japanese is registered as a language of the browser, the display 
is shown in Japanese regardless of an OS language and characters are 
not displayed correctly if using an OS language other than Japanese. 
When using an OS language other than Japanese, do not add Japanese 
to the rowser language. When English is registered as a language of the 
browser being placed above Japanese, characters are displayed in 
English. The Applet screen is displayed in Japanese when using 
Japanese or in English when using an OS language other than Japanese 
regardless of the registration of languages.

• When connecting Hitachi Storage Navigator Modular 2 by IPv6, if the 
temporary address of IPv6 is set to Enabled in the installed computer 
and many temporary addresses are registered, the processing time 
becomes long. Check the temporary addresses and if many are set, 
disable them.
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• The IPv6 multicast of the link local scope is used for the array search by 
the IPv6 address. When performing the array search, set up the array 
and the computer in which Hitachi Storage Navigator Modular 2 is 
installed in the same link.

• While executing the setting/reference operation by Navigator 2, the 
performance of the storage system for the host I/O may deteriorate. 
Also, if you execute multiple settings/references by Navigator 2 at the 
same time, the storage system performance for the host I/O may 
deteriorate compared to the single execution. Hitachi recommends you 
perform the operations to the storage system at once during host I/O 
execution be less than five (less than two for 9500V).

• The setting/reference operations that one array can receive from 
Navigator 2 at once have the upper limits as shown in the following 
table.

If you try to execute the maximum number of operations that can be 
received at once for one array, the following errors may occur.

Environment
Hitachi Storage Navigator Modular 2 is operated by connecting to the 
array unit over a LAN. When an array unit is connected to a LAN, the 
host, in which Hitachi Storage Navigator Modular 2 is installed, must be 
connected with the network and must operate normally.

Revisions of the array and firmware
The maximum number of 

operations that can be 
received

AMS 2000 08C5/A 50 operations
Less than 08C5/A 5 operations

SMS All revisions 5 operations

AMS/WMS All revisions 5 operations

9500V All revisions 2 operations

Message Code Error Code The maximum number of operations that 
can be received

DMEA000006 0x00060000 Failed to connect with the subsystem. Confirm 
the subsystem status and the LAN 
environment, and then try again.

DMEA000007 0x00070000 An invalid response was received from the 
subsystem. Confirm the subsystem status and 
the LAN environment, and then try again.

DMEA00000B 0x00001002 Failed to transfer data. Confirm the subsystem 
status and the LAN environment, and then try 
again.
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Windows

Host OS support

• Virtual OS: The following table shows the supported Windows platforms 
for virtual OS:

Table 1-1:  Virtual Operating System Specifications

• Operating environment of guest OS is same as normal operating 
environments

The following specifications show the operating environments of Hitachi 
Storage Navigator Modular 2:

Operating System
Remarks

Name Service Pack

Windows XP (x86) SP2, SP3

Windows Server 2003 
(x86)

SP1, SP2

Windows Server 2003 R2 
(x86)

Non SP, SP2

Windows Server 2003 R2 
(x64)

Non SP, SP2

Windows Vista (x86) SP1

Windows Server 2008 
(x86)

Non SP, SP2

Windows Server 2008 
(x64)

Non SP, SP2

Windows 7 (x86) Non SP, SP1

Windows 7 (x64) Non SP, SP1

Windows Server 2008 R2 
(x64)

Non SP, SP1

NOTE: The 64-bit Windows platform is not supported except Windows 
Server 2003 R2 (x64), Windows Server™ 2008 (x64), Windows 7 (x64) 
(AMS 2000 only), or Windows Server 2008 R2 (x64) (AMS 2000 only).

Host Operating System Guest Operating System

VMWare ESX Server 3.x Windows XP
Windows Server 2003 R2

VMware 4.1 Windows Server 2008 SP2 (x64)
Windows Server 2008 R2 (x64)

Windows Server 2008 R2 (x64)
(Hyper-V2) Windows Server 2008 R2 (x64)
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• CPU: Minimum 1 GHz (2 GHz or more is recommended)
• Memory: 1 GB or more (2 GB or more is recommended) 

When using Hitachi Storage Navigator Modular 2 and other software 
products together, the memory capacity totaling the value of each 
software product is required.

• Available disk capacity: A free capacity of 1.5 GB or more is required.

Client
• OS: Windows 2000 (SP3, SP4), Windows XP (SP2), Windows Server 

2003 (SP1, SP2), Windows Server 2003 R2, Windows Server 2003 R2 
(x64), Windows Vista, Windows Server™ 2008 (Non SP, SP1) for both 
x32 and x64, Windows 7 (x64) (86) (AMS 2000 only). The 64-bit 
Windows is not supported except Windows Server 2003 R2 (x64), 
Windows 7 x64) (AMS 2000 only), or Windows Server™ 2008 R2 (x64) 
(AMS 2000 only).
Windows XP and Windows Server 2003 R2 operate as a GUEST OS of the 
VMWare ESX Server 3.1.x. 
You must apply the newest (KB922760 or newly) Windows Update.

• Browser: IE6.0 (SP1, SP2, SP3) or IE7.0. The 64-bit IE6 (SP1, SP2, 
SP3) on Windows Server 2003 R2 (x64) and the 64-bit-IE7.0 on 
windows Server 2008 (x64) is supported.

• Only IE8.0 (x86, x64) is supported on Windows 7 and Windows Server 
2008 R2.

• JRE: JRE 1.6.0_30, 1.6.0_25, JRE 1.6.0_22, 1.6.0_20, 1.6.0_15, 
1.6.0_13, 1.6.0_10. The 64-bit JRE is not supported. For more 
installation about JRE, refer to java download page.
The JRE download from http://java.com/en/download/, and then install 
JRE.
When you operate AMS 2000 and SMS 100, installation of JRE is not 
necessary.
When you operate 9500V and AMS/WMS, install JRE.

• CPU: (1 GHz or more is recommended)
• Memory: 1 GB or more (2 GB or more is recommended)

When using Hitachi Storage Navigator Modular 2 and other software 
products together, the memory capacity totaling the value of each 
software product is required.

• Available disk capacity: A free capacity of 800 MB or more is required.
• Monitor: Resolution 800 × 600, 1,024 × 768 or more is recommended, 

256 color or more.

Red Hat Linux

Host
• OS: Red Hat Enterprise Linux AS 4.0 (x86) update1, Red Hat Enterprise 

Linux AS 4.0 (x86) update5, Red Hat Enterprise Linux 5.3 (x86) 
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(excluding SELinux), Red Hat Enterprise, Linux 5.4 (x86) (excluding 
SELinux), Red Hat Enterprise Linux 5.4 (x64) (excluding SELinux), Red 
Hat Enterprise Linux 5.5 (x86) (excluding SELinux), Red Hat Enterprise 
Linux 5.5 (x64) (excluding SELinux), Red Hat Enterprise Linux 5.6 
(x86, x64, excluding SELinux)
Not supported update from Red Hat Enterprise Linux AS 4.0 to update. 
Supported only x86 environment.

• CPU: Minimum 1 GHz (2 GHz or more is recommended)
• Memory: 1 GB or more (2 GB or more is recommended)

When using Hitachi Storage Navigator Modular 2 and other software 
products together, the memory capacity totaling the value of each 
software product is required.

• Available disk capacity: A free capacity of 1.5 GB or more is required.

Client
• OS: Red Hat Enterprise Linux AS 4.0 (x86) update1, Red Hat Enterprise 

Linux AS 4.0 (x86) update5, Red Hat enterprise Linux 5.3 (x86) 
(excluding SELinux), Red Hat Enterprise Linux 5.4 (x86) (excluding 
SELinux), Red Hat Enterprise Linux 5.4 (x64) (excluding SELinux), Red 
Hat Enterprise Linux 5.5 (x86) (excluding SELinux), Red Hat Enterprise 
Linux 5.5 (x64) (excluding SELinux).
Not supported update from Red Hat Enterprise Linux AS 4.0 to update. 
Supported only x86 environment.

• Browser: Mozilla 1.7
• JRE: JRE 1.6.0_22, 1.6.0_20, 1.6.0_15, 1.6.0_13, 1.6.0_10.

The JRE download from http://java.com/en/download/, and then install 
JRE.

• CPU: (1 GHz or more is recommended)
• Memory: 1 GB or more (2 GB or more is recommended)

When using Hitachi Storage Navigator Modular 2 and other software 
products together, the memory capacity totaling the value of each 
software product is required.

• Available disk capacity: A free capacity of 100 MB or more is required.
• Monitor: Resolution 800 × 600, 1,024 × 768 or more is recommended, 

256 color or more.

Solaris

Host
• OS: Solaris 8 (SPARC).

Solaris 9 (SPARC)
Solaris 10 (SPARC), or
Solaris 10 ((x64)

• CPU: SPARC minimum 1 GHz (2 GHz or more is recommended)
Solaris 10 (x64): Minimum 1.8 GHz (2 GHz (2 GHz or more is 
recommended))
Not supported x86 processor as like Opteron.
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Solaris 10 (x64) is supported 64 bits kernel mode on Sun Fire x64 server 
family only. Do not change the kernel mode to other than 64 bits after 
installing Hitachi Storage Navigator Modular 2.

• Memory: 1 GB or more (2 GB or more is recommended)
When using Hitachi Storage Navigator Modular 2 and other software 
products together, the memory capacity totaling the value of each 
software product is required.

• Available disk capacity: A free capacity of 1.5 GB or more is required.
• JDK: JDK1.5.0 is required.

Client
• OS: Solaris 8

Solaris 9 (SPARC)
Solaris 10 (SPARC)
Solaris 10 (x86), or
Solaris 10 (x64)

• CPU: SPARC minimum 1 GHz (2 GHz or more is recommended)
Solaris 10 (x64): Minimum 1.8 GHz (GHz or more is recommended)
Not supported x86 processor as like Opteron.
Solaris 10 (x64) is supported 64-bit kernel mode on Sun Fire x64 server 
family only. Do not change the kernel mode to other than 64 bits after 
installing Hitachi Storage Navigator Modular 2.

• Browser: Mozilla 1.7, Firefox 2
• JRE: JRE 1.6.0_22, 1.6.0_20, 1.6.0_15, 1.6.0_13, 1.6.0_10

The JRE download from http://java.com/en/download/, and then install 
JRE.

• CPU: (1 GHz or more is recommended)
• Memory: 1 GB or more (2 GB or more is recommended)

When using Hitachi Storage Navigator Modular 2 and other software 
products together, the memory capacity totaling the value of each 
software product is required.

• Available disk capacity: A free capacity of 100 MB or more is required.
• Monitor: Resolution 800 × 600, 1,024 × 768 or more is recommended, 

256 color or more.

Common Environment

LAN connection
• Connect one of the LAN cables to the LAN port of the controller #0 or 

controller #1 of the array unit.
• Connect the other of the LAN cables to the LAN-HUB prepared by a 

customer or the LAN port of the host for controlling the array unit.
• The LAN port supports the function (Auto MDI/MDX) to automatically 

distinguish the LAN cable type (straight or cross). Therefore, you can 
connect it with the straight cable when connecting to the LAN-HUB and 
directly connecting to the host for controlling the array unit. 
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Port number of TCP/IP

When connecting the array unit and a LAN, Hitachi Storage Navigator 
Modular 2 uses the port number of 2000. When changing the port number, 
add “df-damp-snm port number/TCP” to the services file of the OS. In 
addition, when changing the port number, it is also required to change the 
port number of the array unit to be connected. When the port number of the 
array unit is set as 2000, the array unit can be connected to the LAN though 
it takes time for the connection even if another port number is registered in 
the services file.

IPv6 Supported Platforms
The following table shows the IPv6 supported platforms.

Table 1-2:  IPv6 Supported Platforms

Vendor
Operating System

Service Pack IPv6 Supported
Name

Sun Solaris 8 (SPARC) - Supported

Solaris 9 (SPARC) - Supported

Solaris 10 (SPARC) - Supported

Solaris 10 (x86) - Supported only client

Solaris 10 (x64) - Supported

Microsoft Windows Server 2003 (x86) SP1 Supported

Windows Server 2003 (x86) SP2 Supported

Windows Server 2003 R2 
(x86)

SP1 Supported

Windows 7 (x86) Non SP, SP1 Supported

Windows 7 (x64) Non SP, SP1 Supported

Windows Server 2008 R2 
(x64)

Non SP, SP1 Supported

Windows Server 2003 R2 
(x64) 

SP1 Supported

Windows Vista (x86) SP1 Supported

Windows Server 2008 (x86) SP1, SP2 Supported

Windows Server 2008 (x64) SP1, SP2 Supported

Red Hat

Red Hat Enterprise Linux AS 
4.0 (x86) update1 -

Address searching 
function is not 
supported on the 
server

Red Hat Enterprise Linux AS 
4.0 (x86) update5 -

Address searching 
function is not 
supported on the 
server

Red Hat Enterprise Linux 
5.3 (x86) - Supported
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Connecting Hitachi Storage Navigator Modular 2 to the 
Host

You can connect Hitachi Storage Navigator Modular 2 to a host through a 
LAN with or without a switch.

When two or more LAN cards are installed in a host and a segment set in 
each LAN card is different from the others, Hitachi Storage Navigator 
Modular 2 can only access from the LAN card side specified by the installer. 
When accessing the array unit from the other segment, make the 
configuration that a router is used. Install one LAN card in the host to be 
installed.

Installing Hitachi Storage Navigator Modular 2
When Storage Navigator Modular is installed, Hitachi Storage Navigator 
Modular 2 cannot perform updating installation from Storage Navigator 
Modular.

Preparation
Make sure of the following on the host in which Hitachi Storage Navigator 
Modular 2 is to be installed before starting installation:

When the preparation items are not done correctly, installation may not be 
completed. It is usually completed in about 30 minutes. If it is not 
completed even one hour or more passes, terminate the installer forcibly 
and check that the preparation items are correctly done.

Red Hat Enterprise Linux 
5.4 (x86) - Supported

Red Hat Enterprise Linux 
5.4 (x64) - Supported

Red Hat Enterprise Linux 
5.5 (x86) - Supported

Red Hat Enterprise Linux 
5.5 (x64) - Supported

Red Hat Enterprise Linux 
5.6 (x64, x86) - Supported

Table 1-2:  IPv6 Supported Platforms

Vendor
Operating System

Service Pack IPv6 Supported
Name

Sun Solaris 8 (SPARC) - Supported

Solaris 9 (SPARC) - Supported

NOTE: If an array unit is already connected with a LAN, a host is 
connected to the same network as the array unit.
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• For Windows, when you install Hitachi Storage Navigator Modular 2 to 
the C: partition. A filename “program” is required to be placed directly 
under the C: partition.

• For Windows, you are logged on to Windows as an Administrator or a 
member of the Administrators group.
For Linux and Solaris, you are logged on to as a root user.

• To install Hitachi Storage Navigator Modular 2, the following free disk 
capacity is required.

When install Hitachi Storage Navigator Modular 2, it is not required exits 
the above directory. If directories do not exist, above directories are 
required to have enough free space.

• For Linux and Solaris, when the /opt exists, the normal directory is 
required (not the symbolic link). However, the file system may be 
mounted as a mount point.

• For Linux and Solaris, the kernel parameters must be set correctly. For 
more details, see section 0 or 805518148.

• The following patch must be applied to Solaris 10 (SPARC).
The patch 120664-xx (xx: 01 or later)
The patch 127127-xx (xx: 11 or later)
Do not apply the patch 127111-02 and 127111-03

• The following patch must be applied to Solaris 10 (x64).
The patch 120665-xx (xx: 01 or later)
Do not apply the patch 127112-02 and 127112-03

• Products other than Hitachi Storage Command Suite Common 
Component are not using port numbers 1099, 23015 to 23018, 23032, 
and 45001 to 49000.
If other products are using these ports, you cannot start Hitachi Storage 
Navigator Modular 2, even if the installation of Hitachi Storage Navigator 
Modular 2 has finished normally. Make sure that no other products are 
using these ports, and then begin the installation. You can change the 
port numbers 1099 and 23015 after the installation. Refer to section 
805518148 more details. If these port numbers have already been 
changed and used in an environment where Hitachi Storage Command 
Suite Common Component is installed, you can use the changed port 
numbers to install Hitachi Storage Navigator Modular 2. You do not have 
to change the port numbers back to the default.

• No other Hitachi Storage Command product is running.

Table 1-3:  Free Disk Capacity

OS Directory Free Disk Capacity

Windows Installed directory 1.5 GB

Linux /opt/HiCommand 1.5 GB

Solaris /opt/HiCommand 1.5 GB

/var/opt/HiCommand 1.0 GB

/var/tmp 1.0 GB
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When applications are running, stop the services (daemon process) 
according to the operation manual of each application.

• The installed Hitachi Storage Command Suite Common Components 
must not be operated in a cluster configuration.
When the host is in the cluster configuration, you cannot install Hitachi 
Storage Navigator Modular 2. In case of a cluster configuration, change 
it to the stand-alone configuration according to the manual.

• Dialog boxes used for operating Windows services, such as Computer 
Management or Services, are not displayed. 
When you display a window, you may not able to install Hitachi Storage 
Navigator Modular 2. If the installation is not completed after one hour 
elapsed, terminate the installation forcibly and check if the window is 
displayed.

• Services (daemon process) such as process monitoring and virus 
monitoring must not be operating.
When the service (daemon process) is operating, you may not be able 
to install Hitachi Storage Navigator Modular 2. If the installation is not 
completed after one hour elapsed, terminate the installation forcibly and 
check what service (daemon process) is operating.

• When third-party-made firewall software other than Windows firewall is 
used, it must be invalidated during the installation or un-installation.
When you are using the third party- made firewall software, if the 
installation of Hitachi Storage Navigator Modular 2 is not completed after 
one hour elapsed, terminate the installation forcibly and check if the 
third party-made firewall software is invalidated.

• For Linux and Solaris environment, the firewall must be invalidated.
To invalidate the firewall, see the each firewall manual.

• Some of the firewall functions provided by the OS might terminate 
socket connections in the local host. You cannot install and operate 
Hitachi Storage Navigator Modular 2 in an environment in which socket 
connections are terminated in the local host. When setting up the 
firewall provided by the OS, configure the settings so that socket 
connections cannot be terminated in the local host.

• Windows must be set to produce the 8+3 form file name that is 
compatible with MS-DOS.
There is no problem because Windows creates the 8+3 form file name 
in the standard setting. When the tuning tool of Windows is used, the 
standard setting may have been changed. In that case, return the 
setting to the standard one.

• Hitachi Storage Navigator Modular 2 for Windows supports the Windows 
Remote Desktop functionality. Note that the Microsoft terms used for 
this functionality differ depending on the Windows OS. The following 
terms can refer to the same functionality:
• Terminal Services in the Remote Administration mode
• Remote Desktop for Administration
• Remote Desktop connection
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When using the Remote Desktop functionality to perform Hitachi 
Storage Navigator Modular 2 operation (including installation or un-
installation), you need to connect to the console session of the target 
server in advance. However, even if you have successfully connected to 
the console session, the product might not work properly if another user 
connects to the console session.

• Windows must be used in the application server mode of the terminal 
service and must not be installed in the execution mode.
When installing Hitachi Storage Navigator Modular 2, do not use the 
application server mode of the terminal service. If the installer is 
executed in such an environment, the installation may fail or the 
installer may become unable to respond.

To disable DEP:
1. Choose Start, Settings, Control Panel, and then System. 

The System Properties dialog box appears.
2. Select the Advanced tab, and under Performance click Settings.

The Performance Options dialog box appears.
3. Select the Data Execution Prevention tab, and select the Turn on 

DEP for all programs and services except those I select radio 
button.

4. Click Add and specify Hitachi Storage Navigator Modular 2 installer 
(HSNM2- xxxx-W-GUI.exe). (The portion “xxxx” of file names varies 
with the version of Hitachi Storage Navigator Modular 2, etc.)
Hitachi Storage Navigator Modular 2 installer (HSNM2-xxxx-W-GUI.exe) 
is added to the list.

5. Select the checkbox next to Hitachi Storage Navigator Modular 2 
installer (HSNM2-xxxx-W-GUI.exe) and click OK.
Automatic exception registration of Windows firewall:

NOTE: Before installing Hitachi Storage Navigator Modular 2 on a host in 
which another Hitachi Storage Command product has already been 
installed, back up the database. However, you install Hitachi Storage 
Navigator Modular 2 only, it is not necessary to back up.

NOTE: When installing Hitachi Storage Navigator Modular 2 in Windows 
Server 2003 SP1 or Windows XP SP2 or later, you need to specify the 
following settings if Data Execution Prevention is being used: 

Settings When Data Execution Prevention Is Enabled

If Data Execution Prevention (DEP) is enabled in Windows, sometimes 
installation cannot start. In this case, use the following procedure to disable 
DEP and then re-execute the installation operation.



Overview 1–17

Hitachi Storage Navigator Modular 2 Advanced Settings User’s Guide

When Windows firewall is used, the installer for Hitachi Storage 
Navigator Modular 2 automatically registers the file of Hitachi Storage 
Navigator Modular 2 and that included in Hitachi Storage Command 
Suite Common Components as exceptions to the firewall. Check that no 
problems of security exist before executing the instaler.

Setting of Linux Kernel Parameters

When install Hitachi Storage Navigator Modular 2 to Linux, you must be set 
the Linux kernel parameters. If you not set the Linux kernel parameters, 
Hitachi Storage Navigator Modular 2 installer terminates abnormally. 
Besides, when the application have already been installed and used in an 
environment where Hitachi Storage Command Suite Common Component, 
the Linux kernel parameters are not required to set.

To set the Linux kernel parameters:
1. Backup the kernel parameters setting file (/etc/sysctl.conf and /etc/

security/limits.conf).
2. Open the kernel parameters setting file (/etc/sysctl.conf) with text 

editor and change referring to the following.
The parameters are specified using the form, which is “ [name of 
parameter]=[value]”. Four values separated by space are specified in 
kernel.sem.
Then, the parameter must not exceed the maximum value that OS 
specifies.
The value can be checked by the following command.
cat /proc/sys/kernel/shmmax (Case: Check value of “kernel.shmmax”)

3. Open the kernel parameters setting file (/etc/security/limits.conf) with 
text editor and change referring to the following.

Table 1-4:  Linux kernel parameters

Parameter Name
Recommended Value

Calculation Method
Navigator 2 Data Base

kernel.shmmax 11542528 200000000 The maximum value in current 
and two recommended value.

kernel.shmall 22418432 22418432 The total value of current 
value and recommended 
value.

kernel.shmmni 0 2000 The larger value in following: 
• The total value of current 
and Navigator 2 
recommended value 
• The data base 
recommended value

kernel.threads-max 184 574

kernel.msgmni  32 32

kernel.sem 
(Second parameters)

80 7200

kernel.sem
(Forth parameters)

9 1024

s.file-max  53898 53898
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The parameters are specified using the form, which is “ [domain] [type] 
[name of parameter] [value]”. The domains are specified for “*”. The 
types are specified for both “soft” and “hard”. Then the soft value must 
not exceed the hard value. Then, the parameter must not exceed the 
maximum value that OS specifies.

4. Reboot host.

Setting of Solaris 8 or Solaris 9 Kernel Parameters

When install Hitachi Storage Navigator Modular 2 to Solaris 8 or Solaris 9, 
must be set the Solaris kernel parameters. If you not set the Solaris kernel 
parameters, Hitachi Storage Navigator Modular 2 installer terminates 
abnormally. Besides, when the application have already been installed and 
used in an environment where Hitachi Storage Command Suite Common 
Component, the Solaris kernel parameters are not required to set.

To set the Solaris kernel parameters:
1. Backup the kernel parameters setting file (/etc/system).
2. Open the kernel parameters setting file (/etc/system) with exit editor 

and add the following text line to bottom.
When a certain value has been set in the file, revise the existing value 
by adding the following value within the limit that the value does not 
exceed the maximum value which each OS specifies. For the maximum 
value, refer to the manual of each OS.

3. Reboot the Solaris host and then install Hitachi Storage Navigator 
Modular 2.

Table 1-5:  

Parameter Name
Recommended Value

Calculation Method
Navigator 2 Data Base

nofile 572 1344 The larger value in following:
• The total value of current 
and Navigator 2 
recommended value
• The data base 
recommended value

nproc 165 512

NOTE: The shmsys:shminfo_shmseg is not used in Solaris 9. But there is 
no influence even if sets it.
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Setting of Solaris 10 Kernel Parameters

When install Hitachi Storage Navigator Modular 2 to Solaris 10, must be set 
the Solaris kernel parameters. If you not set the Solaris kernel parameters, 
Hitachi Storage Navigator Modular 2 installer terminates abnormally. 
Besides, when the application have already been installed and used in an 
environment where Hitachi Storage Command Suite Common Component, 
the Solaris kernel parameters are not required to set.

To set the Solaris kernel parameters:
1. Backup the kernel parameters setting file (/etc/project).
2. From the console, execute the following command and then check the 

current parameter value.

3. From the console, execute the following command and then set the 
parameters.
When a certain value has been set, revise the existing value by adding 
the following value within the limit that the value does not exceed the 
maximum value which each OS specifies. For the maximum value, refer 
to the manual of each OS.
The parameter must be set for the both projects, user.root and system.

4. Reboot the Solaris host and then install Hitachi Storage Navigator 
Modular 2.

Installing
You need to specify the following items when installing Hitachi Storage 
Navigator Modular 2 for the first time. Check these items before the 
installation.

NOTE: In case of the setting of the kernel parameters is not enabled in 
Solaris 10, open the file (/etc/system) with text editor and change referring 
to the following before reboot host.
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• Host name or IP address of the host that installing Hitachi Storage 
Navigator Modular 2 (If two or more IP addresses set on the host)

• Port number (1099 must not be used as a port number)If 1099 is used 
as a port number, replace it to a port number currently not used. We 
recommend using a number 25000 or more for a port number.

To perform a new installation for Windows:

1. Insert Hitachi Storage Navigator Modular 2 installation CD-ROM.
The installation starts automatically. If you perform the installation later, 
terminate it. After that, display the contents of the CD-ROM with 
Explorer and execute HSNM2-xxxx-W-GUI.exe. (The portion “xxxx” of 
file names varies with the version of Hitachi Storage Navigator Modular 
2, etc.)
The Welcome to the InstallShield Wizard for Hitachi Storage 
Navigator Modular 2 dialog box appears.

2. Click Next.
Click Next to display the Choose Destination Location dialog box.

NOTE: In the case of Windows Vista, open the command prompt and then 
close it before starting the installation..
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Figure 1-2:  InstallShield Wizard
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Figure 1-3:  Choose Destination Location dialog box

We recommend installing Hitachi Storage Navigator Modular 2 in the 
default folder. If you do not want to accept the default installation folder, 
specify another installation folder. The rules for specifying an installation 
folder are as follows:
• Only the following characters can be used:

A to Z, a to z, 0 to 9, hash mark (#), plus sign (+), hyphen (-), period 
(.), at mark (@), underscore (_), and the space character.
Note that a space character cannot be used at the beginning or end 
of a folder name.

• The path name must not contain any names reserved by the OS 
(CON, AUX, NUL, PRN, CLOCK$, COM1 to COM9, and LPT1 to 
LPT9).

• Do not specify the UNC path.
• For the directory specification of the installation destination, the 

length of the character string is within 100 characters and do not 
specify a route of the drive. If you specify a route of the drive, the 
installer displays the following error message in the middle of the 
installation.
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Figure 1-4:  InstallShield wizard error message - route specification

The installer creates the _HDBInstallerTemp and 
StorageNavigatorModular directories. Delete the _HDBInstallerTemp 
and StorageNavigatorModular directories if necessary.

If you install Hitachi Storage Navigator Modular 2 on a host in which 
other Hitachi Storage Command products are not installed, Hitachi 
Storage Navigator Modular 2 and Hitachi Storage Command Suite 
Common Component will be installed in the folder that is specified in the 
Setup of the Installation Folder dialog box.
If you install Hitachi Storage Navigator Modular 2 on a host in which 
other Hitachi Storage Command products are installed, Hitachi Storage 
Navigator Modular 2 will be installed in the folder that is specified in the 
Setup of the Installation Folder dialog box, but Hitachi Storage 
Command Suite Common Component will be installed in the folder that 
contains the existing Hitachi Storage Command Suite Common 
Component, and overwrites it.
A volume with a folder of Hitachi Storage Navigator Modular 2 
installation destination must have a capacity of 1.5 GB or more.

3. Click Next.
The Input the IP address and port number of the PC dialog box 
appears.

Specify the following information (confirm the information before you 
start installation):
• IP Addr.: Set an IP address or a host name to display the Applet 

screen. Specify an IP address or a host name to install Hitachi 
Storage Navigator Modular 2.
If only one IP address is set to the host to install Hitachi Storage 
Navigator Modular 2, it is not required to set the IP address. Set it 
when two or more IP addresses are set to the host to install Hitachi 
Storage Navigator Modular 2.
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Figure 1-5:  InstallShield wizard - Input IP address

When Storage Navigator Modular (for Web) is installed or run in the same 
host, specify a value other than 1099. When the port number is changed in 
Storage Navigator Modular (for Web) setting, specify a port number other 
than the changed value.

4. Click Next.
Clicking Next displays the Start Copying Files dialog box.

Parameters about the installation are display. Confirm that they are 
correct. If you find any mistake, return to the previous dialog box click 
Back and correct it.

5. Confirm that the displayed installation settings are correct, and then 
click Next.

NOTE: Do not specify 127.0.0.1 and localhost. If you specify it, the Applet 
screen of Hitachi Storage Navigator Modular 2 is not displayed.

NOTE: Port No.: Port number for SNM2 Server. The default value is 1099..

NOTE: When using DHCP environments, specify host name (computer 
name) to the IP Addr. field.
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Figure 1-6:  InstallShield wizard - Stop copying files

Installation starts. During the installation, dialog boxes indicating the 
processing status appear. When installation is complete, the 
InstallShield Wizard Complete dialog box appears. The installation 
cannot be stopped after it is started.

Figure 1-7:  InstallShield wizard - Complete

6. Click Finish to finish the installation.
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When the installation completes normally, you can operate via a Web 
browser. Refer to section for the procedures to set a client and to access 
Hitachi Storage Navigator Modular 2.

To perform a new installation for Linux:
1. Insert Hitachi Storage Navigator Modular 2 installation CD-ROM.
2. Mount the CD-ROM on the file system. The mount destination is /cdrom 

here.
3. From the console, execute the following command.

Specify the IP address or host name used to access Hitachi Storage 
Navigator Modular 2 and the port number for the IP address and port 
number. However, if you use 1099 for the port number, you can omit the 
–p option. You cannot omit the –a option.

To perform a new installation for Solaris:
1. Insert Hitachi Storage Navigator Modular 2 installation CD-ROM.
2. Mount the CD-ROM on the file system. The mount destination is /cdrom 

here.
3. Create the temporary directory that to have enough free space (more 

than 600 MB) on the file system, and expand the compressed files. The 
temporary directory is /temporary here (XXXX is a version number).

4. From the console, execute the following command.

Specify the IP address or host name used to access Hitachi Storage 
Navigator Modular 2 and the port number for the IP address and port 
number. However, if you use 1099 for the port number, you can omit the 
–p option. You cannot omit the –a option.

5. Delete the temporary directory.

NOTE: Do not specify 127.0.0.1 and localhost. If you specify it, the Applet 
screen of Hitachi Storage Navigator Modular 2 is not displayed.

NOTE: When using DHCP environments, specify host name (computer 
name) to the IP Addr. Field.

NOTE: Do not specify 127.0.0.1 and localhost. If you specify it, the Applet 
screen of Hitachi Storage Navigator Modular 2 is not displayed.
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Updating
When you update the installed Hitachi Storage Navigator Modular 2 to that 
of the newer version, you can perform the update installation using the 
installer.

When you install Hitachi Storage Navigator Modular 2 of the same version 
as that has been already installed, the uninstaller starts. Hitachi Storage 
Navigator Modular 2 is uninstalled and then newly installed.

If you are using it by connecting with the https, it is required to set the 
server certificate and private key again after completing the update. 

Check if the preparation for the upgrade installation is completed referring 
to section.

To perform an upgrade installation for Windows: 
1. Insert Hitachi Storage Navigator Modular 2 installation CD-ROM. 

The installation starts automatically. If you perform the installation later, 
terminate it. After that, display the contents of the CD-ROM with 
Explorer and execute HSNM2-xxxx-W-GUI.exe. (The portion “xxxx” of 
file names varies with the version of Hitachi Storage Navigator Modular 
2, etc.)
The Welcome to the InstallShield Wizard for Hitachi Storage 
Navigator Modular 2 dialog box appears.

NOTE: When using DHCP environments, specify host name (computer 
name) to the IP Addr. field

NOTE: When installing Hitachi Storage Navigator Modular 2 in the host 
that cannot read the CD ROM, copy two files, install-hsnm2.sh and HSNM2- 
XXX-LGUI. rpm (Linux) or HSNM2-XXXX-S-GUI.tar.gz (Solaris) (XXXX is a 
version number), to the file system that can be recognized by the host and 
execute the command in the above procedure to install it.

NOTE: You cannot perform the update installation of Hitachi Storage 
Navigator Modular 2 of the former version than that of the installed Hitachi 
Storage Navigator Modular 2. When it is required to return to the former 
version, uninstall Hitachi Storage Navigator Modular 2 once. If you fail to 
reinstall it after uninstalling Hitachi Storage Navigator Modular 2, restart 
the host, check that the installation of Hitachi Storage Navigator Modular 2 
is ready, and then install it again.

NOTE: If you perform the update installation of Hitachi Storage Navigator 
Modular 2 the version to 5.00 or more, the login screen shown in page 3-5 
displays. If it is not displayed, operate the following contents.
• Delete the Temporary Internet files
• Clear the History.
• Close all the screens of the open browser
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Figure 1-8:  InstallShield wizard - Welcome screen

2. Click Next.
Clicking Next displays the Confirm stopping the services dialog box.
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Figure 1-9:  InstallShield wizard - Confirm stopping services

3. Click Next.
Clicking Next displays the Confirm before updating dialog box.
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Figure 1-10:  InstallShield wizard - Confirm before updating

4. Confirm that the displayed information, and then click Next.
Installation starts. During the installation, dialog boxes indicating the 
processing status appear. When installation is complete, the Update 
Complete dialog box appears. The upgrade installation cannot be 
stopped after it is started.
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Figure 1-11:  InstallShield wizard - Update complete

5. Click Finish to finish the installation.
When the installation completes normally, you can operate via a Web 
browser.

To perform an upgrade installation for Linux:
1. When the application that uses Hitachi Storage Command Suite 

Common Components other than Hitachi Storage Navigator Modular 2 is 
installed, stop the daemon process of the Hitachi Storage Command 
Suite Common Components.

2. Insert Hitachi Storage Navigator Modular 2 installation CD-ROM. 
3. Mount the CD-ROM on the file system. The mount destination is /cdrom 

here. 
4. From the console, execute the following command.

To perform an upgrade installation for Solaris:

NOTE: Do not specify 127.0.0.1 and localhost. If you specify it, the Applet 
screen of Hitachi Storage Navigator Modular 2 is not displayed.

NOTE: When using DHCP environments, specify host name (computer 
name) to the IP Addr. field.
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1. Insert Hitachi Storage Navigator Modular 2 installation CD-ROM.
2. Mount the CD-ROM on the file system. The mount destination is /cdrom 

here.
3. Create the temporary directory that to have enough free space (more 

than 600 MB) on the file system, and expand the compressed files. The 
temporary directory is /temporary here (XXXX is a version number).

4. From the console, execute the following command.

Specify the IP address or host name used to access Hitachi Storage 
Navigator Modular 2 and the port number for the IP address and port 
number. However, if you use 1099 for the port number, you can omit the 
– p option. You cannot omit the –a option.

5. Delete the temporary directory. Refer to the notes for best practices.

Uninstalling
Check if the preparation for the un-installation is completed referring to 
section.

NOTE: Do not specify 127.0.0.1 and localhost. If you specify it, the Applet 
screen of Hitachi Storage Navigator Modular 2 is not displayed. When using 
DHCP environments, specify host name (computer name) to the IP Addr. 
field.

NOTE: When installing Hitachi Storage Navigator Modular 2 in the host 
that cannot read the CD ROM, copy two files, install-hsnm2.sh and HSNM2-
XXXX-LGUI.rpm (Linux) or HSNM2-XXXX-S-GUI.tar.gz (Solaris) (XXXX is a 
version number), to the file system that can be recognized by the host and 
execute the command in the above procedure to install it.

NOTE: When other applications using Hitachi Storage Command Suite 
Common Components have been installed in the host to uninstall Hitachi 
Storage Navigator Modular 2, back up the data base of the applications 
before uninstalling Hitachi Storage Navigator Modular 2.
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To uninstall Hitachi Storage Navigator Modular 2 for Windows:
1. In the Windows Start menu, choose Settings, Control Panel, Add or 

Remove Programs.
The Add or Remove Programs panel appears.

2. From the Currently installed programs list, select Hitachi Storage 
Navigator Modular 2.

3. Click Remove.
The Uninstall Hitachi Storage Navigator Modular 2 dialog box 
appears.

Figure 1-12:  InstallShield wizard - Uninstall SNM2

4. Click Next.
Clicking Next displays the Confirm stopping the services dialog box.

NOTE: When you uninstall Hitachi Storage Navigator Modular 2 and the 
message “forcible uninstallation is necessary” is displayed, restart the PC, 
check if the preparation for the un-installation is completed, and uninstall 
Hitachi Storage Navigator Modular 2 again. If you cannot uninstall Hitachi 
Storage Navigator Modular 2 even restarting the PC, you need to reinstall 
the OS.
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Figure 1-13:  InstallShield wizard - Confirm stopping services

5. Click Next.
Clicking Next displays the Confirm before uninstallation dialog box 
appears.

Figure 1-14:  InstallShield wizard - Confirm before uninstallation
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6. Click Next.
When un-installation is complete, the Uninstall Complete dialog box 
appears.

Figure 1-15:  InstallShield wizard - Uninstall complete

7. Click Finish.
When other applications using Hitachi Storage Command Suite Common 
Components have been installed, restart the services referring to the 
manual of each application.

To uninstall Hitachi Storage Navigator Modular 2 for Linux and Solaris:
1. When the application that uses Hitachi Storage Command Suite 

Common Components other than Hitachi Storage Navigator Modular 2 is 
installed, stop the daemon process of the Hitachi Storage Command 
Suite Common Components.

2. From the console, execute the following command.
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2
Getting Started

This chapter provides a function overview of Storage Navigator 2.

Functional Overview
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Functional Overview
Table 2.1 lists the available functions for Hitachi Storage Navigator Modular 
2.

Refer to Help of Hitachi Storage Navigator Modular 2 for the description of 
the Web screen functions. This guide describes the functions of the Applet 
screen.

Refer to the manual of each priced option for the description of the priced 
option.

Table 2-1:  Hitachi Storage Navigator Modular 2 Functions

Category Function Name Description Notes Online 
Usage

Components Component status 
display 

Displays the status of a 
componentsuch as tray. Yes

Groups

RAID Groups RAID group: Creates, deletes, or 
displays a RAID group.

Only for 
AMS2000 Yes

LU creation: Used to add a logical unit 
(LU). A new logical unit is added by 
specifying its capacity.

Yes

LU deletion: Deletes the defined 
logical unit (LU). User data is deleted. Yes

LU formatting: Required to make a 
defined logical unit (LU) accessible by 
the host. Writes null data to the 
specified logical unit, and deletes user 
data.

Yes

Host Groups Review, operate, and set host groups. Yes

iSCSI Targets Review, operate, and set iSCSI 
targets. Yes
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Settings

iSCSI Settings View and configure iSCSI ports. Yes

FC Settings View and configure FC ports. Yes

Port Options View and configure port options. Yes

Replacement of 
Array

View and configure the array 
replacement. Only for SMS Yes

Spare Drives View, add, or remove spare drives. Only for 
AMS2000 Yes

Licenses View, install, or de-install licensed 
storage features. Yes

Command devices View and configure command devices. Yes

DMLU
View and configure the Differential 
management Logical Units for 
replication/migration.

Yes

SNMP Agent View and configure SNMP Agent 
Support Function Yes

LAN View and configure LAN. Yes

Drive Recovery View and configure options to recovery 
drives. Yes

Constitute Array Input and output constitute array 
parameters. Yes

System Paremters View and configure system 
parameters Yes

Verification 
Settings

View and configure verification for the 
drive and cache. Yes

Parity Correction Recovery parity status of the logical 
units. Yes

Mapping Guardq View and configure Mapping Guard for 
the logical units Yes

Mapping Mode View and configure mapping mode. Yes

Boot Options View and configure boot options

Array must be 
restarted to 
implement 
the settings.

Yes

Format Mode View and configure format mode for 
the logical unit. Yes

SATA Write & 
Compare

View and configure SATA Write & 
Compare. Yes

Firmware Refer/update firmware.

Array must be 
restarted to 
implement 
the settings.

Yes

Table 2-1:  Hitachi Storage Navigator Modular 2 Functions

Category Function Name Description Notes Online 
Usage
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You can use the functions such as boot parameters and port options in the 
Applet screen. Refer to this manual for the contents of the functions.

Notes at the Time of Functional Operation
The following sections detail recommended formatting sizes to ensure the 
best performance for given configurations.

Logical units formatting

The total size of logical units that can be formatted at the same time has 
restrictions. If the configuration exceeds the possible formatting size, the 
firmware of the array does not execute the formatting (error messages are 
displayed). Moreover, if the logical units are expanded, the expanded logical 
units size are automatically formatted and the size becomes the restriction 
target that permits which entities can be formatted at the same time.

Note that the possible formatting size differes depending on the array type. 
Format the total size of logical units by the recommended batch formatting 
size or less as shown in Table 2-2.

E-mail Alert View and configure E-mail Alert 
function in the array. Yes

Date & Time View and configure the Date & Time in 
the array. Yes

Advanced Settings View and configure advanced settings. Yes

Security Secure LAN Set the SSL certificate and validity/
invalidity of the normal port. Yes

Performance
Monitoring View and output the monitored 

performance in the array. Yes

Tuning Parameter Configure the parameter to 
performance in the array. Yes

Alerts & 
Events - Displays the alerts and events. Yes

Error 
Monitoring

Report when a 
failure occurs and 
controller status 
display

Polls the array and displays the status. 
If an error is detected, it is output into 
log.

Contact your 
maintenance 
personal.

Yes

Table 2-1:  Hitachi Storage Navigator Modular 2 Functions

Category Function Name Description Notes Online 
Usage

Table 2-2:  Batch Formatting Size By Platform

Array Type Recommended Batch Formatting Size

AMS2500 359 TB (449 GB x 
800)

308 TV (193 GB x 
1,600)

208 TB (65 GB x 
3,200)

AMS2300 287 TB (449 GB x 
640)

247 TB (193 GB x 
1,280)

166 TB (65 GB x 
2,560)

AMS2100 179 TB (449 GB x 
400)

154 TB (193 GB x 
800)

104 TB (65 GB x 
1,600)
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The formatting is executed in the following three operations. However, it has 
no effect on the DP volumes using the Dynamic Provisioning function 
Table 2-3 details formatting capacity operation.

The restrictions of the possible formatting size becomes the size of totaling 
three operations. Perform it so that the total of each operation becomes the 
recommended batch formatting size or less.

When the above-mentioned operation is executed and the restrictions of the 
possible formatting size are exceeded, the following messages are 
displayed. Table 2-4 details messages that display when formatting size is 
exceeded. 

(1) Logical units creation (format is specified):

If the logical units creation (format is specified) becomes an error, the 
logical units are created, but the formatting is not executed and the Status 
of the Logical Units tab becomes Unformat. After checking that the Status 
of logical units which are already executing the other formatting or 
expansion the other logical units becomes Normal, execute only the 
formatting for the logical units which performed the creation of logical units.

(2) Logical units format: 

If the formatting of logical units becomes an error, the formatting is not 
executed and the Status of the Logical Units tab is still kept as before the 
execution. After checking that the Status of logical units which are already 
executing the other formatting or expansion the other logical units becomes 
Normal, execute the formatting again.

(3) Logical units expansion: 

Table 2-3:  Formatting Capacity by Operation

Operation Formatting Capacity

Logical units creation (format is 
specified) Size of logical units to create

Logical units format Size of logical units to format

Logical units expansion Size of logical units to expand

Table 2-4:  Messages for Exceeded Size

Operation Formatting Capacity

Logical units creation (format is 
specified)

DMED100005: The quick format size is over 
maximum value. Please retry after that 
specified quick format size is decreased or 
current executed quick format is finished.Logical units format

Logical units expansion

DMED0E0023: The quick format size is over 
maximum value. Please retry after that 
specified quick format size is decreased or 
current executed quick format is finished.
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If the expansion of logical units becomes an error, the expansion is not 
executed and the Status of the Logical Units tab is still kept as before the 
execution. After checking that the Status of logical units which are already 
executing the other formatting or expansion the other logical units becomes 
Normal, execute the expansion again.

Constitute array

Configurations set successfully.

Regardless of the configuration file that you specified, the cache partition 
number is specified to 0 or 1 and Full Capacity Mode s specified to disabled. 
When the result is different from your expectation, change the 
configurations. It cannot set configurations for optional storage features 
and you need to specify them manually.
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3
Launching the Application

This chapter includes the following:

Starting

Changing the Port Number and Connection Address

Stopping the Services (Daemon Process)
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Starting

Host side
Verify through Control Panel -> Administrative Tools -> Services 
whether HBase Storage Mgmt Common Service, HBase Storage Mgmt 
Web Service, and SNM2 Server have started.

Start the HBase Storage Mgmt Common Service, HBase Storage 
Mgmt Web Service, and SNM2 Server if they have not started.

Client side

For Windows

When you use the JRE 1.6.0_10 or newer, setting the Java Runtime 
Parameters are not necessary in a client to start Navigator 2. When you 
use the JRE less than 1.6.0_10, setting the Java Runtime Parameters are 
necessary in a client to start Navigator 2.
1. In the Windows Start menu, choose Settings, Control Panel. 
2. From the Control Panel, select the Java.
3. Click View of the upper position in the Java tab.
4. Enter -Xmx192m to the Java Runtime Parameters field.

It is necessary to set the Java Runtime Parameters to display the Applet 
screen.

5. Click OK.
6. Click OK in the Java tab.
7. Close the Control Panel.

For Linux and Solaris
1. Run the Java Control Panel from XWindow terminal executing the <JRE 

installed directory>/bin/jcontrol.
2. Click View of the upper position in the Java tab. 
3. Enter “-Xmx192m” to the Java Runtime Parameters field.

It is necessary to set the Java Runtime Parameters to display the Applet 
screen.

4. Click OK. 
5. Click OK in the Java tab.

To start Navigator 2
1. Activate the browser and specify the URL as follows.

NOTE: The https is invalid in the status immediately after the installation. 
When connecting it with the https, it is required to set the server certificate 
and private key in advance referring to the section 0.
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For the URL, specify a host name or IP address of Navigator 2. Do not 
specify a loop back address such as localhost and 127.0.0.1. When you 
specify a loop back address such as localhost or 127.0.0.1, the Web 
screen is displays, but the Applet screen is not displays.
The user login screen displays.

2. Enter your login information and click Login.
When logging in Navigator 2 for the first time after installing it newly, 
login with the built-in user’s system account. The default password of 
the system account is manager. If another user is registered, login with 
the registered user. Enter the user ID and password, and click Login.
To prevent unauthorized access, we recommend changing the default 
password of the system account. You cannot delete the system account 
or change the authority of the system account. The system account is 
the built-in account common to the Hitachi Storage Command Suite 
products.
The system account can use all the functions of Hitachi Storage 
Command Suite Common Component including Navigator 2 and access 
all the resources that each application manages. When Hitachi Storage 
Command Suite Common Component are already installed in the PC, 
etc. in which avigator 2 is installed and the password of the system 
account is changed, login with the changed password.
Although you can login with the user ID registered in Hitachi Storage 
Command Suite Common Component, you cannot operate Navigator 2. 
Add the operation authority of Navigator 2 after logging in Navigator 2, 
and login again.
Navigator 2 starts and the Arrays screen displays.

3. Since the Arrays screen is displays, use Navigator 2 after registering the 
array unit in it.
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Operations
Navigator 2 screens consist of the Web and Applet screens. When you start 
Navigator 2, the login screen is displayed. When you login, the Web screen 
that shows the Arrays list is displayed. On the Web screen, operations 
provided by the screen and the dialog box is displayed. When you execute 
Advanced Settings on the Arrays screen and when you select the 9500V and 
AMS/WMS on the Web screen of the Arrays list, the Applet screen is 
displayed.

One user operates the Applet screen to run the 9500V and AMS/WMS, and 
two or more users cannot access it at the same time.

Figure 3-1:  Array and SMS Array dialog boxes
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The following figure displays settings that appear in the Applet dialog box.

Figure 3-2:  Applet dialog box

Screens such as the Array screens displays when you login are Web screens. 
When you click the tree, details of the screen are updated on the same 
screen. When you click a button on the screen, a dialog box displays. Two 
types of dialog boxes exist; one is displayed on the Web screen and the 
other is displayed on the Applet screen.

A dialog box on the Web screen is displayed on the same screen by clicking 
any buttons. This is the same with the Applet screen. Use each function of 
the Web or Applet screen after completing the dialog function and closing 
the dialog box.

You can operate another button while the dialogue box is open. In that case, 
the display in the dialog box currently open is changed. However, the 
function of the dialog box that was open has worked.

Refer to Help for the procedure for operating the Web screen. The Help is 
not described in this manual. Since the Help for the procedure for operating 
the Applet screen is not provided, refer to this manual when you need help.

The following table shows the troubleshooting steps to take when the Applet 
screen does not display.

NOTE: The Applet screen is displayed connected to the SNM2 Server. If 
20 minutes elapse while displaying the Applet screen, you will not be able 
to operate it due to the automatic logoff function. If the operation is 
completed, close the screen.
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Table 3-1:  Troubleshooting

Problem Case Solution

The following message 
appears.
DMEG800003: The error 
occurred in connecting RMI 
server. Please reboot the 
server.

The IP address of the 
server that installed 
Navigator 2 was 
changed.

Log out of Navigator 2, and change the IP 
address of 
“jp.co.hitachi.str.diskarray.rmi.hostname
” of the “snmserver.properties” file in 
“StorageNavigatorModular\server” in the 
installation folder of Navigator 2. After 
that, restart the service. Then, log in 
Navigator 2. (See the section 0)

The SNM2 server 
stopped.

Log out of Navigator 2, and then restart 
the service. Then, log in Navigator 2. (See 
the section 805518148)

Other services using 
the port number 1099 
exist.

Log out of Navigator 2, and change the 
port number of 
“jp.co.hitachi.str.diskarray.rmi.port” of 
the “snmserver.properties” file in 
“StorageNavigatorModular\server” in the 
installation folder of Navigator 2. After 
that, restart the service. Then, log in 
Navigator 2. (See the section 
805518148) Or, change the port number 
of the service that is using the same port 
number.

An IP address is not 
assigned to the server 
that installed 
Navigator 2.

Assign an IP address to the server. After 
that, restart the service. (See the section 
805518148)

It was not connectable 
although starting of 
Navigator 2 was 
specified by the host 
name.

Check if the host name is correct by the 
ping command. Or, start Navigator 2 by 
specifying an IP address instead of the 
host name.

Two or more IP 
addresses are 
specified for the server 
that installed 
Navigator 2.

Log out of Navigator 2, and change the IP 
address to the other IP address of 
“jp.co.hitachi.str.diskarray.rmi.hostname
” of the “snmserver.properties” file in 
“StorageNavigatorModular\server” in the 
installation folder of Navigator 2. After 
that, restart the service. Then, log in 
Navigator 2. (See the section 
805518148) When Navigator 2 fails to 
start even if the IP address is changed, try 
other IP addresses.
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The X appears in the Applet 
launch screen, and the 
following message appears. 
(Error) Click it and check 
the details.

127.0.0.1 or localhost 
is specified. The 
following exceptions 
are displayed in the 
Java console. 
java.security.AccessC
ontrolException

Log out of Navigator 2, and change 
“jp.co.hitachi.str.diskarray.rmi.hostname
” of the “snmserver.properties” file in 
“StorageNavigatorModular\server” in the 
installation folder of Navigator 2 to an IP 
address of the actual server. After that, 
restart the service. Then, log in Navigator 
2. (See the section 805518148)

The Temporary 
Internet Files on the 
Java Control Panel is 
not deleted.

Open the Java Control Panel, and click 
Settings on of the General tab. Click 
Delete Files in the Temporary Files 
Settings dialog and delete the internet 
temporary files. Close all the opened 
browsers, and then start Navigator 2.

The Temporary 
Internet Files on the 
Java Control Panel is 
set to Keep 
temporary files on 
my computer

Open the Java Control Panel, and click 
Settings on of the General tab. Uncheck 
the checkbox of Keep temporary files 
on my computer in the Temporary 
Files Settings dialog. Close all the 
opened browsers, and then start 
Navigator 2.

The following message 
appears.
Failed to connect with the 
web server. The setting of 
the certificate of the client 
is not correct, the server 
may be down, or an 
automatic logoff was 
executed. Confirm the 
execution environment, 
and then login again.
(code:
0x000000000000b001)

Windows Firewall is 
not set correctly.

Off the Windows Firewall by the 
Window Firewall on the Control Panel. 
Or, add program “snm2srv.exe” of 
“StorageNavigatorModular\server\jre1.6.
0\bin” in the installation folder of 
Navigator 2 as the Exceptions of the 
Windows Firewall.

The following message 
appears.
DMEG800004: The error 
occurred in registering 
temporary user of RMI 
launch. Please reboot the 
server.

The server that 
installed Navigator 2 is 
standby or stopped.

Open the Power Options on the Control 
Panel, specify System standby of the 
Power Schemes tab to Never, and 
uncheck the checkbox of the Enable 
hibernation of the Hibernate tab.

The following message 
appears.
DMEG000220: Cannot 
display because JRE is not 
installed or it is disabled. 
Please install the JRE or 
enable it and try again.

The Java Applet 
Runtime Settings is 
not Enabled.

Open the Java Control Panel, and click 
View of the Java Applet Runtime 
Settings of the Java tab. Check Enabled 
in the Java Runtime Settings screen.

The Java Console is
not Enabled

Select the Tools from the browser menu, 
and click the Enable or Disable Add-
ons from the Manage Add-ons.
Select the Java(TM) Platform SE 
binary, and check Enabled if Disabled 
is checked.

Table 3-1:  Troubleshooting

Problem Case Solution
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Help
Navigator 2 describes the function of the Web screen with Help. Display Help 
by the following operation.

The following two ways exist for starting Help:
• Starting it from the Help menu in the Arrays screen
• Starting it with the Help button in the individual screen.

When starting the Help menu in the Arrays screen, the beginning of Help is 
displayed.

Figure 3-3:  Help - Welcome screen

The following message 
appears.
DMEG0002F0: Since 
memories required for the 
Advanced Settings are 
insufficient, a screen cannot 
be displayed.
Change a setup of Java 
Plug-in installed in the 
client and increase the 
usable memories.

Usable memory setting 
of Java does
not specify -
Xmx192m.

Open the Java Control Panel, and click 
View of the Java Applet Runtime 
Settings of the Java tab. Enter -
Xmx192m in the Java Runtime 
parameter in the Java Runtime 
Settings screen.
When installing the JRE Version 6 Update 
10, the above-mentioned specification is 
not required. Therefore, we recommend 
you to update it.

Table 3-1:  Troubleshooting

Problem Case Solution



Launching the Application 3–9

Hitachi Storage Navigator Modular 2 Advanced Settings User’s Guide

When starting it with the Help button in the individual screen, the 
description according to the function is displayed.

Figure 3-4:  Help - Context help screen shown in background

Changing the Port Number and Connection Address

Changing the Port Number for Starting Navigator 2
To change the port number you use for starting Navigator 2, operate it in 
the following procedure. For the default port number, 23015 is set.
1. Stop the SNM2 Server service (daemon process).
2. If there are other products to use Hitachi Storage Command Suite 

Common Components, stop the service (daemon process).
3. Stop the service (daemon process) for the Hitachi Storage Command 

Suite Common Components.
4. Edit setting file (httpsd.conf) and change the port number.

For Windows:
The listen in the C:\Program
Files\HiCommand\Base\httpsd\conf\httpsd.conf file specifies the port 
number. Rewrite to a port number you want to change.
For Linux and Solaris:
The listen in the /opt/HiCommand/Base/httpsd/conf/httpsd.conf file 
specifies the port number. Rewrite to a port number you want to change.

Listen 23015
5. Start the service (daemon process) for the Hitachi Storage Command 

Suite Common Components.
6. Start the SNM2 Server service (daemon process).
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7. If there are other products to use Hitachi Storage Command Suite 
Common Components, start the service (daemon process).

Changing the Port Number for Applet Screen of Navigator 2
When changing the port number used to display the Applet screen of 
Navigator 2, operate it in the following procedure. The number specified at 
the time of the installation is set for the default port number. The port 
number installed in default is 1099.
1. Stop the SNM2 Server service.
2. If there are other products to use Hitachi Storage Command Suite 

Common Components, stop the service (daemon process).
3. Stop the service (daemon process) for the Hitachi Storage Command 

Suite Common Components.
4. Edit two setting files (snm.conf and snmserver.properties) and change 

the port number. Set the same number for the two files. If the set 
number differs, the Applet screen will not be displayed.
For Windows:
The launch.port in the C:\Program 
Files\HiCommand\StorageNavigatorModular\conf\snm.conf file 
specifies the port number. Rewrite to a port number you want to change.

Launch.port=1099
The jp.co.Hitachi.strdiskarray.rmi.port in the C:\Program 
Files\HiCommand\StorageNavigatorModular\server\snmserver.properti
es file specifies the port number. Rewrite to a port number you want to 
change.

jp.co.Hitachi.strdiskarray.rmi.port=1099
For Linux and Solaris:
The launch.port in the
/opt/HiCommand/StorageNavigatorModular/conf/snm.conf file specifies 
the port number. Rewrite to a port number you want to change.

Launch.port=1099
The jp.co.Hitachi.strdiskarray.rmi.port in the
\opt\HiCommand\StorageNavigatorModular\server\snmserver.properti
es file specifies the port number. Rewrite to a port number you want to 
change.

jp.co.Hitachi.strdiskarray.rmi.port=1099

NOTE: If you change the port number used by Hitachi Storage Command 
Suite Common Components, all the installed products to use Hitachi 
Storage Command Suite Common Components are affected. When other 
products to use Hitachi Storage Command Suite Common Components are 
installed, check that the port number change does not cause problems for 
operating other products.
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5. Start the service (daemon process) for the Hitachi Storage Command 
Suite Common Components.

6. Start the SNM2 Server service (daemon process).
7. If there are other products to use Hitachi Storage Command Suite 

Common Components, start the service (daemon process).

Changing the Connection Address for Applet Screen of Navigator 2
Make the change only when you want to change the IP address of the host 
in which Navigator 2 has been already installed. If you only change the 
connection address, the Applet screen will not be displayed.

To change the connection address used to display the Applet screen of 
Navigator 2, operate it in the following procedure. The address specified at 
the time of the installation is set for the default address. Specify the IP 
address or the host name of the installed host.
1. Stop the SNM2 Server service (daemon process).
2. If there are other products to use Hitachi Storage Command Suite 

Common Components, stop the service (daemon process).
3. Stop the service (daemon process) for the Hitachi Storage Command 

Suite Common Components.
4. Edit setting file (snmserver.properties) and change the connection 

address.
For Windows:
The jp.co.Hitachi.strdiskarray.rmi.hostname in the C:\Program 
Files\HiCommand\StorageNavigatorModular\server\snmserver.properti
es file specifies the connection address. Rewrite to a connection address 
you want to change.
For Linux and Solaris:
The jp.co.Hitachi.strdiskarray.rmi.hostname in the
/opt/HiCommand/StorageNavigatorModular/server/
snmserver.properties file specifies the connection address. Rewrite to a 
connection address you want to change.

jp.co.Hitachi.strdiskarray.rmi.hostname=192.168.0.1
5. Start the service (daemon process) for the Hitachi Storage Command 

Suite Common Components.
6. Start the SNM2 Server service (daemon process).
7. If there are other products to use Hitachi Storage Command Suite 

Common Components, start the service (daemon process).

Stopping and Starting the Services (Daemon Process)
If you install Navigator 2 in Windows, Hitachi Storage Command Suite 
Common Components and the SNM2 Server are registered in the OS as 
services. If you install Navigator 2 in Linux and Solaris, start and stop 
scripts of the process are created below /etc/init.d and the Hitachi Storage 
Command Suite Common Components and SNM2 Server are executed 
automatically as the daemon process when it starts.
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Because the services (daemon process) are registered in the start status, if 
you start the OS, the services (daemon process) are automatically started. 
When a user performs the following operations, however, the user must 
stop, start, or restart the services (daemon process) of Hitachi Storage 
Command Suite Common Components and the SNM2 Server.
• Updating installation of Navigator 2
• Uninstalling of Navigator 2
• Installing other products to use Hitachi Storage Command Suite 

Common Components
• Uninstalling other products to use Hitachi Storage Command Suite 

Common Components
• Changing the setting files of Navigator 2
• When it is required to stop or start the service (daemon process) to use 

Hitachi Storage Command Suite Common Components while another 
product is in use

When the service (daemon process) is stopped, the functions of Navigator 
2 and other products to use Hitachi Storage Command Suite Common 
Components become unable to be used. Check the following items before 
stopping the service (daemon process).
• All users must not be using Navigator 2.
• No problem occurs even if the error monitoring is temporarily 

invalidated.
• Update of the firmware must not be operated.
• No problem occurs even if services (daemon process) of other products 

to use Hitachi Storage Command Suite Common Components are 
stopped. (Refer to the manual of each product for the cautionary notes 
on stopping the services (daemon process) of other products.)

You can restart the services (daemon process) by continuing each operation 
to stop or start the services (daemon process).

Stopping the Services (Daemon Process)
To stop the services (daemon process):
1. Stop the SNM2 Server service (daemon process).
2. Stop the service (daemon process) for the Hitachi Storage Command 

Suite Common Components.

Among the above procedures, if other products to use Hitachi Storage 
Command Suite Common Components are installed, step 2, is not required 
for each product but it is executed only once. Besides, the operations other 
than the above may be required for each product when the services 
(daemon process) are stopped. Refer to the manual of each product for the 
details.
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Stopping the SNM2 Server Service (Daemon Process)

For Windows

To stop the SNM2 Server service, used the Control Panel or Command 
Prompt of Windows.

Control Panel
1. In the Windows Start menu, choose Settings, Control Panel.
2. From the Control Panel, select the Administrative Tools.
3. Select the Services.
4. From the Services (Local) list, select the SNM2 Server.
5. Select the Stop the service.

Command Prompt
1. In the Windows Start menu, choose Programs, Accessories, and then 

Command Prompt.
2. In the Command Prompt, specify as following command and then 

press the Enter.

C:\> net stop snm2server

Any directory can be the current directory at the time of the command 
execution.

For Linux and Solaris

To stop the SNM2 Server daemon process, execute the following 
command.

/etc/init.d/snm2srv stop

The root authority is required to execute the command. Any directory can 
be the current directory at the time of the command execution.

Stopping the Hitachi Storage Command Suite Common Components

For Windows

To stop the Hitachi Storage Command Suite Common Components service, 
used the Command Prompt of Windows.
1. In the Windows Start menu, choose Programs, Accessories, and then 

Command Prompt.
2. The command prompt moves the current directory to the directory in 

which the commands of Hitachi Storage Command Suite Common 
Components have been installed.

C:\> cd /D C:\Program Files\HiCommand\Base\bin
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3. The directory in which the commands of Hitachi Storage Command Suite 
Common Components have been installed, specify as following 
command and then press the Enter.

C:\Program Files\HiCommand\Base\bin\hcmdssrv /stop

4. It may take several seconds to several minutes to stop the service. 
Check that the service is stopped by executing the following command.

C:\Program Files\HiCommand\Base\bin>hcmdssrv /status

The underlined part of the command, C:\Program Files\HiCommand, is 
a path of the folder in which Hitachi Storage Command Base Common 
Components is installed. It is required to replace it according to the 
environment in which Hitachi Storage Command Base Common 
Components is installed. In the environment not using the products to 
use Hitachi Storage Command Suite Common Components other than 
Navigator 2, this folder is the same as that in which Navigator 2 has been 
installed. If other products are also installed, specify a folder that was 
specified when the first product was installed.

For Linux and Solaris

To stop the Hitachi Storage Command Suite Common Components daemon 
process, execute the following command.

/opt/HiCommand/Base/bin/hcmdssrv -stop

The root authority is required to execute the command.
Any directory can be the current directory at the time of the command 
execution.

It may take several seconds to several minutes to stop the daemon process. 
Check that the daemon process is stopped by executing the following 
command.

/opt/HiCommand/Base/bin/hcmdssrv -status

The underlined part of the command, /opt/HiCommand, is a path of the 
directory in which Hitachi Storage Command Base Common Components is 
installed. For Linux, it is required to replace it according to the environment 
in which Hitachi Storage Command Base Common Components is installed. 
In the environment not using the products to use Hitachi Storage Command 
Suite Common Components other than Navigator 2, this directory is 
/opt/HiCommand. If other products are also installed, specify a directory 
that was specified when the first product was installed. Refer to the manual 
of each product for the details.

For Solaris, it is not required to replace /opt/HiCommand.

NOTE: Do not directly stop the service of Hitachi Storage Command Suite 
Common Components using the Services screen of the Control Panel or 
the net stop command. If you stop it directly, Hitachi Storage Command 
Suite Common Components may become unable to be used.
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Starting the Services (Daemon Process)
To start the services (daemon process):
1. Start the service (daemon process) for the Hitachi Storage Command 

Suite Common Components.
2. Start the SNM2 Server service (daemon process).

Among the above procedures, if other products to use Hitachi Storage 
Command Suite Common Components are installed, step 1, is not required 
for each product but it is executed only once. Besides, the operations other 
than the above may be required for each product when the services 
(daemon process) are stopped. Refer to the manual of each product for the 
details.

Starting the Command Suite Common Components

For Windows

To start the Hitachi Storage Command Suite Common Components 
service,used the Command Prompt of Windows.
1. In the Windows Start menu, choose Programs, Accessories, and then 

Command Prompt.
2. The command prompt moves the current directory to the directory in 

which the commands of Hitachi Storage Command Suite Common 
Components have been installed.

3. The directory in which the commands of Hitachi Storage Command 
SuiteCommon Components have been installed, specify as following 
command and then press the Enter.

C:\Program Files\HiCommand\Base\bin>hcmdssrv /start

4. It may take several seconds to several minutes to start the service. 
Check that the service is started by executing the following command.

C:\Program Files\HiCommand\Base\bin>hcmdssrv /status

The underlined part of the command, C:\Program Files\HiCommand, is 
a path of the folder in which Hitachi Storage Command Base Common 
Components is installed. It is required to replace it according to the 
environment in which Hitachi Storage Command Base Common 
Components is installed.

NOTE: In the process of the Hitachi Storage Command Suite Common 
Components, do not stop it by using the script below /etc/init.d or by 
sending a signal with the kill command, etc. If you stop it in such method, 
you may not use the Hitachi Storage Command Suite Common 
Components.
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For Linux and Solaris

To start the Hitachi Storage Command Suite Common Components daemon 
process, execute the following command.

/opt/HiCommand/Base/bin/hcmdssrv -start

The root authority is required to execute the command.
Any directory can be the current directory at the time of the command 
execution.

It may take several seconds to several minutes to start the daemon process. 
Check that the daemon process is stopped by executing the following 
command.

/opt/HiCommand/Base/bin/hcmdssrv -status

The underlined part of the command, /opt/HiCommand, is a path of the 
directory in which Hitachi Storage Command Base Common Components is 
installed. For Linux, it is required to replace it according to the environment 
in which Hitachi Storage Command Base Common Components is installed. 
In the environment not using the products to use Hitachi Storage Command 
Suite Common Components other than Navigator 2, this directory is /opt/
HiCommand. If other products are also installed, specify a directory that 
was specified when the first product was installed. Refer to the manual of 
each product for the details.

For Solaris, it is not required to replace /opt/HiCommand.

Starting the SNM2 Server Service (Daemon Process)

For Windows

To start the SNM2 Server service, used the Control Panel or Command 
Prompt of Windows.

Control Panel
1. In the Windows Start menu, choose Settings, Control Panel.
2. From the Control Panel, select the Administrative Tools.
3. Select the Services.

NOTE: Do not directly start the service of Hitachi Storage Command Suite 
Common Components using the Services screen of the Control Panel or 
the net start command. If you start it directly, Hitachi Storage Command 
Suite Common Components may become unable to be used.

NOTE: In the process of the Hitachi Storage Command Suite Common 
Components, do not start it by using the script below /etc/init.d or by 
sending a signal with the kill command, etc. If you stop it in such method, 
you may not use the Hitachi Storage Command Suite Common 
Components.
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4. From the Services (Local) list, select the SNM2 Server.
5. Select the Restart the service.

Command Prompt
1. In the Windows Start menu, choose Programs, Accessories, and then 

Command Prompt.
2. In the Command Prompt, specify as following command and then 

press the Enter.

C:\> net start snm2server

Any directory can be the current directory at the time of the command 
execution.

For Linux and Solaris

To start the SNM2 Server daemon process, execute the following command.

/etc/init.d/snm2srv start

The root authority is required to execute the command.
Any directory can be the current directory at the time of the command 
execution.

Automatic Log-off
When you do not operate anything for 20 minutes or longer while displaying 
the Applet screen of Navigator 2, a logoff is done automatically by the 
SNM2 Server and you will not be able to operate it on the Applet screen. 
However, you may continue to operate it on the Web screen.

Access to a host by Navigator 2 occurs when the configuration information 
is set. It does not occur in a change of the displayed information such as a 
tab switching on the Applet screen.

When the automatic logoff runs, a message is displayed in response to the 
operation informing that the connection to the host is impossible. When the 
message is displayed, return to the Array screen, select the Array again, 
and display the Array screen.

Setting the Server Certificate and Private Key
We recommend that you use the server certificate and private key for 
SSLcommunication that you have created for using the array safely in your 
environment. The methods to create and set the server certificate and 
private key using OpenSSL are shown here.
1. Stop the services for Navigator 2.

Stop the service of the SNM2 Server first and then stop the service of 
Hitachi Storage Command Suite Common Components. For more 
details, see the section 805518148.

2. Create a private key.
Create a private key using the hcmdssslctool command.
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Open the command prompt (terminal console for Unix) and move to the
following directory.
For Windows: <Navigator 2 installation directory>\Base\bin
For Unix: <Navigator 2 installation directory>/Base/httpsd/sslc/bin
Execute the following command line. The underlined part indicates a bit 
length of the key. Enter any of 2048 and 3072.
You must create the directory that to be output a private key in advance.
For Windows:

hcmdssltool /key <file name of private key> /csr <file name of CSR>
/cert <file name of self-signed certificate file>
/certtext <file name of self-signed certificate displaying contents file>
/dname “CN=<server name>, OU=<organization unit>, 0=<organization name>,

L=<city or locality>, S=<state or province>, C=<country-code>

For Unix:

hcmdssltool -key <file name of private key> /csr <file name of CSR>
-cert <file name of self-signed certificate file>
-certtext <file name of self-signed certificate displaying contents file>
-dname “CN=<server name>, OU=<organization unit>, 0=<organization name>,

L=<city or locality>, S=<state or province>, C=<country-code>

An execution example is shown below. You must enter all of the following 
environment variable text during one session.

hcmdssltool /key c:\ca\httpsdkey.pem /csr c:\ca\httpsd.csr /cert c:\cs\httpsd.pem
/certtext c:\ca\httpsd.pem.txt /dname “CN=Hitachi, OU=hsnm2, O=Hitachi, 
L=San Jose,S=California, C=us”
KAPM0674-I The hcmdsssltool command ended successfully.

3. Issue the certificate in the external CA (Certificate Authority):
Send the CSR file created in step 2 to the CA which supports SHA256, 
and obtain the certificate of the SHA256 signature algorithm in PEM 
format. Note that when using the self-signing certificate, you do not 
need to send it to the CA. Use the self-signing certificate file created in 
step 2.

4. Create a Certificate Signing Request (CSR).
To create a CSR, execute the following command line.
For Windows:

hcmdssslc req -config “C:\Program Files\HiCommand\Base\httpsd\sslc\bin\demoCA\sslc.cnf”
-new -key c:\ca\httpsdkey.pem -out c:\ca\httpsd.csr

For Unix:
./ssslc req -config /opt/HiCommand/Base/httpsd/sslc/bin/demoCA/sslc.cnf”

-new -key ca/httpsdkey.pem -out /ca/httpsd.csr 

An execution example is shown below:

Using configuration from C:\Program Files\HiCommand\Base\httpsd\sslc\bin\demoCA\sslc.cnf
You will be prompted to enter information to incorporate into the certificate request.
This information is called a Distinguished Name or a DN.
There are many fields however some can remain blank.
Some fields have default values.
Enter '.', to leave the field blank.
-----
Country Name (2 letter code) []:us
State or Province Name (full name) []:California
Locality Name (eg, city) []:San Jose
Organization Name (eg, company) []:Hitachi
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Organizational Unit Name (eg, section) []:Hitachi
Common Name (eg, YOUR name) []:Hitachi
Email Address []:
Please enter the following 'extra' attributes
to be sent with your certificate request
A challenge password []:
An optional company name []:

Submit the created csr file (“httpsd.csr” in the above example) to the CA 
(Certificate Authority) and obtain the signed certificate.
Even if you do not submit the csr file or obtain the signed certificate file 
from the CA, you can correspond to SSL by creating the certificate file 
with your signature using the hcmdssslc (sslc for Unix) command. In 
this case, however, the warning screen is displayed at the time of the 
initial screen display of Navigator 2, and when the applet launches.
To create a self-signed certificate file, using the hcmdssslc (sslc for 
Unix) command. Execute the following command line.
For Windows:

.hcmdssslc x509 -in c:\ca\httpsd.csr -out c:\ca\newcert.pem -reg -signkey
c:\ca\httpsdkey.pem -days 365

c:\ca\httpsd.csr: CSR to CA
c:\ca\newcert.pem: self-signed certificate
c:\ca\httpsdkey.pem: key file
Add screen from PDF on page 3-23

For Unix:

./sslc x509 –in /ca/httpsd.csr –out /ca/newcert.pem –reg –signkey
/ca/httpsdkey.pem -days 36

/ca/httpsdkey.pem –days 36

5. Edit the httpsd.conf file.
Open the httpsd.conf file stored in <installation_directory>\Base\httpsd\conf with the 
text editor and edit it.
Remove “#” of the following underlined lines which are commented out 
by default and change the values of “SSLCertificateFile” and
“SSLCertificateKeyFile”.
Specify the signed certificate file obtained from the CA for
“SSLCertificateFile” and the full path of the private key file created in 
step 2 for “SSLCertificateKeyFile”.
The contents of the file are shown below:

SSLSessionCacheSize 0
#Listen 23016
#Listen [P::]:23016
#<VirtualHost slj-orca2xp:23016>
#ServerName slj-orca2xp
#SSLEnable
#SSLProtocol SSLv3 TLSv1
#SSLRequiredCiphers AES256-SHA:AES128-SHA:DES-CBC3-SHA
#SSLRequireSSL
#SSLCertificateFile “C:/ca/httpsd.pem”
#SSLCertificateKeyFile “C:/ca/httpsdkey.pem”
#SSLCACertificateFile “C:/Program
#Files/HiCommand/Base/httpsd/conf/ssl/cacert/anycert.pem”
#SSLSessionCacheTimeout 3600#</VirtualHost>
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SSLProtocol TLSv1

6. Start the services for Navigator 2.
Start the service of the SNM2 Server first and then start the service of 
Hitachi Storage Command Suite Common Components. For more 
details, see the section 805518148.

7. Confirm SSL communication.
Activate the browser and specify the URL as follows.

https//############:23016/StorageNavigatorModular/

IP address of host name of host The port number of the host

Setting the Server Certificate and Private Key for Applet 
Screen of Navigator 2

Hitachi recommend that you use the server certificate and private key for 
SSL communication that you have created for using the array safely in your 
environment. The methods to create and set the server certificate and 
private key using OpenSSL are shown here.

The setting is not required if you do not display the applet screen for 
operating the Advanced Settings.

The applet screen can only connect either the normal port or secure port.
1. Execute the setting tool.

Open the command prompt (terminal console for Unix) and move to the
following directory.
For Windows:
<Navigator 2 installation directory>\StorageNavigatorModular\bin
For Unix:
<Navigator 2 installation directory>/StorageNavigatorModular/bin
Execute the following command.

For Windows: snmkey.bat
For Unix: ./snmkey.sh

NOTE: Since the SSLProtocol row specifies a protocol used for 
communication, the security vulnerability CVE-2014-3566 (https://
web.nvd-nist.gov/view/vuln/detail?vulnid-CVE-2014-3566) exists in 
SSLv3 (SSL3.0). You can avoid the vulnerability by specifying TLSv1 
(TLs1.0) only (set other rows as mentioned above).

In that case, however, it is necessary to set up so that TLSv1 can be used 
in a browser (for Internet Explorer, enable Tools -> Internet Options -> 
Advanced -> Security -> Use TLS1.0). If you only specify TLSv1 by 
SSLProtocol of the httpsd.conf file and does not set TLSv1 to be usable in 
the browser, you cannot access Navigator 2.
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An execution example is shown below: The shading parts are the input 
information.

cd “C:\Program Files\HiCommand\StorageNavigatorModular\bin”
c:
snmkey.bat

Keystore file or certification file are already existed.
If you set the secure port as use, the files are overwritten.
Are you sure you want to continue? (y/n) [n]:y

2. When you created the keystore file and the certification file for a client 
installation already, enter y on the above screen.

These settings need to stop the HiCommand Suite Common Component services and the RMI server 
service.
Do you want to continue processing? (y/n) [n]: no
Stopping the HiCommand Suite Common Component services...success
Stopping the RMI server service...success

3. When the Hitachi Storage Command Suite Common Components 
services or the RMI server service being was starting, the above 
message appears. Enter y on the above screen.

Current RMI normal port number:1099
Input the normal port number (Input “unset” to unset

4. Enter the port number that you want to set the normal port.
If you enter the unset, the normal port is not available

Current RMI secure port number:unset
Input the secure port number (Input “unset” to unset) [unset]:10995

5. Enter the port number that you want to set the secure port.
If you enter the unset, the secure port is not available.

Input the alias name of keystore file [snm2rmi]:mysnm2rmi

Input the new password of keystore file:abcdefg

Creating keystore...success
Signing to keystore...success
Creating certification file...success
Updating certification file...success

RMI security settings have been set successfully.

Certification file have been output to the following path.
<C:\Program Files\HiCommand\StorageNavigatorModular\security\snm2rmi.cert>

6. Input the alias name and password of the keystore file for using SSL.
When the processing ended successfully, the created certification file 
path for a client is displays (the above underline).

Starting the RMI server service...success
Starting the HiCommand Suite Common Component services...success

All process completed.

NOTE: You cannot set the same port number to the normal and secure 
port number.
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When the processing ended successfully, the Hitachi Storage Command 
Suite Common Components services and RMI server service are starting 
automatically, and the command prompt (terminal console for Unix) 
screen is closed.

Execute the installation for the client side in the following procedure. Use 
the created certificate file for a client that you created in step 5 in the 
previous procedure. 
1. When a client and server are different, copy the certificate to a client.
2. Open the command prompt (terminal console for Unix) and move to the 

following directory.

<JRE installation directory>\bin

3. Execute the following command line. The underlined part is an item that 
the user can enter as an option.

keytool –import

-keystore “<JRE installation directory>\lib\security\cacerts”

–alias <alias name>

-file <created certificate file for a client>

An execution example is shown below:

keytool –import –keystore “C:\Program Files\Java\server\jre1.6.0_10\lib\security\cacerts” -alias snm2rmi 
–file “C:\cert\snm2rmi.cert”

Enter keystore password:  changeit
Owner: CN=Hitachi, OU=Hitachi, O=Hitachi, L=San Jose, ST=California, C=us
Issuer: CN=Hitachi, OU=Hitachi, O=Hitachi, L=San Jose, ST=California, C=us
Serial number: 47b429aa
Valid from: Thu Feb 14 20:44:42 PDT 2008 until: Wed May 14 20:44:42 PDT 2008
Certificate fingerprints:
         MD5:  D8:C3:CC:59:93:68:DA:68:8A:6F:0A:87:78:E8:74:32
         SHA1: C4:2D:49:2E:1E:AF:CC:AF:F5:1D:B2:A3:1C:44:DE:90:72:32:67:13
Trust this certificate? [no]:  yes
Certificate was added to keystore

4. Enter chageit for the password.
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4
Advanced Settings

This chapter describes thow to start and configure advanced 
settings using Navigator 2.

This chapter includes the following:

Starting the Advanced Settings

Boot Options

System Parameter

Port Options

Restore Options
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Starting the Advanced Settings
For details on acquiring the graph and outputting a .CSV file of the 
Performance Monitor, refer to the Performance Monitor User’s Guide. 

To start Advanced Settings:
1. Start Navigator 2.
2. Log in as registered user to Navigator 2.
3. Select an array unit in which you will set up advanced settings.
4. Click Show & Configure Array.
5. Select Advanced Settings icon in the Settings tree view.
6. Click Open Advanced Settings.

Figure 4-1:  Advanced Settings window

After a few minutes, an Array Unit (Applet) screen displays.

• Close the Web browser, stop the SNM2 Server once, restart it, and 
display the screen of the Array you want to operate.

• Close the Web browser; confirm the SNM2 Server is started. If it has 
stopped, start it and display the screen of the Array that you want to 
operate.

NOTE: Note: The Applet screen is displayed connected to the SNM2 
Server. If 20 minutes elapses while displaying the Applet screen, you will 
not be able to operate it due to the automatic logoff function. If the 
operation is completed, close the screen. If the Applet screen cannot be 
displayed, the login to the SNM2 Server may have failed. In this case, the 
Applet screen cannot be displayed again. The code: 0x000000000000b045 
or “DMEG800003: The error occurred in connecting RMI server.” is 
displayed on the Applet screen. Take the following actions.
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• Return to the Array screen after 20 minutes elapsed and display the 
screen of the Array you want to operate.

Figure 4-2:  Array Unit Screen

Configuration Settings
1. Select Configuration Settings icon in an Array Unit tree view.
2. Click Set.
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The Configuration Settings tab page is displays.

Figure 4-3:  Configuration Settings window

Boot Options
When the boot option is set, the subsystem requires a restart after setting 
changes.

To set the boot options:
1. Select or enter the following boot options.

• System Startup Attribute: Select the subsystem configuration.
Single Mode: Single configuration
Dual Active Mode: Dual active configuration

• Delay Planned Shutdown: Specify the time in minutes to delay 
the execution of the planned shutdown when the main switch has 
turned off. The applicable range is from 0 to 60 minutes.

WARNING! Rebooting requires stopping I/O from the host.
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• Vendor ID: Enter an eight-character vendor name. When the 
name consists of less than eight characters, make an eight-
character entry by filling the reset with space(s). The default value 
set in HITACHI .  Denotes a space.)

• Product ID: Enter a 16-character model name. When the name 
consists of less than 16 characters, make a 16-character entry by 
filling the reset with space(s).
The default value set in DF600F .  Denotes a space.)

• ROM Microprogram Version: Specify a microprogram version of 
a ROM reported by inquiry command.

• RAM Microprogram Version: Specify a microprogram version of 
a RAM reported by inquiry command.

2. Click Apply.
3. Follow the information in messages that appear. Click OK to continue.

Figure 4-4:  Boot Option confirm message box

Figure 4-5:  Boot Options output message box
When you choose to restart the subsystem, the time the restart began is displayed. 
This usually takes approximately four to fifteen minutes.

Figure 4-6:  Reboot Dialog message box

NOTE: It may take time for the subsystem to respond, depending on the 
condition of the subsystem. If it does not respond after 15 minutes or more, 
check the condition of the subsystem.
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4. A message appears, stating that the restart is successful. Click OK.

Figure 4-7:  Subsystem restart message box

5. A message appears, click Close.

System Parameter
This setting information becomes valid without restarting the subsystem.
1. Click Open Advanced Settings.

After a few minutes, an Array Unit screen displays.
2. Select Configuration Settings icon in an Array Unit tree view.
3. Click Set.
4. Click the System Parameter tab.

Figure 4-8:  Configuration Settings - System Parameters tab

5. Set the system parameters. See Table 4-1 for a description of these 
parameters.

6. Click Apply.
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7. Follow the information in messages that appear. Click OK to continue.

Figure 4-9:  System parameter confirm message box
Table 4-1:  Setting System Parameters

Parameter Description Operation

Turbo LU Warning

This parameter is to be 
specified when the Turbo LU 
setting function is used.

Default = Disable

Disable: When the Turbo LU 
can no longer be maintained 
due to a failure, the parameter 
allows host access to be 
issued.

Enable: When the Turbo LU 
can no longer be maintained 
due to a failure and the 
performance is lowered, the 
parameter suppresses host 
access and issues a warning

Write Unique 
Response Mode

This parameter is to be 
specified when a host of the 
NX series is connected.

Default = Disable

Disable: Cache memory is 
used for write commands.

Enable: Write commands are 
executed unconditionally in 
write-through mode (write 
data directly to disk without 
using cache).

Auto 
Reconstruction 
Mode

This parameter specifies 
operations to be performed 
when a disk drive is removed.

Default = Disable

Disable: When a disk drive is 
removed, correction copy to a 
spare disk drive is not 
performed.

Enable: When a disk drive is 
removed, correction copy to a 
spare disk drive is performed.

Caution: This mode is for test 
purposes and should only be 
used by authorized service 
personnel.

Forced Write 
Through Mode

This parameter specifies the 
method for executing write 
commands after a CTL 
detachment or power failure.

Default = Disable

Disable: If a CTL detachment 
or power failure has occurred, 
cache memory is used for 
write commands.

Enable: If a CTL detachment 
or power failure has occurred, 
write commands are executed 
in write-through mode (write 
data directly to disk without 
using cache).
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ShadowImage I/O 
Switch Mode

This parameter specifies an 
operation of a ShadowImage 
P-VOL to be performed when a 
double disk drive failure 
occurs.

Default = Disable

Disable: If a double failure 
occurs in disk drives of a 
ShadowImage P-VOL in the 
PAIR status, the status is 
changed to PSUE.

Enable: If a double failure 
occurs in disk drives of a 
ShadowImage P-VOL in the 
PAIR status, the execution of 
the host I/O is switched to the 
S-VOL to continue the 
execution.

Note: For further information, 
see the ShadowImage User’s 
Guide.

Synchronize Cache 
Execution Mode

This parameter specifies an 
operation to be performed 
when the Synchronize Cache 
command is received.

Disable: No operation is 
performed when the 
Synchronize Cache command 
is received.

Enable: When the 
Synchronize Cache command 
is received, all data in the 
cache memory is written to 
disk drives.

Note: For further information, 
see the TrueCopy User’s 
Guide.

Drive Detach Mode

Specifies an operation to be 
performed when a drive failure 
occurs in the same RAID 
group.

Default = Disable

Disable: When a failure 
occurs in a diskdrive in a state 
in which another disk drive in 
the same RAID group has 
already been detached due to 
a failure, the parameter does 
not detach the disk drive that 
failed secondarily.

Enable: When a failure occurs 
in a disk drive in a state in 
which another disk drive in the 
same RAID group has already 
been detached due to a 
failure, the parameter 
detaches the disk drive that 
failed secondarily and 
detaches LUs (makes LUs 
unformatted) in the RAID 
group concerned.

Lower Drive 
Detach Threshold 
Mode

Specifies whether to set the 
Lower Drive Detach Threshold 
Mode effective or ineffective.

Defaul = Disable

Table 4-1:  Setting System Parameters

Parameter Description Operation
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Port Options
The Port Options tab allows you to set the system parameter port options. 
The setting information becomes valid without restarting the subsystem.
1. Click Open Advanced Settings.

After a few minutes, an Array Unit screen displays.
2. Select Configuration Settings icon in an Array Unit tree view.
3. Click Set.

The Configuration Settings tab page is displays.

Operation if the 
Processor failures 
Occurs

This parameter specifies the 
operation to be performed 
when a processor failure 
occurs.

Default = Reset the Fault

Reset the Fault: The 
parameter resets.

Shutdown System: The 
parameter shuts the 
subsystem down

Web Title

When the Web function built in 
the subsystem is displayed 
with the browser, this 
parameter specifies 
characters to be displayed in 
the browser title bar.

Default = Not set 

Characters that can be 
entered (maximum 32) are 
alphabetic characters, 
numerals, and characters 
other than numerals 
(excluding ', ", and \).

Write & Verify 
Execution Mode

This parameter specifies the 
execution mode for write and 
verify operation.

Default = OFF

ON: The write and verify 
operation is performed.

OFF: The write and verify 
operation is not performed.

Table 4-1:  Setting System Parameters

Parameter Description Operation
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4. Click the Port Options tab.

Figure 4-10:  Configuration Settings - Port Options tab

5. Select the desired port, and then select the desired Port Options:
• Reset/LIP Mode (Signal): Set this option to transmit Reset/LIP 

signals to other ports.
• Reset/LIP Mode (Process): Set this option to transmit reset 

processing to other ports. If this option is set, the Reset/LIP 
Mode (signal) is automatically enabled.

• LIP Port ALL Reset Mode: Set this option to execute reset on 
receiving LIP.

6. Click Apply.
7. When the confirmation message displays, click OK.

Figure 4-11:  Port Options parameter confirmation message box

NOTE: Multiple Port Options can be set, but depending on the setting, it 
may not function properly. If it is to be set, please refer to the appended 
ubsystem manual and set only the applicable parameters.
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Restore Options
Do not set drive restoration options while a drive restoration is in progress.

To set drive restoration options:
1. Click Restore Options tab.

Figure 4-12:  Configuration Settings - Restore Options tab

2. Enter the following settings:
Drive Restoration Mode:
• Background: Executes drive restoration while host I/O 

processing is not executed.
• Interleave (Normal): Restores the drive at preset time intervals 

(specified as “Interval Time”) giving preference to a host command 
(restores after executing the command).

• Interleave (Prior): Restores the drive at preset time intervals 
(specified as “Interval Time”) taking preference over a host 
command

Drive Restoration:
• Manual: Starts restoring data and copying by manual operations.
• Auto: Automatically starts data and copying restoration.
Interval Time:
The default is 0 to 10 ms with restoration executed at intervals of 0 ms. 
To set, specify a multiplication factor from 0 to 255 in a unit of 10 ms.
Processing Unit Size:
Specify the size of the data block to be restored. The value of the range 
of 1 to 511 is specified by a multiple of 128. The minimum value is 128, 
which restores 65 kB data in a single operation. When Interleave mode 
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is specified, the function restores the data of the processing unit size 
that is specified, waits for the time interval that is specified, and then 
starts the next data restoration.
Dynamic Sparing: 
Specify a mode for data restoration for the spare drive when the error 
occurrence count controlled by preventive maintenance exceeds the 
threshold value.
• Execute (Read/Write & Online Verify): When the error 

occurrence count in Read/Write Error or Online Verify Error, 
data restorationis performed for the spare drive (when the spare 
drive is not used), and the error disk is blocked.

• Execute (Read/Write): When the error occurrence count in 
Read/Write Error exceeds the threshold value, data restoration is 
performed for the spare disk in the spare drive (when the spare 
disk is not used), and the error disk is blocked.
When the error occurrence count in Online Verify Error exceeds 
thethreshold value, but Dynamic Sparing is not performed.

• Do not Execute: When the error occurrence count in Read/Write 
Error or Online Verify Error exceeds the threshold value, but 
Dynamic Sparing is not performed.

Spare Drive Operation Mode: Specify the spare drive operation mode.
• Variable: When a failed drive is replaced, the new drive becomes 

a spare drive. However, even if the Spare Drive Operation Mode 
is set to Variable, it becomes operation of Fixed in SMS100.

• Fixed: Uses only a drive that is designated as a spare.
3. Click Apply.
4. A confirmation message displays. Click OK.

Figure 4-13:  Drive restoration information confirmation message box

Online Verify
To enable Online Verify Test or to Skip Online Verify:
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1. Click Online Verify tab.

Figure 4-14:  Configuration Settings - Online Verify tab

2. Select the desired options:
• Online Verify Test: Specify whether or not to execute Online 

Verify Test.
• Skip Online Verify: When a verify command is received from a 

host, ensure that verification operation is performed.
• Cache Verify: Specify whether or not to execute Cache Verify. 

Click Apply.
3. A confirmation message displays. Click OK.

Figure 4-15:  Online verify information confirmation message box

Constitute
This section describes how to output the configuration information of the 
subsystem in a text file or set the configuration using a text file.

The configuration information output in a text file includes the status of the 
system parameters, RAID group/DP pool/logical unit, port information, and 
the constituent parts of the subsystem. The configuration to be set includes 
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the system parameters, RAID group/DP pool/logical unit, and port 
information. The status of the constituent parts of the subsystem cannot be 
set.

The configuration information is handled with separate text files for the 
system parameters, for RAID group/DP pool/logical unit, and for port 
information.

Copying configuration information between subsystems can be executed by 
outputting a text file of the configuration from the subsystem, then using 
the output text file to set another subsystem.

Editing a text file to set the subsystem can be done, however, it is 
recommended that this function be used for the configuration of the same 
subsystem. To change the configuration, use individual functions.

File Output for System Parameters
To output the settings of the system parameters for the subsystem in text 
form to a specified file:
1. Click the Constitute tab.

Figure 4-16:  Configuration Settings - Constitute tab

2. Check the System Parameters option in the Select Configuration 
Information box.

3. Specify the file name to which the configuration file will be output.
4. Select the Output option.
5. Click Apply.
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6. When the confirmation message displays, click OK. Navigator 2 displays 
the following system message.

Figure 4-17:  System parameters output message box

System parameter information is saved in the form of a text file with 
thespecified file name. The format of the output file consists of the following 
items. The outline of the layout of the output file is shown in Figure 4.2.
• File header
• File format revision
• Subsystem registration name with Navigator 2
• Output time (Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• Navigator 2 version
• Common controller parameters
• Controller parameters

System parameter list.
File Format : 2.00

DF Name : SA800_81000026
Date : 2008/11/20 06:03:59
Firmware Revision : 1860/A-A
Array Unit Type : SA800
Serial Number : 81000026
#HSNM2 Version : 6.00

---- System Parameter ----
Options
  Turbo LU Warning = OFF
  Write Unique Response Mode = OFF
  Auto Reconstruction Mode = OFF
  Forced Write Through Mode = OFF
  ShadowImage I/O Switch Mode = OFF
  Synchronize Cache Execution Mode = OFF
  Drive Detach Mode = OFF
Operation if the Processor failures Occurs = Reset the Fault
Web Title = ""
---- CTL0 Parameter ----
Write & Verify Execution Mode = OFF
---- CTL1 Parameter ----
Write & Verify Execution Mode = OFF
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Setting System Parameters with a File
Set the system parameters in the subsystem with the information described 
in the file. If you set the system parameters using a file that was output 
when a priced optional feature is in an unlocked state, the setting may 
terminate abnormally. To set system parameters, use a file that was output 
when all priced optional features are in a locked state.

For a dual system, setting cannot be executed if one of the controllers is 
detached. Verify that the subsystem is operating normally.

When system parameters are set, the subsystem cannot execute 
commands from the host. The functions of Navigator 2 can no longer work; 
however, the wizard sets the system parameters and failure monitoring.

To set subsystem parameters with a file:
1. Edit the file for setting the system parameters to set the subsystem. The 

file has a specified format. The format of the file is the same as that of 
the file output by the subsystem. Refer to the following sections of this 
manual for the format and parameters of the file respectively.
For the format of the file, see section 0.

2. Click the Constitute tab.
3. Click the System Parameter option.
4. Specify the file name of the file that describes the system parameters 

edited in step 1. The specified file name displays in the text box.
5. Select the Input option.
6. Click Apply.

7. When the confirmation message displays, click OK.

Figure 4-18:  System parameter confirmation message box

Figure 4-19:  System parameters set message box
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RAID Groups/DP Pools/Logical Units and Configuration File Output 
Status

To output RAID group/logical unit definition information already set in the 
subsystem to a specified file in a text format:
1. Click the Constitute tab.

Figure 4-20:  Configuration Settings - Constitute tab

2. Click the RAID Group/DP Pool/Logical Unit option and RAID Group, 
DP Pool, or RAID Group/DP Pool in the Select Configuration 
Information box.

3. Specify the file name to output the file of the configuration.
4. Select the Output option.
5. Click Apply.

6. When the confirmation message displays, click OK.

Figure 4-21:  RAID/LU configuration confirmation message box

Configuration information is saved in the form of a text file with the 
specified file name.The format of the output file consists of the following 
items. 
• An outline of the layout of the output file.
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• File header
• File format revision
• Subsystem registration name at Navigator 2
• Output time (Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• Navigator 2 version
• RAID group/DP pool/logical unit configuration
• Drive configuration

y unit configuration information list.
File Format : 4.00

DF Name : AMS2100_83000026
Date : 2010/05/26 12:03:35
Firmware Revision : 0893/A-S
Array Unit Type : AMS2100
Serial Number : 83000026
#HSNM2 Version : 9.30

---- RAID Configuration Information ----
    ---- RAID Configuration ----
    RAID   RAID      Start Location     Number of HDU    Number of     Free Capacity  Type
    Group  Level  [Unit No.   HDU No.]  in parity group  parity group        [block]
        0  6              0          0                6             1     3806461952  SATA

    -- End

    ---- Drive Location of RAID Group ----
    RAID Group   Drive Location(Unit No.-HDU No.)
             0   0-0     0-1     0-2     0-3     0-4     0-5

    -- End
-- End

---- DP Pool Configuration Information ----
    ---- DP Pool Configuration ----
    DP Capacity Mode
        Current      = Regular Capacity
        User Setting = Regular Capacity
                                                       <DP Pool Consumed Capacity Alert>  <Over 
Provisioning Threshold>
    DP    RAID     Total       Consumed  Type    Page  Utilization  Early  Depletion      Over 
Provisioning  Warning  Limit  Notification
    Pool  Level    Capacity    Capacity          Size  Percent      Alert  Alert          Percent
      48  6          1.0 TB      0.0 MB  SAS     32MB           0%    40%        50%                     
0%     100%   130%  Disable

    -- End

    ---- DP RAID Configuration ----
    DP    RAID   RAID      Start Location     Number of HDU    Number of     Type
    Pool  Group  Level  [Unit No.   HDU No.]  in parity group  parity group
      48     47  6              2          0               10             1  SAS

    -- End

    ---- Drive Location of DP RAID Group ----
    RAID Group   Drive Location(Unit No.-HDU No.)
            47   2-0     2-1     2-2     2-3     2-4     2-5     2-6     2-7     2-8

    -- End
-- End

---- LU Configuration Information ----
    ---- LU Configuration ----
    LU        Capacity  Status      RAID   DP    RAID   Number of        Stripe Size    
Capacity  Type
    No.       [block]             Group  Pool  Level  Cache Partition        [KB]  [MB/GB/TB]
      0        2097152  Normal          0  N/A   6                    1          256      1.0 GB  SATA
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      1        4194304  Normal          0  N/A   6                    0          256      2.0 GB  SATA
     :

    -- End
-- End

---- Drive Configuration Information ----
Location       Status      Type        Vendor ID   Product ID         Revision   Serial 
Number   Capacity   Drive Type   Rotational Speed
Unit0 ,HDU0    Normal      Data        HITACHI     HDS725050KLA360    6666       HSAT500A
   500GB   SATA                  7200rpm
Unit0 ,HDU1    Normal      Data        HITACHI     HDS725050KLA360    6666       HSAT500B
   500GB   SATA                  7200rpm
     :

-- End

Setting RAID Group/DP Pool/Logical Unit Definition with a File
Set the subsystem according to the RAID group/DP Pool/logical unit setting 
information described in a file. If the setup of the RAID group/DP Pool/
logical unit is configured and completed, all of the previous user’s data will 
be lost. The RAID group/logical unit configuration, as specified in the file, is 
set after deleting the current RAID group/DP Pool/logical unit. If user data 
is needed, configure the setting after backing up the system.
1. Edit the file to set the RAID group/DP Pool/logical unit information in the 

subsystem. The file has a specified format. The format of the file is the 
same as that of the file output by the subsystem. For the proper file 
format, see section 0.
The parameters in the file are RAID configuration information, DP 
pool configuration information, LU configuration information, 
and Drive information in the format of the output file. In the output 
file, there are items that give the status of constituent parts. Ignore 
these items while setting up the configuration. The parameters are 
described below:
• RAID configuration information: Sets the RAID configuration 

which specifies RAID group number, RAID level, and RAID size. If 
the RAID group is not set, “-” is shown after Level, and no other 
parameters are set.

• DP pool configuration information: Sets the DP pool 
configuration which specifies RAID level, DP pool number, and pool 
size. If the DP pool configuration exits on the destination array, it 
generates an error.

• LU configuration information: Sets the logical unit 
configuration.
Specify thelogical unit number, logical unit capacity, logical unit 
status, RAID group number, RAID level, cache partition number, 
stripe size, and drive type.
In logical unit status, for cases where formatting is to be executed, 
specify Normal. Formatting cannot be executed if another status is 
specified.
In cases where the full capacity of the RAID group is allocated to one 
logical unit, specify All in Capacity.
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In cases where logical units of less than the maximum logical unit 
number are created, specify at the end that “After nn, not define” 
(nn: the last logical unit number + 1).
Drive information: Sets the configuration of the HDU installed in 
the subsystem. For an HDU that is not installed, do not specify 
anything.
When a capacity bigger than that of the installed HDU is specified, it 
is regarded as an error and not set.

2. Click the Constitute tab.
3. Click the RAID Group/DP Pool/Logical Unit option.
4. Specify the name of the file that describes the RAID group definition, DP 

pool definition, and logical unit definition edited in step 1. The specified 
file name is shown in the text box.

5. Select the Input option.
6. Click Apply.
7. Messages display and warn you of the following:

• The procedure deletes the current RAID/LU configuration.
• User data in the logical units are invalidated and cannot be 

recovered. 
To continue, click OK in the messages.
A message displays, stating that the RAID configuration setting has 
started.
When the setting of the RAID group ends abnormally, an error message 
displays and interrupts processing.
If the setting of the RAID group ends normally, a message that the 
setting of the DP pool has started displays, and executes the DP pool 
setting.
When the setting of the DP pool ends abnormally, an error message 
displays and interrupts processing.
If the setting of the DP pool ends normally, a message that the setting 
of logical unit has started displays, and executes the logical unit setting.

Figure 4-22:  DP pool configuration start message box
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8. A message displays stating that the setting is complete. Click OK.

Figure 4-23:  LU configuration start message box

Port Information File Output
To output the settings of the port information for the subsystem in text form 
to a specified file:
1. Click the Constitute tab.

Figure 4-24:  Configuration Settings - Constitute

2. Check the Port Information option in the Select Configuration 
Information box.

3. Specify the filename to which the port information file will be output.
4. Click the Output option.
5. Click Apply.
6. When the confirmation message displays, click OK.

The port information is saved in the form of a text file with the specified 
file name.
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The format of the output file consists of the following items. The outline 
of the layout of the output file is shown.
• File header
• File format revision
• Subsystem registration name at Navigator 2 
• Output time (Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• Navigator 2 version
• Mapping mode
• Port type
• Port information
• iSNS information
• Port options
• Target list
• Host system configuration
• Target options
• LU mapping information
• LUN Manager information
• Initiator information

Configuration Information list.
File Format : 2.02

DF Name : SA800_81000026
Date : 2010/05/24 06:04:25
Firmware Revision : 1890/A-H
Array Unit Type : SA800
Serial Number : 81000026
#HSNM2 Version : 9.05

---- CommonInformation ----
MappingMode = ON

---- CTL0 ----
 ---- PortA ----
  PortType = iSCSI
  ---- iSCSIPortInformation ----
   PortNumber = 3260
   KeepAliveTimer = 60
   MTU = 1500
   Ether Address = 00:00:87:66:FC:E4
   IPv4
     IPv4 Address = 192.168.0.200
     IPv4 SubnetMask = 255.255.255.0
     IPv4 DefaultGateway = 0.0.0.0

  ---- iSNS Information ----
   ServerUse = Not Used
   IPAddress = 0.0.0.0
   PortNumber = 3205

 ---- PortOptions ----
  Reset/LIP Mode(Signal) = OFF
  Reset/LIP Mode(Process) = OFF
  LIP Port All Reset Mode = OFF
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---- TargetList ----
  ---- TargetInformation ----
    TargetNumber = 0
    TargetAlias = "T000"
    iSCSI Name = "iqn.1994-04.jp.co.hitachi:rsd.d8a.t.00026.0a000"
    Authmethod = CHAP,None

      ---- HostSystemConfiguration ----
    Platform = not specified
    Middleware = not specified

   ---- TargetOptions ----
    Host Connection Mode 1 = Standard Mode
    Host Connection Mode 2
     HP-UX Mode = OFF
     PSUE Read Reject Mode = OFF
     Mode Parameters Changed Notification Mode = OFF
     NACA Mode = OFF
     Task Management Isolation Mode = OFF
     Unique Reserve Mode 1 = OFF
     Port-ID Conversion Mode = OFF
     Tru Cluster Mode = OFF
     Product Serial Response Mode = OFF
     Same Node Name Mode = OFF
     CCHS Mode = OFF
     Inquiry Serial Number Conversion Mode = OFF
     NOP-In Suppress Mode = OFF
     S-VOL Disable Advanced Mode = OFF

 ---- LuMapping ----
      H-LUN      LUN
          0        0
          1        1
               :
   -- TargetInformationEnd
  -- TargetListEnd

  --- LUNManagementInformation ---
   Security = OFF
  ---- InitiatorList ----
  -- InitiatorListEnd

 ---- PortB ----
  :
  :
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Setting Port Information with a File
To set port information settings with a file:
1. Click the Constitute tab.

Figure 4-25:  Configuration Settings - Constitute tab

2. Click the Port Information (Update) option in the Select 
Configuration Information box.

3. Select the items that you will set from setting information for iSCSI. An 
error will occur if nothing is chosen. (When the LUN Manager function is 
valid, the initiator Information displays for setting information for 
iSCSI.)

4. Specify the file name to which the port information file will be input.
5. Select the Input option.
6. When the confirmation message displays, click OK to continue.

File Output of Boot Option Information
1. Click the Constitute tab.
2. Check Boot Options in the Select Configuration Information box.
3. Specify the file name to which the boot option information file will be 

output.
4. Click Apply.
5. When the confirmation message displays, click OK.

The boot options information is saved in the form of a text file with the 
specified file name.

The format of the output file consists of the following items. 
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• File header
• File format revision
• Subsystem registration name at Navigator 2
• Output time (Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• Navigator 2 version
• Boot options information

Boot Option list.
File Format : 2.00

DF Name : SA800_81000026
Date : 2008/11/20 06:04:42
Firmware Revision : 1860/A-A
Array Unit Type : SA800
Serial Number : 81000026
#HSNM2 Version : 6.00

---- Boot Options ----
System Startup Attribute = Dual Active Mode
Delay Planned Shutdown[min.] = 0
INQUIRY Information
  Vendor ID = HITACHI
  Product ID = DF600F
  ROM Microprogram Version =
  RAM Microprogram Version =

Setting Boot Option Information with a File
When the boot option is set, the subsystem requires a restart after setting 
changes.

1. Click the Constitute tab.
2. Check Boot Options and Input option in the Select Configuration 

Information box.
3. Specify the file name to which the boot option information file will be 

input.
4. Click Apply.
5. When the confirmation message displays, click OK.

When you choose to restart the subsystem, the time the restart began 
is displayed. This usually takes approximately four to fifteen minutes.

6. A message appears, stating that the restart is successful. Click OK.
7. A message appears, click Close.

WARNING! Rebooting requires stopping I/O from the host.

NOTE: It may take time for the subsystem to respond, depending on the 
condition of the subsystem. If it does not respond after 15 minutes or more, 
check the condition of the subsystem.



4–26 Advanced Settings

Hitachi Storage Navigator Modular 2 Advanced Settings User’s Guide 

File Output of Parts Information
To output parts information to a file:
1. Click Open Advanced Settings.

After a few minutes, an Array Unit screen displays.
2. Select Configuration Settings icon in an Array Unit tree view.
3. Click Set.

The Configuration Settings tab page is displays.
4. Click the Constitute tab.
5. Check Parts Information in the Select Configuration Information 

box.
6. Specify the file name to which the parts information file will be output.
7. Click Apply.
8. When the confirmation message displays, click OK.

Setting CHAP User Information with a File
1. Click the Constitute tab.
2. Click the CHAP User option in the Select Configuration Information 

box.
3. Specify the file name to which the CHAP User information file will be 

input.
4. Select the Input option.
5. A confirmation message displays. To continue, click OK.

The CHAP User information setting file format is shown in Table 4.2.
Table 4-2:  CHAP User Information Setting File Format

File Contents Descriptions

User name,secret,Target No. or alias ... The lines are invalid until <CHAP User> appears.

<CHAP User>,, The valid lines are from <CHAP User> to <END>.

<Port 0A>,, The line specifies the port. (<Port ALL> specifies 
all ports)

hitachi-0,abcdefghij00,alias0 The first column is CHAP User, and the second 
column is Secret.

hitachi-1,abcdefghij01,alias1 The third row and the following are aliases of 
Target to assign.

#hitachi-1,abcdefghij01,alias1
The line with the first character of # is a comment 
line.

(Invalid line)

hitachi-2,abcdefghij02,3 The Target number can be specified as the alias of 
Target.

<Port 0B>,,

<Add CHAP User>,, If <Add CHAP User> is specified, CHAP User is 
added.
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File Output of LAN Information
To output the settings of the LAN information for the subsystem in text form 
to a specified file:
1. Click the Constitute tab.
2. Check the LAN Information option in the Select Configuration 

Information box.
3. Specify the file name to which the LAN information file will be output.
4. Click the Output option.
5. Click Apply.
6. When a message displays, confirming that the LAN information is output 

with the specified file name, click OK.

The LAN information is saved in the form of a text file with the specified 
filename.

The format of the output file consists of the following items.
• File header
• File format revision
• Subsystem registration name at Navigator 2
• Output time (Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• Navigator 2 version
• User LAN information
• Maintenance Port IP Address Automatic Change Mode
• Maintenance Port LAN information

Concerning the Ether Address of the user LAN information, only the 
information on the controller connected over the LAN is output. To output 
the information on the both controllers, connect the both controllers over 

hitachi-0,abcdefghij00,alias0 If <Add CHAP User> is specified, CHAP User is 
added.

hitachi-

1,abcdefghij01,alias0,alias01,alias02
One or more Targets can be specified.

<Port 1A>,,

<Port 1B>,,

<END>,, The line of <END> and the following are all invalid 
lines.

Table 4-2:  CHAP User Information Setting File Format

File Contents Descriptions
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the LAN. When the information is output in the state in which the 
controller(s) is (are) blocked, the LAN information on the blocked 
controller(s) is output as 0.0.0.0.

LAN parameter list.
File Format : 2.00

DF Name : SA800_81000026
Date : 2008/11/20 06:05:15
Firmware Revision : 1860/A-A
Array Unit Type : SA800
Serial Number : 81000026
#HSNM2 Version : 6.00

---- User LAN Parameter ----
  Maintenance Port IP Address Automatic Change Mode = OFF
  ---- CTL0 Parameter ----
    IPv4
      DHCP = OFF
      IPv4 Address = 125.30.9.143
      IPv4 Subnet Mask = 255.0.0.0
      IPv4 Default Gateway = 125.11.1.1
    Negotiation = Auto
    Ether Address = 00:00:87:C6:46:E1
  ---- CTL1 Parameter ----
    :
    :

---- Maintenance LAN Parameter ----
  ---- CTL0 Parameter ----
    IPv4
      IPv4 Address = 10.0.0.16
  ---- CTL1 Parameter ----
    IPv4
      IPv4 Address = 10.0.0.17

Setting LAN Information with a File

To set LAN settings with a file:
1. Click the Constitute tab.
2. Click the Input option in the Operation box.
3. Check the LAN Information option in the Select Configuration 

Information box.
4. Specify the file name to which the LAN information file will be input.
5. Click Apply.
6. A confirmation message displays. To continue, click OK.
7. Follow the information in messages that appear. Click Close.

Ping
Sends the ping to the initiator (host) and displays the result of the sending.

WARNING! The User LAN Parameter (Maintenance Port IP Address 
Automatic Change Mode, IP Address, Subnet Mask, Default Gateway) and 
Maintenance LAN Parameter (Network Address) can be set up. The other 
information cannot be set up.
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1. Click the Ping tab.

2. Set the ping parameters:
• Port/Destination IP Address: Select the port that sends the 

ping. And specify the IP address of the initiator.
3. Click Start.
4. Click OK to continue.

The result displays.
5. Select Refresh as necessary to display the latest information.



4–30 Advanced Settings

Hitachi Storage Navigator Modular 2 Advanced Settings User’s Guide 

Format Mode
Changes to Format Priority Mode apply without restarting the subsystem.
1. Click the Format Mode tab.

2. Select the Format Priority Mode and Format Data settings.
Format Priority Mode:
• Normal: Formats at an idle time when no host I/O is executed.
• Host: Host's I/O is executed preferentially.
• Format: Subsystem formats are done preferentially.

Format Data: Specify a format data.

3. Click Apply.

4. A confirmation message displays. Click OK.

Figure 4-26:  Format Priority Mode confirmation message

Access Mode
The access mode default setting is Enable for each port.



Advanced Settings 4–31

Hitachi Storage Navigator Modular 2 Advanced Settings User’s Guide 

You can set to Disable the access mode if necessary.
1. Click the Access Mode plus sign. Select Mapping Mode.

Figure 4-27:  Mapping Mode window

2. On the Mapping Mode list, select Enable or Disable, and click Modify.

The Modify Mapping Mode dialog box displays.

Figure 4-28:  Modify Mapping Mode

3. Select Disable or Enable and click OK.
4. A confirmation message displays. Click OK.

Mapping Guard
Mapping guard is a function to protect mapping setting against erroneous 
operation. Users cannot do mapping operation on Navigator 2 to the logical 
unit on which mapping guard is set to effective.

To enable or disable Mapping Guard:
1. Select Mapping Guard icon in the tree view.

NOTE: If you change the Mapping Mode from Enabled to Disabled, 
Navigator 2 removes all the configured mapping values. If you want to 
change the mode to Enabled, set the mapping information again.
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2. Click Set.The Mapping Guard window displays.

Figure 4-29:  Mapping Guard window

3. Select a LUN.
4. Click Enable or Disable.
5. Click OK.
6. A confirmation message displays. Click OK. The Mapping Guard window 

displays with a list of available LUNs and their status.

Figure 4-30:  Mapping Guard window
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Parity Correction
Restore the logical unit in which the parity error occurred. From the status of

the logical unit, you can determine if a parity error has occurred.
1. Select Parity Correction icon in the tree view.
2. Click Parity Correction.
3. Select the logical unit to which you want to correct parity.

Figure 4-31:  Parity Correction window

The unconnected logical units list displays.

Figure 4-32:  Parity Correction displaying unconnected logical units list

4. Change the order of the restoration process, when necessary.
(The logical unit listed at the top is processed first.)

5. To continue, click Start, and then click OK. (Or to cancel, click Skip and 
click OK.)

6. A message displays. Click OK.
7. A message displays stating that the parity correction has started. Click 

OK.
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Navigator 2 only directs the process being performed. The array 
firmware performs the specific operation.
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5
Hitachi Storage Navigator

Modular 2 on 9500 VIAMS/
WMS Arrays

This chapter describes how to use Navigator 2 to manage the 
legacy Hitachi storage systems 9500V and AMS/WMS.

This chapter contains the following:

Using Navigator with the 9500V or AMS/WMS

Displaying Status and Properties of Array Unit and Components

Definition of RAID Group/Logical Unit

Configuring Array Unit

Setting Host Group Information

Setting Target Information

Setting System Parameters

Configuring NNC

Displaying Statistical Information

Acquiring Performance Information

Tuning Parameters

ACE Tool
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Using Navigator with the 9500V or AMS/WMS
To use Navigator 2 with the 9500V or AMS/WMS:
1. Start Navigator 2.
2. Log in as registered user to Navigator 2.
3. Add the 9500V or AMS/WMS arrays. For more detailed information, see 

Navigator 2 online help.
4. Select array and click Show & Configure Array.
5. Select Advanced Settings icon in the Settings tree view.
6. Click Open Advanced Settings.

After a few minutes, an Array Unit (Applet) screen displays.

If the operation is completed, close the screen. If the Applet screen 
cannot be displayed, the login to the SNM2 Server may have failed. In 
this case, the Applet screen cannot be displayed again. The code:
0x000000000000b045 or “DMEG800003: The error occurred in 
connecting RMI server.” is displayed on the Applet screen. Take the 
following actions.
Close the Web browser, stop the SNM2 Server once, restart it, and 
display the screen of the Array you want to operate.
• Close the Web browser; confirm the SNM2 Server is started. If it 

has stopped, start it and display the screen of the Array that you 
want to operate.

• Return to the Array screen after 20 minutes elapsed and display 
the screen of the Array you want to operate.

On the Array Unit screen, the status of the array unit system 
components and configuration information of logical units, etc. displays 
selectively by switching the tab. For example, the following screen 
displays a connection with a AMS/WMS subsystem.

NOTE: The Applet screen is displayed connected to the SNM2 Server. If 
20 minutes elapses while displaying the Applet screen, you will not be able 
to operate it due to the automatic logoff function.
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Navigator 2 Version: Less than 5.00
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Navigator 2 Version: More than 5.00

Menu and Tool Bars
The following sections contain examples of the various icons and objects 
that display on Array Unit screen.

View:

Name Tool Bar Function

Propertes - Displays the property of the subsystem

Drive Configuration - Displays the drive configuration of the subsystem.

Refresh Refreshes the Array Unit screen.
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Settings:

Tools:

RAID 
Group

Create Displays the RAID group settings 
screen

Delete - Delete specified RAID group

Logical 
Unit

Create Displays the logical unit settings 
screen.

Format Formats the logical unit (Max.6).

Change Default Controller - Changes default controller of the 
logical unit.

Parity Correction - Corrects the logical unit parity.

Delete - Deletes specified logical unit. 

Name Tool Bar Function

Wizard Starts the logical unit wizard.

Configuration 
Settings

Displays the configuration settings screen.

Mapping Guard - Display the LU mapping guard settings screen.

Performance Output 
File

Outputs the performance of the subsystem.

Settings - Sets the collection of performance statistics.

Statistical 
Information

Displays the statistics information of the subsystem.

Information 
Message ? 

- Displays the information message of the subsystem.
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Pop-Up (Right-Click) Menus
The pop-up menus are context-sensitive and display when you click the 
right the mouse button on the Array Unit screen (Logical Status tab).

The following figure shows the pop-up menu that displays when a RAID 
group number is selected on the Array Unit screen.

The following table describes the pop-up menu options.

Tuning Parameter - Displays the tuning parameter screen.

ACE Tool - Navigates the Back-end configuration.

Name Tool Bar Function
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The following figure shows the pop-up menu that displays when RAID 
Groups is selected on the Array Unit screen.

The following table describes the pop-up menu options.

Selection Menu Function

RAID group 
number icon

Create New Logical Unit Display the property dialog box for 
creating a new logical unit.

Display Drive Configuration Display the drive configuration of the
subsystem.

Delete Delete the selected RAID group.

Properties Display the property of the RAID 
group.
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The following figure shows the pop-up menu that displays when one logical 
unit icon is selected on the Array Unit screen.

The following table describes the pop-up menu options.

Selection Menu Function

RAID Groups Create New RAID Group Display the RAID group setting 
screen.

Selection Menu Function

Logical unit icons 
(one)

Format Format the logical units.

Change Default Controller Change default controller of logical 
unit.

Parity Correction Correct the logical unit parity.

Delete Delete the selected logical unit.
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The following figure shows the pop-up menu that displays when multiple 
logical unit icons are selected on the Array Unit screen.

The following table describes the pop-up menu options.

The following figure shows the pop-up menu that displays when a drive icon 
is selected on the Array Unit screen.

Properties Display the property of the logical 
unit.

Selection Menu Function

Logical unit icons 
(two or more)

Format Format the logical units (maximum 
6).

Parity Correctioin Correct the logical unit parity.

Delete Delete the selected logical unit.

Selection Menu Function
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The following table describes the pop-up menu options.

Displaying Status and Properties of Array Unit and 
Components

• To update the component display, on the View menu, select Refresh 
or click .

• To display component status and properties, select the component in 
the Component Status tab.

• To display the properties of the subsystem, on the View menu, select 
Properties. The Property screen displays the following information. 
See following figure.

Selection Menu Function

Drive icon Display Drive Configuration Display the drive configuration of an 
array unit.
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• Array Unit Type: Subsystem type
• Construction: Subsystem configuration type
• Serial Number: Subsystem serial number
• Microprogram Revision: Subsystem firmware revision
• Controller No.
• IP Address: IP address of each controller
• Subnet Mask: Subnet Mask of each controller
• Default Gateway: Default gateway of each controller

Displaying Array Unit Configuration Information
To display array unit configuration information:
1. On the Tools menu of the Array Unit window, select Configuration 

Settings or click .
2. Click the LAN tab.

The LAN configuration displays the information that is validated in the 
subsystem. See following figure.
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Displaying an Information Message
To display the Information Message dialog box, see following figure.

Double click a patrol lamp icon  in the Array Unit Screen.
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• Controller 0/1 Common: After the array unit starts, the fault 
information and status information displays in the Controller 0/1 
Common box.

• Controller 0: As the array unit starts, the fault information and status 
information displays in the box of Controller 0.

• Controller 1: As the array unit starts, the fault information and status 
information displays in the box of Controller 1.

Definition of RAID Group/Logical Unit

Displaying RAID Group/Logical Unit Definition
1. Click the Logical Status tab on the Array Unit screen.

This figure displays the definition information of all RAID groups and all 
logical units defined in the array unit:
• RAID Groups: Information about all RAID groups defined for an 

array unit displays for each RAID group.
• Logical Units: Information about all logical unit number (LUN) 

defined for an array unit displays for each LUN.
2. To display the relation of the RAID group that defines the logical unit and 

a drive, select Drive Configuration on the View menu.
The Drive Configuration dialog displays.The Drive Configuration dialog 
displays.

3. When you click the RAID group number icon, the RAID level is 
highlighted on the icon for the drive that composes the RAID group. The 
displayed RAID level overlaps the icon.
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Creating a RAID Group Automatically
To create a new RAID group by selecting the drives automatically:
1. Click the Logical Status tab on the Array Unit screen.
2. On the Settings menu of the Array Unit, select RAID Group, then 

click Create, or click .
You can also complete this operation from the context menu of the RAID 
Groups icon.
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The Create RAID Group dialog displays. See following figure.

3. Select and/or enter a RAID Level and Drive Configuration which 
includes the Drive Type, Drive Capacity, Combination, and Parity 
Groups, then click OK.
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4. Click OK as needed to continue and to respond to the confirmation 
messages.
Clicking OK updates the set RAID group and displays following figure.

Creating a RAID Group Manually
To create a new RAID group by selecting the drives manually:
1. Click the Logical Status tab on the Array Unit screen.
2. On the Settings menu of the Array Unit, select RAID Group, then click 

Create or click .
You can also complete this operation from the context menu of the RAID 
Groups icon.
The Create RAID Group dialog displays. See following figure.
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3. Enter the settings in the Create RAID Group dialog box.
4. In Drives, in the Select Drives dialog box, select the Manual 

Selection option, and click Select. See following figure.

5. In Available Drives list, click the HDU number.
6. Click the HDU number to compose a RAID group, keeping the Shift key
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pressed.
7. Click .

8. Click OK as needed to continue and to respond to messages.
Clicking OK updates the set RAID group and displays following figure.
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Deleting a Specified RAID Group
To delete a specified RAID group from set RAID groups:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the icon of a RAID group on the Array Unit screen.

To delete more than one RAID group, select additional groups while 
pressing the Shift key.

3. On the Settings menu of the Array Unit screen, select RAID Group 
and click Delete.

4. To continue through warning or status messages, click OK or Close.

If a logical unit that cannot be deleted is defined in the specified RAIDgroup, 
this RAID group cannot be deleted. To delete the specified RAID group, first 
release the settings on all logical units in the specified RAID group, and then 
delete the RAID group.

Constituting a Logical Unit Automatically
1. Click the Logical Status tab on the Array Unit screen.
2. Click the icon of the desired RAID group to create a logical unit.
3. On the menu, select Logical Unit and click Create, or click .

See following figure. You can also complete this operation from the 
context menu of the RAID group number icon.

The Create Logical Unit dialog displays. See following figure.

NOTE: If a logical unit is defined in the RAID group, all of the user data is 
invalidated by deleting the RAID group.
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4. Select a Logical Unit No., Default Controller, and input Size.
A created logical unit number displays the Logical Unit No. and RAID 
group number and displays the logical units that are defined for the 
RAID Group. Additionally, a logical unit capacity that can be created 
displays.
a. Specify Number of Block, MB, or GB Increased.

To specify a value clearly, specify the allocation (number of blocks, 
MBs, or GBs). When you allocate all of the remaining capacity of the 
designated RAID group, specify a capacity displayed on the screen.

b. Specify the Controller No.

NOTE: When the capacity of a logical unit is specified by GB or MB and the 
capacity is specified as the rightmost value of the slider, a logical unit with 
the whole free capacity of the RAID group to which the logical unit belongs 
is created. When a fractional capacity is included in the free capacity, a 
logical unit with a capacity that includes it is created. (You can see whether 
the free capacity has a fractional portion by viewing the Free Capacity 
field.) When you want to create a logical unit that does not have a fractional 
capacity, specify the logical unit using the other unit.

The relation between MB and blocks is: 1 MB = 2,048 blocks. A fraction less 
than 2,048 blocks is omitted. The relationship between GB and MB is 1 GB 
= 1,024 MB. A fraction less than 1,023 MB is omitted.

Example: 
2,048,000 blocks = 1,000 MB
2,049,024 blocks = 1,000 MB
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Select Controller 0 or Controller 1 to select the controller in charge 
of the logical unit. If you select the wrong controller, the logical unit 
can unexpectedly switch during operation. Performance quality may 
deteriorate as a result.
This is necessary with a dual system connection. It is not displayed 
with a single system connection.

Example:

c. Dual Active Mode: Select a controller to access from the host to the 
logical unit as the controller for the logical unit.
In above figure, CTL#0 is in charge of logical unit0 and CTL#1 is in 
charge of logical unit1. In this example, set up the logical unit by 
selecting optional button CTL#0 to select logical unit0 and button 
CTL#1 to select logical unit1 respectively.

5. After setting logical unit information, click OK.
6. A message displays stating that the setting is complete. Click OK.

Clicking OK updates the logical unit information, and then following 
figure displays.

NOTE: When dual active mode is selected in the dual system, the 
controller in charge of a logical unit must be selected to set up the logical 
unit. Perform the logical unit setting, including the selection of the 
controller that is referred to following figure.
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Constituting a Logical Unit Manually
1. Click the Logical Status tab on the Array Unit screen.
2. Click the icon of the desired RAID group to create a logical unit.
3. On the Settings menu, select Logical Unit and click Create, or click.

You can also complete this operation from the context menu of the RAID 
group number icon.
You can also complete this operation from the context menu of the RAID 
group number icon.
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The Create Logical Unit dialog displays. See following figure.

4. Click Detail.
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5. Select a Logical Unit No., a Default Controller, and the input Size. 
Click Select. See following figure.

6. Select Area and No. and then click OK.
7. In the Create Logical Unit dialog box, click OK.
8. Click OK to confirm the confirmation messages.

Clicking OK updates the logical unit information and displays following 
figure.
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Formatting a Logical Unit
To format the logical unit:

Format: Up to six logical units can be formatted concurrently per controller. 
A host I/O can be received even when formatting logical units.
1. Click the Logical Status tab on the Array Unit screen.
2. Click the logical unit icon on the Array Unit screen. On the context menu 

of the logical unit icon, select Format. See following figure.
When you select multiple logical units, hold down the Ctrl key and click 
the icons of the logical units you want to format.

To continue through warning and confirmation messages, click OK.
This updates the formatted logical unit information and displays 
following figure.

NOTE:  The formatting may be interrupted during the following 
conditions:
• A host is rebooting
• I/O path switching
• Access to a logical unit of the non-ownership controller
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Deleting a Specified Logical Unit
To delete a specified logical unit:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the logical unit icon on the Array Unit screen. On the context 

menu of the logical unit icon, select Delete. See following figure.
When you select multiple logical units, press the Ctrl key, and click the 
logical units icons that you want to delete.
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3. To continue through confirmation and status messages, click OK and 
Close.
The logical unit is deleted.

Changing Default Controller in Charge of a Logical Unit
To change the default controller in charge of a logical unit:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the logical unit in the Array Unit screen. On the context menu of 

the logical unit icon, select Change Default Controller. See following 
figure.
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3. To continue through confirmation and status messages, click OK.
The default controller in charge of the logical unit is changed.

Parity Correction
Restore the logical unit in which the parity error occurred. From the status 
of the logical unit, you can determine if a parity error has occurred.
1. Click the Logical Status tab on the Array Unit screen.
2. Select the logical unit to which you want to correct parity. Select Logical 

Unit in the Settings menu, and then select Parity Correction. See 
following figure.
If the parity restoration displays in halftone, no parity error has 
occurred.

NOTE:  Switching the default controller owning the logical unit changes 
the default controller currently displayed. When the switching is executed 
twice, the specified controller is changed to the original default controller 
that is controlling the logical unit.
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To continue, click OK in the confirmation message.
The unconnected logical units list displays. See following figure.

3. Change the order of the restoration process, when necessary.
(The logical unit listed at the top is processed first.)
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4. To continue, click Start, and then click OK. (Or to cancel, click Skip and 
click OK.)

5. A message displays. Click OK.
6. A message displays stating that the parity correction has started. Click 

OK.
The Navigator 2 only directs the process being performed. The array unit 
firmware performs the specific operation.

Configuring Array Unit

Creating Logical Units by Wizard
To create logical units by wizard:
1. On the Tools menu, select Wizard ->. Create Logical Units.

On the Select Usage drop down list (see following figure), select logical unit 
usage. A dialog box displays where you can select the usage by setting the 
suitable parameter for Drive Type, RAID Level, and Parity. If you want to 
customize the parameter, click Customize and select 

Table 5-1:  

Usage Recommended RAID Configuration Drive Type

Default 4D+1P FC/SATA
Data Base 4D+1P FC
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2. Specify the logical unit size, number of logical units, and port(s) to use.
3. Select Next.
4. The specification contents display. When the specification contents are 

no problem, click Confirm. If you want to modify the contents, click 
Back.

5. Click Done. The Logical Unit Creation Wizard Summary displays.

File System 4D+1P FC
Backup 8D+1P FC
Archive 8D+1P SATA
Archive2 8D+2P SATA
Streaming 4D+1P SATA
Digital Surveillance 
System

8D+1P FC

High Performance 
Computing

4D+4D FC

Table 5-1:  

Usage Recommended RAID Configuration Drive Type
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Designating Spare Drives
To ensure maximum storage capacity, assign a spare drive in the 
subsystem. Any drive except a data drive can be assigned as spare.

Designating Spare Drives

To designate a spare drive:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the Spare Drives icon.
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3. Click Set. The Spare Drives Settings dialog displays. Click Set. The 
Spare Drives Settings dialog displays.

4. In the Available Drives list, select the HDU number for the spare 
drives you want to set, and click .
The selected HDU number moves to the Drives to Set list.
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5. Click OK.
6. Confirmation and status messages display to continue through the 

confirmation and status messages, click OK and Close.

Releasing Spare Drive

To release the spare drive:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the Spare Drives icon
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3. Select the HDU number of the spare drives you want to release. Click 
Release. Confirmation and status messages display. To continue 
through the confirmation and status messages, click OK and Close. The 
setting information displays.

Setting Differential Management LU
When the Differential Management LU is not set, you can set it. The 
Differential Management LU is an exclusive logical unit for storing the 
differential data at the time when the volume is copied. The Differential 
Management LU in the disk subsystem is treated in the same way as the 
other logical units. However, a logical unit that is set as the Differential 
Management LU is not recognized by a host because it is hidden.

The minimum logical unit size for the Differential Management LU is 5 GB. 
Up to the two Differential Management LUs can be set. The second 
Differential Management LU is used for the mirroring.

Setting Differential Management LU

To set the Differential Management LU:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the Differential Management LU icon.
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3. Click Set.
The Select Logical Unit dialog box displays.

4. Select the LUN you want to set to the differential management LU, and 
click OK.
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5. Confirmation and status messages display. To continue through the 
confirmation and status messages, click OK.
The setting information displays.

Releasing Differential Management LU

To release the differential management LU:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the Differential Management LU icon.
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3. Select the LUN you want to release to the differential management LU, 
and click Release.

4. Confirmation and status messages display. To continue through the 
confirmation and status messages, click OK.
The setting information displays.

Setting Command Devices
Two command devices can be designated for the subsystem. The Command 
Device LU size must be greater than or equal to 33 MB.

Setting Command Devices
1. Click the Logical Status tab on the Array Unit screen.
2. Click the Command Devices icon.
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3. Click Set.
The Command Devices Settings dialog box displays.

4. In the Available Logical Units list, select the LUN you want to set in 
the command devices, and click 
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The selected LUN moves to the Command Devices to Set list.

5. Click OK.
6. A message displays. Click OK.

The setting information displays.
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Changing Command Devices

To change the command devices:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the Command Devices icon.

3. Select the Command Device number you want to change in the 
Command Device list, and click Modify.
The Modify Command Devices dialog box displays.
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4. In the RAID Manager Protect drop-down list, select Disable or 
Enable.

5. Click OK.
6. Confirmation and status messages display. Click OK to continue through 

confirmation and status messages.
The setting information displays.

Releasing Command Devices

To release the command devices:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the Command Devices icon.
3. Select the Command Device number you want to release the command 

devices, and click Release.
4. Confirmation and status messages display. Click OK to continue through 

confirmation and status messages.
The setting information displays.

Setting Optional Features
This section describes how to install and uninstall optional features.
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Installing Optional Features

To install the optional features:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the License Key icon.

3. Click Install.
The Install Options dialog box displays.

WARNING! Rebooting requires stopping I/O from the host.
WARNING! If you are using TrueCopy or TrueCopy Extended Distance and 
you are required to reboot the subsystem, change the pair status to PSUS 
before you reboot.
WARNING! If you are using a NAS, you must also stop the clusters 
between NAS units. When restarting the subsystem, you must restart the 
clusters.
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4. Choose an install option, Key Code, or Key File:
Key Code: For the key code of the priced optional features, refer to the 
priced optional features manual. In the Key Code field, enter the key 
code, and click OK.
Key File: In the Key File field, enter the path to the key file and click 
OK. An Install Options box displays. Select the desired features, and 
click OK.

5. In any confirmation screens that display, click OK or Close to continue.
6. A status message indicates whether the install is successful.

To perform other operations on the Arrays screen, select an Array Unit from 
the Arrays screen and open the selected Array Unit screen.

De-installing Optional Features

 

NOTE: Some options may require a subsystem restart before the options 
are functional. Follow the on-screen instructions. Before restarting, ensure 
that the host is not accessing data on the subsystem. A subsystem restart 
takes about 4 to 15 minutes.

NOTE: For additional information on priced optional features, refer to the 
corresponding manual of each feature.

WARNING! Rebooting requires stopping I/O from the host.
WARNING! If you are using TrueCopy or TrueCopy Extended Distance and 
you are required to reboot the subsystem, change the pair status to PSUS 
before you reboot.
WARNING! If you are using a NAS, you must also stop the clusters 
between NAS units. When restarting the subsystem, you must restart the 
clusters.
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To de-install the optional features:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the License Key icon.
3. Click De-install.

The De-install Options dialog displays.

4. Enter the key code, and click OK.
5. A status message displays and indicates whether the de-install is 

successful.

To perform other operations on the Arrays screen, select an Array Unit from 
the Arrays screen and open the selected Array Unit screen.

Setting Optional Features

After releasing the key of the optional feature, set enable or disable this 
feature.

To set the optional features:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the License Key icon.

NOTE: If the message indicates that a subsystem restart is needed, follow 
the instructions in the message. Before restarting, ensure that the host is 
not accessing data on the subsystem. A subsystem restart takes about 4 to 
15 minutes.

WARNING! Rebooting requires stopping I/O from the host.
WARNING! If you are using TrueCopy or TrueCopy Extended Distance and 
you are required to reboot the subsystem, change the pair status to PSUS 
before you reboot.
WARNING! If you are using a NAS, you must also stop the clusters 
between NAS units. When restarting the subsystem, you must restart the 
clusters.
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3. Select the optional features to be set up, and click Change.
4. A confirmation message displays. Click OK to continue setting the 

enable/disable option.
5. A status message displays and indicates that the priced optional features 

have been set up.

To perform other operations on the Arrays screen, select an Array Unit from 
the Arrays screen and open the selected Array Unit screen.

Setting Host Group Information
This section contains information about setting a host group 0 (000:G000), 
such as a host group option and mapping information.

For information on creating a host group, refer to the LUN Manager User's 
Guide.

Setting Host Group Options
To set the host group options:
1. Click the Logical Status tab.
2. Click the Port 0A plus sign.

NOTE: If the message indicates that a subsystem restart is needed, follow 
the instructions in the message. Before restarting, ensure that the host is 
not accessing data on the subsystem. A subsystem restart takes about 4 to 
15 minutes.
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3. Click the 000:G000 plus sign, then select Options.
4. Click Simple Settings.

5. As necessary, select Platform, Alternate Path, and Failover. See the 
following figure. The combination, which can be chosen for every 
platform, is limited.
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Platform:
• HP-UX
• Solaris
• AIX®
• Windows 2000
• Windows 2003
• Linux®
• Tru64
• Not specified

Alternate path:
• Not specified
• PV Link: Can be used by HP-UX.
• HDLM: Can be used by Solaris, AIX, and Windows 2000/2003.
• VxVM: Can be used by HP-UX, AIX, Solaris, Windows 2000/2003, 

and Linux.
• MPxIO: Can be used by Solaris.

Failover:
• Not specified
• MC/ServiceGuard: Can be used by HP-UX.
• SunCluster: Can be used by Solaris.
• VCS: Can be used by Solaris and Linux.
• HACMP: Can be used by AIX.
• MSCS: Can be used by Windows 2000/2003.
• Tru Cluster: Can be used by Tru64.

6. Click Additional Parameters.
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7. Select the appropriate options in the Item group and click OK.
8. Click Detail.

9. Select Host Connection Mode 1, Host Connection Mode 2 and click 
OK.
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Host Connection Mode 1:
• Standard Mode: Open system emulation mode
• Open VMS Mode: Open VMS mode
• TRESPASS Mode: TRESPASS mode
• Wolfpack Mode: Wolfpack mode

Host Connection Mode 2:
• HP-UX Mode: Enables the HP-UX Mode.
• PSUE Read Reject Mode: Enables the PSUE Reject Mode.
• UA (60/2A00) Suppress Mode: Suppresses the unit attention (06/

2A00).
• NACA Mode: Enables the NACA Mode.
• HISUP OFF Mode: Enables the HISUP OFF Mode.
• Reset Propagation Mode: The mode to propagate reset to other 

ports.
• Unique Reserve Mode 1: Enables the Unique Reserve Mode 1.
• ASL Report Mode (Active/Passive Group): Enables the ASL Report 

Mode (Active/Passive Group).
• ASL Report Mode (Active/Passive): Enables the ASL Report Mode 

(Active/Passive).
• ASL Report Mode (Active/Active): Enables the ASL Report Mode 

(Active/Active).
• Port ID No Report Mode: Enables the Port ID No Report Mode.
• Port ID Conversion Mode: Enables the Port ID Conversion Mode.
• Tru Cluster Mode: Enables the Tru Cluster Mode.
• Product Serial Response Mode: Enables the Product Serial 

ResponseMode.
• Same Node Name Mode: Enables the Same Node Name Mode.
• CCHS Mode: Enables the CCHS convert.
• SPC-2 Mode: Enables the SPC-2 Mode.

10.Click OK.
11.A confirmation message displays. Click OK.

The modified host group options display.

Setting Mapping Guard
Mapping guard is a function to protect mapping setting against erroneous 
operation. Users cannot perform the mapping operation on the Navigator 2 
to the logical unit on which the mapping guard is set to effective.

To enable or disable Mapping Guard:
1. Click the Logical Status tab on the Array Unit screen.
2. On the Tools menu, select Mapping Guard.
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3. In the Mapping Guard window.

1. Select a LUN.

2. Click Enable or Disable.

3. Click OK.

4. A confirmation message displays. Click OK.

Specifying Mapping Mode
To enable or disable Mapping Mode:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the Access Mode plus sign next to the Mapping Mode.
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3. On the Mapping Mode list, select Enable or Disable and click Modify.
This operation can also be done from the context menu of the list view.
The Modify Mapping Mode dialog box displays.

4. Select Enable or Disable and click OK.
5. A confirmation message displays. Click OK.

The setting information displays.

Setting Mapping Information

To set mapping information:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the Port 0A plus sign and select 000:G000.
3. Select the Logical Unit icon.
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4. Select Modify Mapping.
The Modify Mapping dialog box displays.

5. Select one H-LUN to be added. Select LUN, and click . The added 
contents display in the Mapping Information list.
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To delete, click the line to be deleted in Mapping Information list and 
click . The deleted contents disappear.

6. Click OK.
7. A confirmation message displays. Click OK.

The set mapping information is updated and the following window 
displays.

Setting Target Information
This section contains information about setting Target 0 (000:T000) 
information, such as a target options and mapping information. For 
information on creating a target, refer to the LUN Manager User's Guide.
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Setting Target Options
To set the target options:
1. Click the Logical Status tab.
2. Click the Port 0A plus sign.
3. Click the 000:T000 plus sign and select Options.
4. Click Simple Settings.

5. As necessary, select Platform, Alternate Path, and Failover. The 
combination, which can be chosen for every platform, is limited.
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Platform:
• HP-UX
• Solaris
• AIX®
• Windows 2000
• Windows 2003
• Linux®
• Tru64
• Not specified

Alternate path:
• Not specified
• PV Link: Can be used by HP-UX.
• HDLM: Can be used by Solaris, AIX, and Windows 2000/2003.
• VxVM: Can be used by HP-UX, AIX, Solaris, Windows 2000/2003, 

and Linux.
• MPxIO: Can be used by Solaris.

Failover:
• Not specified
• MC/ServiceGuard: Can be used by HP-UX.
• SunCluster: Can be used by Solaris.
• VCS: Can be used by Solaris and Linux.
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• HACMP: Can be used by AIX.
• MSCS: Can be used by Windows 2000/2003.
• Tru Cluster: Can be used by Tru64.

6. Click Additional Parameters.

7. Select the appropriate options in the Item group and click OK.
8. Click Detail.
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9. Select Host Connection Mode 1, Host Connection Mode 2 and click 
OK.
Host Connection Mode 1:
• Standard Mode: Open system emulation mode
• Open VMS Mode: Open VMS mode
• TRESPASS Mode: TRESPASS mode
• Wolfpack Mode: Wolfpack mode
Host Connection Mode 2:
• HP-UX Mode: Enables the HP-UX Mode.
• PSUE Read Reject Mode: Enables the PSUE Reject Mode.
• UA (60/2A00) Suppress Mode: Suppresses the unit attention (06/

2A00).
• NACA Mode: Enables the NACA Mode.
• HISUP OFF Mode: Enables the HISUP OFF Mode.
• Reset Propagation Mode: The mode to propagate reset to other 

ports.
• Unique Reserve Mode 1: Enables the Unique Reserve Mode 1.
• ASL Report Mode (Active/Passive Group): Enables the ASL Report 

Mode (Active/Passive Group).
• ASL Report Mode (Active/Passive): Enables the ASL Report Mode 

(Active/Passive).
• ASL Report Mode (Active/Active): Enables the ASL Report Mode 

(Active/Active).
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• Port ID No Report Mode: Enables the Port ID No Report Mode.
• Port ID Conversion Mode: Enables the Port ID Conversion Mode.
• Tru Cluster Mode: Enables the Tru Cluster Mode.
• Product Serial Response Mode: Enables the Product Serial 

Response Mode.
• Same Node Name Mode: Enables the Same Node Name Mode.
• CCHS Mode: Enables the CCHS convert.
• SPC-2 Mode: Enables the SPC-2 Mode.

10.Click OK.
11.A confirmation message displays. Click OK.

The modified target options display.

Setting Mapping Guard
To enable or disable Mapping Guard:
1. Click the Logical Status tab on the Array Unit screen.
2. On the Tools menu, select Mapping Guard.

In the Mapping Guard window:
a. Select a LUN.
b. Click Enable or Disable.
c. Click OK.

3. A confirmation message displays. Click OK.
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Specifying Mapping Mode
To enable or disable Mapping Mode:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the Access Mode plus sign. Select Mapping Mode.

3. On the Mapping Mode list, select Enable or Disable, and click Modify.
This operation can also be done from the context menu of the list view.
The Modify Mapping Mode dialog box displays.

4. Select Enable or Disable and click OK.
5. A confirmation message displays. Click OK.

The setting information displays.

Setting Mapping Information

To set mapping information:
1. Click the Logical Status tab on the Array Unit screen.
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2. Click the Port 0A plus and select 000:T000.
3. Select the Logical Unit icon.

4. Select Modify Mapping.
The Modify Mapping dialog box displays.

5. Select one H-LUN to be added. Select LUN, and click . The added 
contents display in the Mapping Information list.
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To delete, click the line to be deleted in the Mapping Information list 
and click . The deleted contents disappear.

6. Click OK.
7. A confirmation message displays. Click OK.

The set mapping information is updated and the following window 
displays.
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CHAP User
This section contains information about adding, changing, and deleting a 
CHAP user.

Adding a CHAP User

To add a CHAP User:
1. Click the Logical Status tab.
2. Click the Port 0A plus sign and select CHAP User.
3. Click Add.

The CHAP User dialog box displays.



5–64 Hitachi Storage Navigator 2 on 9500VIAMS/WMS Arrays

Hitachi Storage Navigator 2 Advanced Settings User’s Guide 

4. In the CHAP User dialog box, enter the User Name, Secret, and 
Secret Confirmation.

5. From the Available Targets list, select the target to be assigned, and 
click .
• User Name: Enter the name of the User with 256 or less 

alphanumeric character. The following symbols can be used:
(. - + @ _ = : / [ ] ~ (space))

• Secret: Enter the Secret from 12 through 32 alphanumeric 
characters.
The following symbols can be used:
(. - + @ _ = : / [ ] ~ (space))

• Secret Confirmation: Enter the characters that enter into the 
Secret.

6. Click OK.
7. A confirmation message displays. Click OK.

Changing the CHAP User

To change the CHAP user:
1. Click the Logical Status tab.
2. Click the Port 0A plus sign and select CHAP User.
3. Select the CHAP User to be changed from the CHAP User list.
4. Click Modify.
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The CHAP User dialog box displays.

5. As necessary, enter the User Name, Secret, and Secret 
Confirmation.

6. As necessary, change the Assigned Targets, and click OK.
7. A confirmation message displays. Click OK.

Deleting the CHAP User

To delete the CHAP user:
1. Click the Logical Status tab.
2. Click the Port 0A plus sign and select CHAP User.
3. Select the CHAP User to be deleted from the CHAP User list.
4. Click Delete.



5–66 Hitachi Storage Navigator 2 on 9500VIAMS/WMS Arrays

Hitachi Storage Navigator 2 Advanced Settings User’s Guide 

Setting a Target Information
This section includes changing target information and initializing the target.

Changing Target Information
1. Click the Logical Status tab.
2. Click Port 0A.
3. Select the Target to be changed from the Target list.
4. Click Modify.
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The Target dialog box displays.

5. In the Target dialog box, enter or select the Alias, the Authentication 
Method, the CHAP Information, the iSCSI Name.
• Alias: Enter the name of the Target with 32 or less alphanumeric 

character.
(Excluding \, /, : , , , ;, *, ?, “, <, >, | and ‘)
Spaces at the top or end are ignored. An identical name cannot be 
used in an identical Port.

• Authentication Method: Select the CHAP, None, or CHAP,None.
• CHAP Information:

CHAP Algorithm: Displayed MD5 always.
Two-Way Authentication: Select the Enable or Disable radio 
button.
When the Enable radio button is selected, specify following items.
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User Name: Enter the name of the User with 256 or less 
alphanumeric character. The following symbols can be used:
(. - + @ _ = : / [ ] ~ (space))
Secret: Enter the Secret from 12 through 32 alphanumeric 
characters.
The following symbols can be used:
(. - + @ _ = : / [ ] ~ (space))
Secret Confirmation: Enter the characters that enter into the 
Secret.

• iSCSI Name: Enter the name of the iSCSI Name with 223 or less 
alphanumeric character. A period (.), hyphen (-), and colon (:) can 
be used.

6. Click OK.
7. A confirmation message displays. Click OK.

Initializing the Target 000
1. Click the Logical Status tab.
2. Click the Port.
3. Select the Target to be initialized from the Target list.
4. Click Initialize.

5. A confirmation message displays. Click OK.
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Setting System Parameters
This section contains information about setting a system configuration, such 
as Fibre information, for an array unit. Individual items to be set are 
selected by switching the tab screen. Tab screens might not display, 
depending on the connected array unit and other variables.

Setting Boot Options
When the boot option is set, the subsystem requires a restart after setting 
changes.

To set the boot option:
1. On the Tools menu, select Configuration Settings or click . Click the 

Boot Options tab and set the options.

• System Startup Attribute: Select the subsystem configuration.
Single Mode: Single configuration
Dual Active Mode: Dual active configuration

WARNING! Rebooting requires stopping I/O from the host.
WARNING! If you are using TrueCopy or TrueCopy Extended Distance and 
you are required to reboot the subsystem, change the pair status to PSUS 
before you reboot.
WARNING! If you are using a NAS, you must also stop the clusters 
between NAS units. When restarting the subsystem, you must restart the 
clusters.
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• Delay Planned Shutdown: Specify the time in minutes to delay 
the execution of the planned shutdown when the main switch has 
turned off. The applicable range is from 0 to 60 minutes.

• Drive Detach Mode: Validates the drive blockade mode.
• Vendor ID: Enter an eight-character vendor name. When the 

name consists of less than eight characters, make an eight-
character entry by filling the reset with space(s). The default value 
set in HITACHI .  Denotes a space.)

• Product ID: Enter a 16-character model name. When the name 
consists of less than 16 characters, make a 16-character entry by 
filling the reset with space(s).
The default value set in DF600F . ( Denotes 
a space.)

• ROM Microprogram Version: Specifies a microprogram version 
of a ROM reported by inquiry command.

• RAM Microprogram Version: Specifies a microprogram version 
of a RAM reported by inquiry command.

2. Click Apply.
3. Follow the information in messages that appear. Click OK to continue or 

Cancel.
4. The subsystem restarts in about 4 to 15 minutes.

Setting Fibre Channel Information
Fibre channel settings include Port Address, Transfer Rate, and 
Topology Information.

Displaying Fibre Channel Information

To display fibre channel information:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Fibre Channel tab.
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• Node Name: Describes 8 bytes of data hexadecimal (with 16 
characters).

• Port Name: Describes 8 bytes of data hexadecimal (with 16 
characters).

• Port Address: Port address displays as a hexadecimal number.
• Transfer Rate: Indicates fibre transfer rate.
• Topology Information: Indicates topology status.
• Link Status: Indicates link status.
• LinkUp (Private Loop): Arbitrated Loop that is not connected 

with the Fibre Channel switch.
• LinkUp (Public Loop): Arbitrated Loop that is connected with 

Fibre Channel switch.
• LinkUp (N_Port connection): Connect Point to Point with host.
• LinkUp (F_Port connection): Connect Point to Point with Fibre 

Channel switch.
• Loop Port Bypass: Bypassed from the loop.
• Standby: Standby state.
• LinkDown: Link is down.
• LinkFailure: Link initialization condition.

Setting Fibre Channel Settings

Fibre channel information is set up on a port basis.
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To set the fibre channel settings:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Fibre Channel tab.
3. Set the Port Address, Transfer Rate, and Topology Information 

making them conform to an environment that matches a host.
• Port Address: Enter 8 bytes of data hexadecimal (with 16 

characters).
• Transfer Rate: Select the value from the drop-down menu.
• Topology Information: Select the value from the drop-down 

menu.
4. Click Apply.
5. Click OK to continue.

Setting iSCSI Port Information
To set the iSCSI port information:
1. On the Tools menu, select Configuration Settings or click .
2. Click the iSCSI tab.

NOTE: This procedure causes the subsystem to cease host access. Before 
setting, stop access to the port from the host.

NOTE: It may take time to complete the setting. Click Refresh to verify 
that the correct settings have been made.
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3. Set the iSCSI port parameters:
• Network: Set the IP Address, Subnet Mask, Default Gateway, Port 

Number, and Keep Alive Timer (sec.) making them conform to an 
environment.

4. Click Apply.
5. Click OK to continue.

Setting iSNS Server Information
To set the iSNS server information:
1. On the Tools menu, select Configuration Settings or click .
2. Click the iSNS tab.
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3. Set the iSNS server parameters:
• Select iSNS Server
• Click Use: b whether to use the iSNS server or not. When use the 

iSNS server, specify the IP Address and Port Number of the 
iSNS server.

4. Click Apply.
5. Click OK to continue.

Sending Ping
Sends the ping to the initiator (host) and displays the result of the sending.
1. On the Tools menu, select Configuration Settings or click .
2. Click the Ping tab.
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3. Set the ping parameters:
• Port: Select the port that sends the ping.
• Destination IP Address: Specify the IP address of the initiator.

4. Click Start.
5. Click OK to continue.

The result displays.
6. Select Refresh as necessary to display the latest information.

Setting System Parameters
This setting information becomes valid without restarting the subsystem.
1. On the Tools menu, click the Configuration Settings or click .
2. Click the System Parameter tab.
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3. Set the system parameters. See Table 5-2 for a description of these 
parameters.

4. Click Apply.
5. Click OK.

Table 5-2:  Setting System Parameters

Parameters Description Operations

Turbo LU 
Warning

This parameter is to be 
specified when the Turbo 
LU setting function is 
used.
Default = Disable

Disable: When the Turbo LU can no 
longer be maintained due to a failure, 
the parameter allows host access to be 
issued.
Enable: When the Turbo LU can no 
longer be maintained due to a failure 
and the performance is lowered, the 
parameter suppresses host access and 
issues a warning.

Write Unique 
Response Mode

This parameter is to be 
specified when a host of 
the NX series is 
connected.
Default = Disable

Disable: Cache memory is used for 
write commands.
Enable: Write commands are 
executed unconditionally in write-
through mode (write data directly to 
disk without using cache).
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Auto 
Reconstruction 
Mode

This parameter specifies 
operations to be 
performedwhen a disk 
drive is removed.
Default = Disable

Disable: When a disk drive is 
removed, correctionb copy to a spare 
disk drive is not performed.
Enable: When a disk drive is 
removed, correction copy to a spare 
disk drive is performed.
Caution: This mode is for test 
purposes and should only be used by 
authorized service personnel.

Forced Write 
Through Mode

This parameter specifies 
the method for executing 
write commands after a 
CTL detachment or power 
failure.
Default = Disable

Disable: If a CTL detachment or 
power failure has occurred, cache 
memory is used for write commands.
Enable: If a CTL detachment or power 
failure has occurred, write commands 
are executed in writethrough mode 
(write data directly to disk without 
using cache).

LU Ownership 
Change Disable 
Mode

This parameter specifies 
an operation to re-assign 
an LU to a non-owner 
controller when the 
controller attempts to 
access the LU.
Default = Disable

Disable: Request internal processing 
to the Control Unit in charge of the LU. 
If there is no access for one minute 
from the Control Unit in charge of the 
LU, reallocate the Control Unit in 
charge of the LU.
Enable: The access is always made by 
the Control Unit that controls the LU 
concerned by request, without re-
assigning the LU to a Control Unit that 
wants to access the LU.

ShadowImage 
I/O Switch 
Mode

This parameter specifies 
an operation of a 
ShadowImage P-VOL to 
be performed when a 
double disk drive failure 
occurs.
Default = Disable

Disable: If a double failure occurs in 
disk drives of a ShadowImage P-VOL 
in the PAIR status, the status is 
changed to PSUE.
Enable: If a double failure occurs in 
disk drives of a ShadowImage P-VOL 
in the PAIR status, the execution of the 
host I/O is switched to the S-VOL to 
continue the execution.
Note: For further information,

Synchronize
Cache
Execution Mode

This parameter specifies 
an operation to be 
performed when the 
Synchronize Cache 
command is received.
Default = Disable

Disable: No operation is performed 
when the Synchronize Cache 
command is received.
Enable: When the Synchronize Cache 
command is received, all data in the 
cache memory is written to disk 
drives.
Note: For further information, see the 
TrueCopy User’s Guide.

Table 5-2:  Setting System Parameters

Parameters Description Operations
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Setting Port Options
The Port Options tab allows you to set the system parameter port options. 
The setting information becomes valid without restarting the subsystem.
1. On the Tools menu, click the Configuration Settings or click .
2. Click the Port Options tab.

Drive Detach 
Mode

Specifies an operation to 
be performed when a 
drive failure occurs in the 
same RAID group.
Default = Disable 

Disable: When a failure occurs in a 
disk drive in a state in which another 
disk drive in the same RAID group has 
already been detached due to a 
failure, the parameter does not detach 
the disk drive that failed secondarily.
Enable: When a failure occurs in a 
disk drive in a state in which another 
disk drive in the same RAID group has 
already been detached due to a 
failure, the parameter detaches the 
disk drive that failed secondarily and 
detaches LUs (makes LUs 
unformatted) in the RAID group 
concerned.

Operation if the 
Processor 
Failure Occurs

This parameter specifies 
the operation to be 
performed when a 
processor failure occurs. 
Default = Reset of
occurred

Reset the Fault: The parameter 
resets the failure and reboots the 
Control Unit.
Shutdown System: The parameter 
shuts the disk array subsystem down.

Web When the Web function 
built in the disk 
subsystem is displayed 
with the browser, this 
parameter specifies 
characters to be 
displayed in the browser 
title bar.
Default = Not set

Characters that can be entered 
(maximum 32) are alphabetic 
characters, numerals, and characters 
other than numerals (excluding ', ", 
and \).

Write & Verify 
Execution Mode

This parameter specifies 
the execution mode for
write and verify 
operation.
Default = ON 

ON: The write and verify operation is 
performed.
OFF: The write and verify operation is 
not performed.

Table 5-2:  Setting System Parameters

Parameters Description Operations
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3. Select the desired port, and then select the desired Port Options:
a. Reset/LIP Mode (Signal): Set this option to transmit Reset/LIP 

signals to other ports.
b. Reset/LIP Mode (Process): Set this option to transmit reset 

processing to other ports. If this option is set, the Reset/LIP Mode 
(signal) is automatically enabled.

c. LIP Port ALL Reset Mode: Set this option to execute reset on 
receiving LIP.

d. Click Apply to apply the selected settings to the subsystem.

Setting Drive Restoration Options
Do not set drive restoration options while a drive restoration is in progress.

To set drive restoration options:
1. On the Tools menu, select Configuration Settings or click .
2. Click Restore Options tab.
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Enter the following settings:
Drive Restoration Mode:
a. Background: Executes drive restoration while host I/O processing 

is not executed.
b. Interleave (Normal): Restores the drive at preset time intervals 

(specified as “Interval Time”) giving preference to a host command 
(restores after executing the command).

c. Interleave (Prior): Restores the drive at preset time intervals 
(specified as “Interval Time”) taking preference over a host 
command.

Drive Restoration:
a. Manual: Starts restoring data and copying by manual operations.
b. Auto: Automatically starts data and copying restoration.
Interval Time:
The default is 10 × 10 ms with restoration executed at intervals of 100 
ms. 
To set, specify a multiplication factor from 0 to 255 in a unit of 10 ms.
a. Processing Unit Size: Specify the size of the data block to be 

restored. The value of the range of 1 to 511 is specified by a multiple 
of 128. The minimum value is 128, which restores 65 KB data in a 
single operation. When Interleave mode is specified, the function 
restores the data of the processing unit size that is specified, waits 
for the time interval that is specified, and then starts the next data 
restoration.
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Dynamic Sparing: Specify a mode for data restoration for the spare 
drive when the error occurrence count controlled by preventive 
maintenance exceeds the threshold value.
a. Execute (Read/Write & Online Verify): When the error 

occurrence count in Read/Write Error or Online Verify Error, 
Threshold Value Over and Start of Dynamic Sparing display on the 
panel. Data restoration is performed for the spare drive (when the 
spare drive is not used), and the error disk is blocked.

b. Execute (Read/Write): When the error occurrence count in Read/
Write Error exceeds the threshold value, Threshold Value Over and 
Start of Dynamic Sparing displays on the panel. Data restoration is 
performed for the spare disk in the spare drive (when the spare disk 
is not used), and the error disk is blocked. 
When the error occurrence count in Online Verify Error exceeds the 
threshold value, Threshold Value Over displays on the panel, but 
Dynamic Sparing is not performed.

c. Do not Execute: When the error occurrence count in Read/Write 
Error or Online Verify Error exceeds the threshold value, 
Threshold Value Over displays on the panel, but Dynamic Sparing is 
not performed.

Spare Drive Operation Mode: Specify the spare drive operation mode.
a. Variable: When a failed drive is replaced, the new drive becomes a 

spare drive.
b. Applying No Copy Back Mode on All Units: Specify whether to set 

the Applying No Copy Back Mode on All Units effective or ineffective.
c. Fixed: Uses only a drive that is designated as a spare 

3. Click Apply.
4. A confirmation message displays. Click OK.

Online Verify Mode
To enable Online Verify Test or to Skip Online Verify:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Online Verify tab.
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3. Select the desired options:
a. Online Verify Test
b. Skip Online Verify: When a verify command is received from a 

host, ensure that verification operation is performed.
c. Cache Verify: Specify whether or not to execute Cache Verify.

4. Click Apply.
5. A confirmation message displays. Click OK.

Setting Format Priority Mode
Changes to Format Priority Mode apply without restarting the subsystem.

To change the Format Priority Mode:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Format Mode tab.
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3. Select the Format Priority mode and Format Data settings.

Format Priority mode:
a. Normal: Formats at an idle time when no host I/O is executed.
b. Host: Host's I/O is executed preferentially.
c. Format: Subsystem formats are done preferentially.
Format Data: Specify a format data.

4. Click Apply.
5. A confirmation message displays. Click OK.

Setting LAN Configuration

Setting LAN Configuration without Rebooting

LAN information cannot be set when it accesses the user port and the 
maintenance port of the controller to be set with Web, etc. Execute LAN 
information after stopping access to the controller to be set.

To Set the LAN configuration without rebooting:
1. On the Tools menu, select Configuration Settings or click .
2. Click the LAN tab.
3. Select Set now without reboot.
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a. Set with reboot: Rebooting is necessary.
b. Set now without reboot: Rebooting is unnecessary. You cannot 

select the DHCP mode.
c. Maintenance Port IP Address Automatic Change Mode: The IP 

address of the maintenance port is set automatically in accordance 
with the IP address that has been set. When the mode is set as 
Enable, the maintenance port cannot be set with the Maintenance 
LAN tab.

d. LAN: Specify IP Address, Subnet Mask, Default Gateway, and 
Negotiation, which is part of the LAN information. Ether Address 
is displayed but cannot be changed.

e. The Setting value and the Current value are displayed as the 
information that has been set and that is enabled in the subsystem, 
respectively.

4. Click Apply.
5. A message displays stating that the setting is completed. To continue, 

click OK.
6. The following message displays when the LAN information is set in the 

case that it accesses the user port and the maintenance port of the 
controller to be set with Web, etc.
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The usage condition of the LAN port is output to netstat.inf. See 
following figure. In the netstat.inf file, “Local address” means IP address 
of the controller, “Foreign Address” means IP address of PC connecting 
with the subsystem, “State” means the status of TCP connection. 
Regardless of “Status” in the netstat.inf file, stop the all application 
currently connecting from “Foreign address”, and execute it again.

Setting LAN Configuration with Rebooting

This procedure requires restarting the subsystem.

To set the subsystem LAN configuration:
1. On the Tools menu, select Configuration Settings or click .
2. Click the LAN tab.
3. Select Set with reboot.

WARNING! Rebooting requires stopping I/O from the host.
WARNING! If you are using TrueCopy or TrueCopy Extended Distance and 
you are required to reboot the subsystem, change the pair status to PSUS 
before you reboot.
WARNING! If you are using a NAS, you must also stop the clusters 
between NAS units. When restarting the subsystem, you must restart the 
clusters.
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a. Maintenance Port IP Address Automatic Change Mode: The IP 
address of the maintenance port is set automatically in accordance 
with the IP address that has been set. When the mode is set as 
Enable, the maintenance port cannot be set with the Maintenance 
LAN tab.

b. DHCP: Specify whether the DHCP mode will be valid or invalid.
c. LAN: Specify IP Address, Subnet Mask, Default Gateway, or 

Negotiation, which is part of the LAN information. Ether Address 
is displayed but cannot be changed.

d. The Setting value and the Current value are displayed as the 
information that has been set and that is enabled in the subsystem, 
respectively.

4. Click Apply.
5. A message indicates that a subsystem restart is needed to apply the 

settings. Before restarting, be certain that the host is not accessing data 
on the subsystem. A subsystem restart takes about 4 to 15 minutes.
To continue, click OK.

6. A message warns that the subsystem restart can cause disruptions when 
using TrueCopy or TrueCopy Extended Distance: failure of TrueCopy or 
TrueCopy Extended Distance paths and changing pairs with PAIR or 
COPY status to PSUE.

NOTE: When ON is selected in DHCP, Network is disabled (gray) and 
cannot be selected.
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To restart and apply the LAN settings, click OK.

Setting the LAN Port Number
The port number can be set when the firmware version of the AMS/WMS 
array subsystem is 0726/E or later (9500V array subsystem is x65B/H or 
later).

The port number is set for each controller, however, set both controllers 
without closing the setting window. After setting the both controllers, close 
the Array Unit screen and edit the services file of the OS that is operating 
Navigator 2. When the two or more disk array subsystems are registered, 
set all of them. The setting of the services file is enabled without closing the 
Arrays screen. 

Set the port number in a range of 1024 to 49151.

When changing the TCP/IP port number of the array unit that is connected 
over a LAN, register the changed port number as “df-damp-snm port 
number/TCP”. Before starting Navigator 2, you must register the changed 
port number in the services file of the OS on which Navigator 2 is installed. 
If it is not registered, the array unit may not be able to be connected to the 
LAN.

NOTE:
• To validate the LAN information, restart the array unit. The previous 

settings stay valid until restarting. The array unit cannot access the 
host until the reboot is completed and the system restarts. Therefore, 
ensure that the host has stopped accessing data before beginning the 
restart process.

• If LAN configuration information is modified, an error message 
(Interface Error) may display without displaying a restart completion 
message whenrestarting is initiated. When an error message displays 
after the LAN configuration information is modified and a restarting is 
directed to be done, close the Array Unit screen, make a change in the 
information that has been registered through the Arrays screen, and 
then open the Array Unit screen again.

NOTE: When the TCP/IP port number is set out of a range of 1024 to 
49151 and the number is already used in the management ports, it may be 
forcibly changed to 1024 in some cases.

Table 5-3:  Registering a Changed TCP/IP Port Number

Array Unit Firmware Version

Simple Modular Storage 100  1810/A or later

Adaptable Modular Storage 2100/2300  0832/B or later

Adaptable Modular Storage 2500  0840/A or later
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1. On the Tools menu, select Configuration Settings or click .
2. Click the LAN Port Number tab.

3. Select the radio button of Controller1 and enter a port number in the 
port number text field.

4. Click Apply.
5. When the confirmation message displays, click OK (three times).
6. When the following confirmation message displays, click Cancel.

Navigator 2 goes to the LAN Port Number tab screen.

NOTE: Enter a port number that is not used by the OS that is operating 
Navigator 2, various types of applications, etc. in the port number field.
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7. Select the radio button of the Controller0 and enter a port number to be 
set in the port number text field. Enter the port number that is set in the 
Controller1.

8. Click Apply.
9. When the confirmation message displays, click OK (five times).

The Array Unit screen is closed.

An example of the edit of the services file (in the case of Windows 2000):
1. Open the services file using a text editor such as Notepad.exe, etc.
2. Add a port number to be used by Navigator 2 referring to the following 

example, and then overwrite and save it.
When adding the port number to the last line, ensure that you start a 
new line

Setting the IP Address of the Maintenance Port

To set the IP address of the maintenance port:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Maintenance LAN tab.

NOTE: The LAN configuration information for the maintenance of the 
subsystem is usually set at the factory shipment; therefore you do not have 
to set it.
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a. IP Address: Select the IP address of the CTL0 from the drop-down 
list. When the Maintenance Port IP Address Automatic Change Mode 
is set as Enable with the LAN tab, the display is grayed and the 
setting cannot be made.

3. Click Apply.
4. When the confirmation message displays, click OK.

Setting RTC
Changes to the RTC apply without restarting the subsystem.

To set the RTC:
1. On the Settings menu, click the Configuration Settings or click .
2. Click the RTC tab.
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3. Set the RTC:
a. Setting: Select Manual or Auto.
b. Manual: Sets the date and time.
c. Auto: Sets the time of the Web Server executing Navigator 2.
d. Date: Displays the date.
e. Time: Displays the time.

4. Click Apply.

5. A confirmation message displays. Click OK.

Setting Time Zone and NTP Server
To set the time zone:
1. On the Tools menu, select Configuration Settings or click 
2. Click the Time Zone tab.
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.

a. Time Zone: Select a time zone from the Time Zone drop-down list.
b. Automatically adjust clock for daylight saving changes: Specify 

whether to use the daylight saving or not.
c. NTP Server: Specify the IP address of the NTP server.

3. Click Apply.
4. When the confirmation message displays, click OK.

Outputting Configuration Information to a File
This section describes how to output the configuration information of the 
subsystem in a text file or set the configuration using a text file.

The configuration information output in a text file includes the status of the 
system parameters, RAID group/logical unit, port/host group, and the 
constituent parts of the subsystem. The configuration to be set includes the 
system parameters, RAID group/logical unit, and port/host group. The 
status of the constituent parts of the subsystem cannot be set.

The configuration information is handled with separate text files for the 
system parameters, for RAID group/logical unit, and for port/host group.

Copying configuration information between subsystems can be executed by 
outputting a text file of the configuration from the subsystem, then using 
the output text file to set another subsystem.

Editing a text file to set the subsystem can be done, however, it is 
recommended that this function be used for the configuration of the same 
subsystem. To change the configuration, use individual functions.
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File Output for System Parameters

To output the settings of the system parameters for the subsystem in text 
form to a specified file:
1. On the Tools menu, select Configuration Settings or click 
2. Click the Constitute tab.

3. Check the System Parameters option in the Select Configuration 
Information box.

4. Specify the directory and file name to which the configuration file will be 
output.

5. Select the Output option.
6. Click Apply.
7. When the confirmation message displays, click OK.

System parameter information is saved in the form of a text file with the 
specified file name. The format of the output file consists of the following 
items. The outline of the layout of the output file is shown in following 
figure.
• File header
• Subsystem registration name with Navigator 2
• Output time (Web Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• Common controller parameters
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• Controller parameters

etting System Parameters with a File

Set the system parameters in the subsystem with the information described 
in the file. If you set the system parameters using a file that was output 
when a priced optional feature is in an unlocked state, the setting may 
terminate abnormally. To set system parameters, use a file that was output 
when all priced optional features are in a locked state.

For a dual system, setting cannot be executed if one of the controllers is 
detached. Verify that the subsystem is operating normally.

When system parameters are set, the subsystem cannot execute 
commands from the host. The functions of Navigator 2 can no longer work; 
however, the wizard sets the system parameters and failure monitoring. 
After setting, restart the subsystem. Confirm that it is operating 
successfully. It connects to the host and Navigator 2.

To set subsystem parameters with a file:
1. Edit the file for setting the system parameters to set the subsystem. The 

file has a specified format. The format of the file is the same as that of 
the file output by the subsystem. Refer to the following sections of this 
manual for the format and parameters of the file respectively.

2. On the Tools menu, select Configuration Settings or click .
3. Click the Constitute tab.
4. Click the System Parameter option.
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5. Specify the directory and file name of the file that describes the system 
parameters edited in step 1. The specified file name displays in the text 
box.

6. Select the Input option.
7. Click Apply.
8. When the confirmation message displays, click OK.

RAID/Logical Units and Configuration File Output Status

To output RAID group/logical unit definition information already set in the 
subsystem to a specified file in a text format:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.

3. Click the RAID Group/Logical Unit option in the Select 
Configuration Information box.

4. Specify the directory and file name to output the file of the configuration.
5. Select the Output option.
6. Click Apply.
7. When the confirmation message displays, click OK.

System parameter information is saved in the form of a text file with the 
specified file name.
The format of the output file consists of the following items. An outline 
of the layout of the output file is shown in following figure.
• File header
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• Subsystem registration name at Navigator 2
• Output time (Web Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• RAID group/logical unit configuration
• Status of constituent parts

Setting RAID Group/Logical Unit Definition with a File

Set the subsystem according to the RAID group/logical unit setting 
information described in a file. If the setup of the RAID group/logical unit is 
configured and completed, all of the previous user’s data will be lost. The 
RAID group/logical unit configuration, as specified in the file, is set after 
deleting the current RAID group/logical unit. If user data is needed, 
configure the setting after backing up the system.
1. Edit the file to set the RAID group/logical unit information in the 

subsystem. The file has a specified format. The format of the file is the 
same as that of the file output by the subsystem. For the proper file 
format, see section 805518148.
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The parameters in the file are RAID configuration information, LU 
configuration information, and Drive information in the format of 
the output file. In the output file, there are items that give the status of 
constituent parts. Ignore these items while setting up the configuration. 
The parameters are described below:
a. RAID configuration information: Sets the RAID configuration 

which specifies RAID level, RAID group number and RAID size. If the 
RAID group is not set, “-” is shown after Level, and no other 
parameters are set.

b. LU configuration information: Sets the logical unit configuration.
Specify the logical unit number, logical unit capacity, pre-read 
capacity, number of controllers in current use, number of controllers 
in default use, RAID group number and RAID level, and logical unit 
status.
In logical unit status, for cases where formatting is to be executed, 
specify Normal. Formatting cannot be executed if another status is 
specified.
In cases where the full capacity of the RAID group is allocated to one 
logical unit, specify All in Capacity.
If the number of the controller in current use is specified as “0” or 
“1”, it becomes the same as the number of the controller in default 
use.
In cases where logical units of less than the maximum logical unit 
number are created, specify at the end that “After nn, not define” 
(nn: the last logical unit number + 1).

c. Drive information: Sets the configuration of the HDU installed in 
the subsystem. For an HDU that is not installed, do not specify 
anything.
When a capacity bigger than that of the installed HDU is specified, it 
is regarded as an error and not set.

2. On the Tools menu, select Configuration Settings or click .
3. Click the Constitute tab.
4. Click the RAID Group/Logical Unit option.
5. Specify the directory and name of the file that describes the RAID group 

definition and logical unit definition edited in step 1. The specified file 
name is shown in the text box.

6. Select the Input option.
7. Click Apply.
8. Messages display and warn you of the following:

a. The procedure deletes the current RAID/LU configuration.
b. User data in the logical units are invalidated and cannot be 

recovered.
To continue, click OK in the messages.
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9. A message displays, stating that the RAID configuration setting has 
started:
a. When the setting of the RAID group ends abnormally, an error 

message displays and interrupts processing.
b. If the setting of the RAID group ends normally, a message that the 

setting of logical unit has started displays, and executes the logical 
unit setting.

c. When the logical unit setting ends abnormally, an error message 
displays and interrupts processing.

d. If the logical unit setting ends normally, formatting of the set logical 
unit starts.

10.A message displays stating that the setting is complete. Click OK.

Port/Host Group Information File Output

To output the settings of the port/host group information for the subsystem 
in text form to a specified file:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab

.

3. Check the Port Information option in the Select Configuration 
Information box.

4. Specify the directory and file name to which the host group information 
file will be output.

5. Click the Output option.
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6. Click Apply.
When the confirmation message displays, click OK.
The host group information is saved in the form of a text file with the 
specified file name.
The format of the output file consists of the following items. The outline 
of the layout of the output file is shown in following figure.
• File header
• Registration name with Navigator 2 of the subsystem
• Output time (Web Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• Mapping mode
• Port option
• Host group option
• Host group information
• Logical unit mapping information
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Setting Port/Host Group Information with a File

To set Port/Host Group settings with a file:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.
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3. Click the Port Information (Update) option in the Select 
Configuration Information box.

4. Select the items that you will set from setting information for Fibre. An 
error will occur if nothing is chosen. (When the LUN Manager function is 
valid, the WWN Information displays for setting information for Fibre.)

5. Specify the directory and file name to which the host group information 
file will be input.

6. Select the Input option.
7. When the confirmation message displays, click OK to continue.
8. One or more messages advise that a subsystem restart is required. 

Followthe on-screen instructions to stop subsystem access and click OK 
to continue.

A message displays, stating that the setting is complete. Click OK.

File Output of Boot Option Information
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.
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3. Check Boot Options in the Select Configuration Information box.
4. Specify the directory and file name to which the boot option information 

file will be output.
5. Click Apply.
6. When the confirmation message displays, click OK.

The boot options information is saved in the form of a text file with the 
specified file name.
The format of the output file consists of the following items. The outline 
of the layout of the output file is shown in following figure.
• File header
• Output time (Web Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• Boot options information
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Setting Boot Option Information with a File

1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.

WARNING! Rebooting requires stopping I/O from the host.
WARNING! If you are using TrueCopy or TrueCopy Extended Distance and 
you are required to reboot the subsystem, change the pair status to PSUS 
before you reboot.
WARNING! If you are using a NAS, you must also stop the clusters 
between NAS units. When restarting the subsystem, you must restart the 
clusters



5–104 Hitachi Storage Navigator 2 on 9500VIAMS/WMS Arrays

Hitachi Storage Navigator 2 Advanced Settings User’s Guide 

3. Check Boot Options and Input option in the Select Configuration 
Information box.

4. Specify the directory and file name to which the boot option information 
file will be input.

5. Click Apply.
6. When the confirmation message displays, click OK.
7. One or more messages advise that a subsystem restart is required. 

Follow the on-screen instructions to stop subsystem access and click OK.
When you choose to restart the subsystem, the time the restart began 
displays. This usually takes approximately 4 to 15 minutes.

8. A message displays, stating that the restart is successful.

File Output of Parts Information

To output parts information to a file:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.

NOTE:  It may take time for the subsystem to respond, depending on the 
condition of the subsystem. If it does not respond after 15 minutes, check 
the condition of the subsystem.
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3. Check Parts Information in the Select Configuration Information 
box.

4. Specify the directory and file name to which the parts information file 
will be output.

5. Click Apply.
6. When the confirmation message displays, click OK.

Outputting NAS System LU/User LU to a File

To output the NAS system LU/User LU to a file:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.
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3. Check the NAS:System LU/User LU option in the Select 
Configuration Information box.

4. Specify the directory and file name to which the NAS system LU/User LU 
information file will be output.

5. Click Apply.
6. When the confirmation message displays, click OK.

The NAS System LU and NAS User LU information is saved in the form 
of a text file with the specified file name.
The format of the output file consists of the following items. The outline 
of the layout of the output file is shown in following figure:
• File header
• Registration name with Navigator 2 of the subsystem
• Output time (Web Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• NAS System LU information
• NAS User LU information
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Setting NAS System LU/User LU Information with a File
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.
3. Check the NAS:System LU/User LU option and Input option in the 

Select Configuration Information box.
4. Specify the directory and file name to which the NAS system LU/User LU 

information file will be input.
5. Click Apply.
6. When the confirmation message displays, click OK.

File Output of iSCSI Port Information

To output the settings of the iSCSI port information for the subsystem in 
text form to a specified file:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.
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3. Check the Port Information option in the Select Configuration 
Information box.

4. Specify the directory and file name to which the iSCSI port information 
file will be output.

5. Click the Output option.
6. Click Apply.
7. When a message displays, confirming that the iSCSI port information is 

output with the specified file name, click OK.
The iSCSI port information is saved in the form of a text file with the 
specified file name.
The format of the output file consists of the following items. The outline 
of the layout of the output file is shown in following figure.
• File header
• Registration name with Navigator 2 of the subsystem
• Output time (Web Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• Mapping mode
• iSCSI port information
• Port options
• Target information
• Host system configuration
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• Target options
• Logical unit mapping information

Setting iSCSI Port Information with a File

To set iSCSI Port settings with a file:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.
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3. Click the Port Information (Update) option in the Select 
Configuration Information box.

4. Select the items that you will set from Setting Information for iSCSI. An 
error occurs if nothing is chosen. (When the LUN Manager function is 
valid, the Initiator Information displays for Setting Information for 
iSCSI.)

5. Specify the directory and file name to which the iSCSI port information 
file will be input.

6. Select the Input option.
7. A confirmation message displays. To continue, click OK.
8. One or more messages advise that a subsystem restart is required. 

Follow the on-screen instructions to stop subsystem access and click OK 
to continue.

9. A message displays, stating that the setting is complete. Click OK.

Setting CHAP User Information with a File
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.
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3. Click the CHAP User option in the Select Configuration Information 
box.

4. Specify the directory and file name to which the CHAP User information 
file will be input.

5. Select the Input option.
6. A confirmation message displays. To continue, click OK.

The CHAP User information setting file format is shown in Table .

File Contents Description

User name,secret,Target No. or
alias ...

The lines are invalid until <CHAP User> appears.

<CHAP User>,, The valid lines are from <CHAP User> to <END>.

<Port 0A>,, The line specifies the port. (<Port ALL> specifies all 
ports)

hitachi-0,abcdefghij00,alias0 The first column is CHAP User, and the second column 
is Secret..

hitachi-1,abcdefghij01,alias1 The third row and the following are aliases of Target to 
assign.

#hitachi-1,abcdefghij01,alias1 ) The line with the first character of # is a comment line.
(Invalid line)

hitachi-2,abcdefghij02,3 The Target number can be specified as the alias of 
Target.

<Port 0B>,,
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File Output of LAN Information

To output the settings of the LAN information for the subsystem in text form 
to a specified file:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.

3. Check the LAN Information option in the Select Configuration 
Information box.

4. Specify the directory and file name to which the LAN information file will 
be output.

5. Click the Output option.

<Add CHAP User>,, If <Add CHAP User> is specified, CHAP User is added.

hitachi-0,abcdefghij00,alias0 If nothing is specified, all CHAP Users are deleted, and 
then added

hitachi-
1,abcdefghij01,alias0,alias01,alias
0
2

One or more Targets can be specified.

<Port 1A>,,

<Port 1B>,,

<END>,, The line of <END> and the following are all invalid 
lines.

File Contents Description
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6. Click Apply. 
7. When a message displays, confirming that the LAN information is output 

with the specified file name, click OK.

The LAN information is saved in the form of a text file with the specified file 
name.

The format of the output file consists of the following items. The outline of 
the layout of the output file is shown in following figure.
• File header
• Registration name with Navigator 2 of the subsystem
• Output time (Web Server time where Navigator 2 is installed)
• Firmware revision
• Subsystem type
• Serial number
• User LAN information

Maintenance Port IP Address Automatic Change Mode
• Maintenance Port LAN information
Concerning the Ether Address of the user LAN information, only the
information on the controller connected over the LAN is output. To output 
the information on the both controllers, connect the both controllers over 
the LAN. When the information is output in the state in which the 
controller(s) is (are) blocked, the LAN information on the blocked 
controller(s) is output as 0.0.0.0.
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Setting LAN Information with a File

To set LAN settings with a file:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Constitute tab.

WARNING! The User LAN Parameter (Maintenance Port IP Address 
Automatic Change Mode, IP Address, Subnet Mask, Default Gateway) and 
Maintenance LAN Parameter (Network Address) can be set up. The other 
information cannot be set up.
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3. Click the Input option in the Operation box.
4. Check the LAN Information option in the Select Configuration 

Information box.
5. Specify the directory and file name to which the LAN information file will 

be input.
6. Click Apply.
7. A confirmation messagedisplays. To continue, click OK.

Replacing a Firmware

The function downloads and replaces the firmware in the subsystem. 
Whenreplacing the firmware, download it, and then replace it.

This section includes the following:
• Firmware Download
• Replacing the firmware

Firmware Download

Download the firmware from the CD-R into the subsystem. In the download, 
the firmware is stored in the subsystem; the firmware of the subsystem is 
not replaced.

NOTE: If a firmware is read during the firmware download, the download 
processing is interrupted. Read a firmware after checking that it is not 
under download.
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1. Copy the firmware from the CD-R to the hard disk.

2. On the Tools menu, select Configuration Settings or click .
3. Click the Micro Update tab.

• Current Revision: Firmware revision of each controller of the 
subsystem.

• New Revision: A firmware revision stored in the system in which 
Navigator 2 is installed. When the firmware is not read, a blank is 
displayed.

• Interval Time: Interval time for download. Specify the time 
between 1 and 60 seconds. For the LAN connection, when the 
interval time is specified as 3 seconds, the download requires 
approximately 9 minutes. The time required for the execution 
varies with the network status and depends on I/Os issued by the 
host. When the interval time is specified as one second longer, the 
time required for the download is prolonged by 3 minutes.
This function can be used during execution of the I/O instructed by 
the host. However, when the download function is executed, I/O 
performance of the host is reduced. To enhance performance, specify 
a longer interval time.

NOTE: For a directory where Navigator 2 is installed, do not copy the 
firmware directly to the CD-R. Create a subdirectory and copy it under this 
subdirectory. Specify the name of a directory in the hard disk drive to which 
the firmware is copied, with a one-byte coded alphanumeric.
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• Revision Check: Instructs the revision check of the firmware to 
be downloaded. When the download instruction is specified, 
whether or not a hot replacement is applicable to the firmware is 
checked. Select Yes.

When no firmware is read, the Download and Delete buttons are 
displayed in gray and cannot be selected.

4. The firmware is read into the PC in which Navigator 2 is installed. Click 
Read. When a revision is displayed Revision (Read), the firmware is 
already read.To download the firmware that is already read, execute 
Download.
When you have clicked Read, specify the revision directory in which the 
firmware is installed is specified, all the firmwares are read 
automatically.

5. When a confirmation message displays, asking whether to read the 
firmware, click OK.
If the firmware is already read, a confirmation message displays. When 
OK is clicked, the firmware is overwritten. To stop reading the firmware, 
click Cancel.
To delete the firmware that is already read in the Web Server, click 
Delete. When a confirmation message displays, click OK.

6. When a window for specifying a revision directory in which the read 
firmware exits displays, enter this directory. When OK is clicked, reading 
the firmware is started.

7. When a message displays indicating that the firmware has been read, 
click OK.
The revision of the read firmware displays in the Revision (Read) field.
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8. To download the firmware, click Download.
9. When a confirmation message displays requesting confirmation to 

download the firmware, click OK.
10.Select the access receptionist opportunity from the host after firmware 

replaced

• If you click Yes, Navigator 2 will not receive access from the host until 
you click OK.

• If you click No, Navigator 2 receives access from the host.

A message displays stating that the download is being executed. This 
message displays the revision of the program being downloaded, interval 
time, and progress.
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The download can be aborted. To abort the download halfway, click Cancel. 
A confirmation message displays. When OK is clicked, the download is 
aborted. When Cancel is clicked, the download is continued.
1.When the firmware is normally downloaded, a confirmation message displays. Click OK

11.When the firmware is normally downloaded, a confirmation message 
displays. Click OK

Replacing a Firmware

Replace the firmware for the controller with the firmware downloaded in the 
subsystem. When replacing the firmware, replace both controller 0 and 
controller 1 firmwares. When connecting with both controllers or only with 
controller 0, replacement begins with controller 0 and then with controller 
1. When connecting only with controller 1, replacement takes place in 
controller 1 and then controller 0.

NOTE: After the firmware downloads, restart the subsystem or replace the 
firmware. If a hot replacement of the controller board is done before 
restarting the subsystem or the firmware replacement, the replaced new 
controller may be blocked. Download may terminate with a DMES05EA03 
message when the subsystem is heavy host I/Os. Perform the download 
operation again.
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To replace the firmware:
1. On the Tools menu, select Configuration Settings or click .
2. Click the Micro Update tab.

3. Select the controller whose firmware is to be replaced and click 
Replace.

4. A confirmation message displays. Click OK.

NOTE: When only the controller of one side replaces firmwares and the 
Array Unit screen is closed, there is a case where the Array Unit screen 
stops opening after that. When the Array Unit screen does not open, 
replace the firmwares after replacing the firmwares into the registration of 
a controller that is not replacing firmwares.

WARNING! This operation will interrupt I/O from the host and may 
requirerebooting the subsystem.
WARNING! If you are using TrueCopy or TrueCopy Extended Distance and 
you are required to reboot the subsystem, change the pair status to PSUS 
before you reboot.
WARNING! If you are using a NAS, you must also stop the clusters 
between NAS units. When restarting the subsystem, you must restart the 
clusters.
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A status message displays.
5. After the firmware download, the following message displays. Check the 

contents of the message and click OK.

6. When the firmware replacement terminates normally, a completion 
message displays. When you click OK, the replacement firmware 
updates and a window displays.
If the downloaded firmware fails, a failure message displays. To validate 
the downloaded firmware, restart the subsystem.

7. Repeat this procedure to replace the firmware on the other controller. 
Whenreplacements for both controllers terminate normally, the 
subsystemfirmware replacement is complete.

Setting the Backend Diagnosis Information
1. 1. On the Tools menu, select Configuration Settings or click .
2. Click the Backend Diagnosis tab. 

NOTE:  It may take time for the subsystem to respond, depending on the 
condition of the subsystem. If it does not respond after 15 minutes, check 
the condition of the subsystem.

NOTE: When a firmware is replaced, if the firmware for only one of the 
controllers is replaced, the subsystem declares a warning state. When the 
other controller’s subsystem is replaced, the subsystem recovers from the 
warning state. Always replace the firmware for both controllers.
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3. Click Apply.
4. A confirmation message displays. Click OK.

Configuring NNC
The following figure shows an example of a connection of the host computer (Web Server) in which Navigator 2 is installed and the subsystem to which the NNC option has been added.
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Setting NNC LAN Information
To set the NNC LAN information for management port:
1. On the Tools menu, select Configuration Settings or click .
2. Click the NNC LAN tab.

• Network: Specify the IP Address, Subnet Mask, MTU, and 
Negotiation, which is part of the LAN information.

3. Click Apply.
4. When the confirmation message displays, click OK.

Setting NAS System Logical Units

Nine logical units are required for the NAS system. The following figure 
shows the capacity that is necessary. When no logical unit is available for 
allocating to the NAS system logical unit, create it. See section 0 for 
information about creating a logical unit.

NOTE: The NAS system logical units are usually set at the factory 
shipment, so that a user is not required to set them.
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To set the NAS system logical units:

For NNC Type2

1. Click the Logical Status tab on the Array Unit screen.

2. Click the NAS plus sign.

3. Click the NNC0/2 plus sign.

4. Click the System icon.

5. Click Set.
The System LU dialog displays.
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6. Click Select to set the System LU.
The Select Logical Unit dialog displays.

7. Select the LUN you want to set the System LU and click OK.

The selected LUN displays to the System LU dialog box.
8. Repeat steps 5 and 6 and complete a System LU list.
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9. Click OK.
10.When the confirmation message displays, click OK.

For NNC Type1
1. Click the Logical Status tab on the Array Unit screen.
2. Click the NAS plus sign.
3. Click the NNC0/2 plus sign.
4. Click the System icon.
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5. Click Set.
The System LU dialog displays.

6. Click Select to set the System LU.
The Select Logical Unit dialog displays.

7. Select the LUN you want to set the System LU and click OK.
The selected LUN displays to the System LU dialog box.

8. Repeat steps 5 and 6 and complete a System LU list.
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Setting NAS User Logical Units
When no logical unit is available for allocating to the logical unit for the NAS 
user, create it. See section 805518148 for information about creating a 
logical unit.

To set the NAS user logical units:
1. Click the Logical Status tab on the Array Unit screen.
2. Click the NAS plus sign.
3. Click the NNC0/2 plus sign.
4. Click the User icon.
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5. Click Set.
The User LU dialog box displays.

6. Select one H-LUN to be added. Select one LUN and click . The 
added contents are displayed in Logical Unit for User Volume list.

7. Repeat step 5 and complete a User LU list.
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To cancel the assigned user LU, click the H-LUN to be canceled in the 
Logical Unit for User Volume list and click .

The selected H-LUN moves to the Available Logical Units list.
8. Click OK.
9. When the confirmation message displays, click OK.

Shutting Down/Booting/Rebooting NNC

Shutting Down the NNC

1. Click the Logical Status tab on the Array Unit screen.

NOTE: When shutting down the NNC, just after the subsystem power ON 
or cluster start from the NAS Manager Modular, stop the NNC after the 
followingconfirmation displays:

The cluster status is “ACTIVE”, and the resource group status is “Online” 
or “Offline”.

When shutting down NCC and NNC is not in the above situation, it is 
possible that the cluster setting and resource group setting cannot execute 
normally. (Example: When executing the cluster stop from the NAS 
Manager that is connected to the NNC which is not executed the shutdown 
the NNC, it is possible that the cluster stop is not finished.) In this case, 
reboot the NNC, which is not executed the shutdown the NNC from 
Navigator 2.
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2. Select the NAS icon and then select the NNC number on the NNC 
Status list.

NNC Status: Status of NAS OS:
ACTIVE: NAS OS is active and the Node is in operation.
BOOT: NAS OS is in boot process.
DISUSE: The controller is blocked.
DOWN: NAS OS is abnormally stopped.
DUMP: A NAS Dump is being collected.
HUNGUP: NAS OS is hung-up.
INACTIVE: NAS OS is in operation and the Node is stopped.
INST: NAS OS is in installation process.
NEW: NAS OS is not installed.
SHUTDOWN: NAS OS is in shutdown process.
STOP: NAS OS is normally stopped.
WARN: NAS Manager is not installed, or NAS OS is in operation and 
the status of the Node is unknown.

3. Click Shutdown.
4. When the confirmation message displays, click OK.
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Booting the NNC

1. Click Logical Status on the Array Unit screen.
2. Select the NAS icon, and then select the NNC number on the NNC 

Status list.

3. Click Boot.
4. When the confirmation message displays, click OK.

NOTE: There is not a difference in operation of boot and reboot. Do not 
specify anything for the boot option.
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Rebooting the NNC

1. Click Logical Status on the Array Unit screen.
2. Select the NAS icon, and then select the NNC number on the NNC 

Status list.

3. Click Reboot.
4. When the confirmation message displays click OK.

NOTE:  When rebooting the NNC immediately after the subsystem power 
ON or cluster start from NAS Manager, reboot the NNC after the following 
confirmation displays

The cluster status is “ACTIVE”, and the resource group status is“Online” or 
“Offline”.

When rebooting the NNC and NCC is not in the above situation, it is possible 
that the cluster setting and resource group setting cannot execute 
normally.

(Example: When executing the cluster stop from the NAS Manager that is 
connected to NNC which is not executed the rebooting the NNC, it is 
possible that the cluster stop is not finished.) In this case, reboot the NNC 
which is not executed the rebooting the NNC from Navigator 2.
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Displaying Statistical Information

Displaying Controller Activity
To display controller activity :

1. On the Tools menu, select Statistical Information or click .

Array Time
• Controller being active for (Integrated): The accumulated time 

when the power is applied from the initial powering on of the 
subsystem to the latest powering off is displayed by the minute.

• Power on for (Work): The time elapsed from the powering on of the 
subsystem to the present time is displayed by the millisecond.

Controller
• Powered on counts: Integrated number of power ON times (at 

interruption) of the controller.
• H-SCSI reset counts: Integrated number of host bus SCSI reset 

times (total of interruptions and messages) of the controller (not 
supported).

Displaying Host Commands Received (Read/Writes per LU) 
To display the cumulative read and write commands per logical unit, select 
the Host Commands tab. 
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• LU: Logical unit number
• Read: Accumulated number of received read commands in each logical 

unit
• Write: Accumulated number of received write commands in each 

logical unit

Displaying Command Execution Activity
To display the command execution activity, select the Execution tab.
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• A: Logical Unit: Logical unit number
• B: Read Cache Hits: Total of READ commands (hitting cache or partially 

hitting cache)
• C: Write Cache Hits: Total of WRITE commands (cache read hits)
• D: Sequential Read: Total of READ commands (recognized as 

sequential reading)
• E: Sequential Write: Total of WRITE commands (recognized as 

sequential writing)
• F: Prefetch Staging: Total of pre-fetch jobs executed
• G: Write Through Operation: Total of WRITE or WRITE & VERIFY 

commands (substituted by Write-Through operations)
• H: Reassigned Blocks: Number of re-assigned blocks (not supported)

Displaying Cache Load Condition
To display cache load activity, click the Cache Load tab.
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• Number of Inflow Threshold Reached: Total number of occurrences of 
inflow limitations.

This equipment manages the amount of data in cache as an inflow limit. 
When the host tries to write data exceeding this limit, an inflow limitation 
occurs. In this case, the write request from the host waits until part of the 
write data is transferred to the drive.

Acquiring Performance Information
In the statistics information, the command operation state is output for 
each logical unit in the array unit. The command operation state consists of 
three types of data: the number of received commands, the number of 
cache-hit commands, and the cache hit rate for each Read or Write 
command.

Collecting Performance Statistics
To collect performance statistics:
1. On the Tools menu, select Performance -> Settings.
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2. Select items from the Collection of Performance Statistics.
3. Click OK.

A confirmation message indicates that the host access may be affected 
during statistic collection. Click OK.

Manually Outputting Performance Statistics to a Text File
To create a performance-statistic text file:
1. On the Tools menu, select Performance -> Output File.
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2. Select a component name (Port, RAID Groups, Logical Unit, Cache, 
Processor, Drive, Drive Operation, or Back-end) for information 
about the controller.

3. Specify the extent of the output using Select, excluding the Cache and 
Processor. When the extent is not specified, all is output. For example, 
when you want to specify an extent of information on the Logical Unit, 
select the Logical Unit icon, click Select, and specify the extent of the 
Logical Unit.
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4. Click the number of the first LU you do not want to output. Scroll the LU 
numbers with the slider keeping the Shift key pressed, and click the 
number of the last LU.

5. Click OK.
6. Select the Manual option.
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7. Set the Collectively output option:
• Select to append the current output to the previous output.
• Clear to collect only the current output.

8. Specify the output directory. If the output directory is omitted, output 
defaults to the directory Navigator 2 installation directory.

9. Click Start.
10.Click Get Data.

• When the Collectively output is not specified:
These files are output in the text file format.
: pfm$$$$$.txt ($$$$$: serial number from 00000 to 19999)

The information is acquired according to the following timing.

NOTE: Files are output with the names of pfm00000.txt to pfm19999.txt. 
After pfm19999.txt, pfm00000.txt is overwritten. Transfer the necessary 
information to another directory.
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• When the Collectively output is specified:
This file is output in the text file format (pfm.txt).

11.After the file processed is terminated, a confirmation message displays. 
Click OK.

12.Click Stop.

When the single system is connected, information is only collected for the 
controller 0 side.

• No.: Output number
• Information getting time: Time and date when the information 

is acquired
• CTL: Controller number
• Port: Port number
• IO Rate (IOPS): Number of Read/Write commands received per 

second
• Read Rate (IOPS): Number of Read commands received per 

second
• Write Rate (IOPS): Number of Write commands received per 

second
• Read Hit (%): Rate of the number of the Read commands, 

whichcould cache-hitting, out of the Read commands received in 
the specified period

• Write Hit (%): Rate of the number of the Write commands, which 
could write data immediately to the cache, out of the Write 
commands received in the specified period

• Trans. Rate (MB/S): Transfer size of Read/Write commands per 
second

• Read Trans. Rate (MB/S): Transfer size of Read commands per 
second

NOTE: For AMS500 subsystems, a single output to text file is 500 KB. 
Multiple outputs increase the file size proportionally. A file with 20,000 
outputs requires about 10 GB of disk space.
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• Write Trans. Rate (MB/S): Transfer size of Write commands per 
second

• Read CMD Count: Received number of Read commands
• Write CMD Count: Received number of Write command
• Read CMD Hit Count: Number of the Read commands that had 

been cache-hit
• Write CMD Hit Count: Number of the Write commands, which 

could write data immediately to the cache
• Read Trans. Size (MB): Transfer size of Read commands
• Write Trans. Size (MB): Transfer size of Write commands
• RG: RAID group number
• LU: Logical unit number
• Read CMD Hit Count2: Number of the Hit Read Special Path 

commands out of the read commands that made cache hits
• Read CMD Hit Time(microsec.): The average response time of 

the Hit Read Special Path command
• Read CMD Hit Max Time(microsec.): The maximum response 

time of the Hit Read Special Path command
• Write CMD Hit Count2: Number of the Write Special Path 

commands out of the Write commands, which could write data 
immediately to the cache

• Write CMD Hit Time(microsec.): The average response time of the 
Write Special Path command

• Write CMD Hit Max Time(microsec.): The maximum response time 
of the Write Special Path command

• Read CMD Miss Count: The number of the Miss Read Special Path 
commands out of the Read commands that made no cache hits

• Read CMD Miss Time(microsec.): The average response time of the 
Miss Read Special Path command

• Read CMD Miss Max Time(microsec.): The maximum response time 
of the Miss Read Special Path command

• Write CMD Miss Count: The number of the Random Write Special 
Path commands that could complete the high-speed process up to 
the parity generation that is an extended process of the Write 
command

• Write CMD Miss Time(microsec.): The average response time of the 
Random Write Special Path command

• Write CMD Miss Max Time(microsec.): The maximum response 
time of the Random Write Special Path command

• Read CMD Job Count: The number of the Read commands that 
could not perform the high-speed process

• Read CMD Job Time(microsec.): The average response time of the 
Read command job
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• Read CMD Job Max Time(microsec.): The maximum response time 
of the Read command job

• Write CMD Job Count: The number of the Write commands that 
could not perform the high-speed process

• Write CMD Job Time(microsec.): The average response time of the 
Write command job

• Write CMD Job Max Time(microsec.): The maximum response time 
of the Write command job

• Read Hit Delay CMD Count(<300ms): The number of commands, 
whose response time is 100 ms to less than 300 ms, out of the Hit 
Read Special Path commands

• Read Hit Delay CMD Count(300-499ms): The number of 
commands, whose response time is in a range of 300 ms to 499 
ms, out of the Hit Read Special Path commands

• Read Hit Delay CMD Count(500-999ms): The number of 
commands, whose response time is in a range of 500 ms to 999 
ms, out of the Hit Read Special Path commands

• Read Hit Delay CMD Count(1000ms-): The number of commands, 
whose response time is 1000 ms or more, out of the Hit Read 
Special Path commands

• Write Hit Delay CMD Count(<300ms): The number of commands, 
whose response time is 100 ms to less than 300 ms, out of the 
Write Special Path commands

• Write Hit Delay CMD Count(300-499ms): The number of 
commands, whose response time is in a range of 300 ms to 499 
ms, out of the Write Special Path commands

• Write Hit Delay CMD Count(500-999ms): The number of 
commands, whose response time is in a range of 500 ms to 999 
ms, out of the Write Special Path commands

• Write Hit Delay CMD Count(1000ms-): The number of commands, 
whose response time is 1000 ms or more, out of the Write Special 
Path commands

• Read Miss Delay CMD Count(<300ms): The number of commands, 
whose response time is 100 ms to less than 300 ms, out of the 
Miss Read Special Path commands

• Read Miss Delay CMD Count(300-499ms): The number of 
commands, whose response time is in a range of 300 ms to 499 
ms, out of the Miss Read Special Path commands

• Read Miss Delay CMD Count(500-999ms): The number of 
commands, whose response time is in a range of 500 ms to 999 
ms, out of the Miss Read Special Path commands

• Read Miss Delay CMD Count(1000ms-): The number of commands, 
whose response time is 1000 ms or more, out of the Miss Read 
Special Path commands

• Write Miss Delay CMD Count(<300ms): The number of 
commands, whose response time is 100 ms to less than 300 ms, 
out of the Random Write Special Path commands
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• Write Miss Delay CMD Count(300-499ms): The number of 
commands, whose response time is in a range of 300 ms to 499 
ms, out of the Random Write Special Path commands

• Write Miss Delay CMD Count(500-999ms): The number of 
commands, whose response time is in a range of 500 ms to 999 
ms, out of the Random Write Special Path commands

• Write Miss Delay CMD Count(1000ms-): The number of 
commands, whose response time is 1000 ms or more, out of the 
Random Write Special Path commands

• Read Job Delay CMD Count(<300ms): The number of 
commands, whose response time is 100 ms to less than 300 ms, 
out of the Read command job

• Read Job Delay CMD Count(300-499ms): The number of 
commands, whose response time is in a range of 300 ms to 499 
ms, out of the Read command job

• Read Job Delay CMD Count(500-999ms): The number of 
commands, whose response time is in a range of 500 ms to 999 
ms, out of the Read command job

• Read Job Delay CMD Count(1000ms-): The number of 
commands, whose response time is 1000 ms or more, out of the 
Read command job

• Write Job Delay CMD Count(<300ms): The number of 
commands, whose response time is 100 ms to less than 300 ms, 
out of the Write command job

• Write Job Delay CMD Count(300-499ms): The number of 
commands, whose response time is in a range of 300 ms to 499 
ms, out of the Write command job

• Write Job Delay CMD Count(500-999ms): The number of 
commands, whose response time is in a range of 500 ms to 999 
ms, out of the Write command job

• Write Job Delay CMD Count(1000ms-): The number of 
commands, whose response time is 1000 ms or more, out of the 
Write command job

• Tag Count: The maximum number of tags in the specified period
• Data CMD IO Rate (IOPS): Sent number of data commands of 

TrueCopy Initiator per second (acquired local side only)
• Data CMD Trans. Rate (MB/s): Transfer size of data commands 

of TrueCopy Initiator per second (acquired local side only)
• Data CMD Count: The data commands count of TrueCopy Initiator 

(acquired local side only)
• Data CMD Trans. Size (MB): Transfer size of data commands of 

TrueCopy Initiator (acquired local side only)
• Data CMD Time (microsec.): Average response time of data 

commands of TrueCopy Initiator (acquired local side only)
• Data CMD Max Time (microsec.): Maximum response time of 

data commands of TrueCopy Initiator (acquired local side only)
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• Cache Write Pending Rate (%): Rate of cache usage capacity 
(middle+physical) within the cache capacity

• Cache Clean Queue Usage Rate (%): Rate of clean cache usage
• Cache Middle Queue Usage Rate (%): Rate of middle cache 

usage
• Cache Physical Queue Usage Rate (%): Rate of physical cache 

usage
• Cache Total Queue Usage Rate (%): Rate of total cache usage
• Partition: Partition number
• Usage (%): Operation rate of the processor
• Host-Cache Bus Usage Rate (%): The use rate of the bus 

between the host and the cache
• Drive-Cache Bus Usage Rate (%): The use rate of the bus 

between the drive and the cache
• Processor-Cache Bus Usage Rate (%): The use rate of the bus 

between the processor and the cache
• Cache (DRR) Bus Usage Rate (%): The use rate of the bus 

between the parity generation circuit (DRR) and the cache
• Dual Bus Usage Rate (%): The use rate of the bus between the 

controllers
• Total Bus Usage Rate (%): The total use rate of the cache bus
• Unit: Unit number
• HDU: HDU number
• Online Verify. Rate (IOPS): Number of Online Verify commands 

per second
• Online Verify CMD Count: Number of Online Verify commands
• Operating Rate (%): Operation rate of the drive
• Tag Count: Number of Tag
• Unload Time (min.): Unload time of the drive
• Path: Path number
• Loop: Loop number

Automatically Outputting Performance Statistics to a Text File

Command oper ation state for each logical unit in the subsystem is output 
at the specified intervals by the specified times.
1. On the Tools menu, select Performance or click .
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2. Select a component name (Port, RAID Groups, Logical Unit, Cache, 
Processor, Drive, Drive Operation, or Back-end) for information 
about the controller.

3. Specify the extent to be output using Select, excluding the Cache and 
Processor. When the extent is not specified, all is output. For example, 
when you want to specify an extent of information on the Logical Unit, 
select the Logical Unit icon, click Select, and specify the extent of the 
Logical Unit.

4. Select the Auto option.
5. Specify the Interval Time and Get Count Times.
6. When you want to make an output as an addition to the information 

previously output, check the Collectively output check box. Do not 
check this box when you want to overwrite the information that was 
previously output.

7. Specify the output directory. If the output directory is omitted, it will be 
outputted to the directory where Navigator 2 is installed.

8. Click Start.
A status message displays.
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a. When Collectively output is not specified:
These files are output in the text file format.
: pfm$$$$$.txt ($$$$$: serial number from 00000 to 19999)

b. When Collectively output is specified:
This file is output in the text file format (pfm.txt).

9. After the file processed terminates, a confirmation message displays. 
Click OK.
When the single system is connected, only information from controller 0 
is collected.
The format to the file to be retrieved is the same as that of the file 
retrieved manually.

Tuning Parameters

Multi Stream Tuning Parameters
1. On the Tools menu, click Tuning Parameter.

The Tuning Parameter panel displays.

NOTE: Files are output with the names of pfm00000.txt to pfm19999.txt. 
After pfm19999.txt, pfm00000.txt is overwritten. Transfer necessary 
information to another directory.

NOTE:  For AMS500 subsystems, a single output to text file is 500 KB. 
Multiple outputs increase the file size proportionally. A file with 20,000 
outputs requires about 10 GB of disk space.
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• Scope: Select System or Logical Unit.
• Mode / Prefetch Information:
LUN: Displays All.
Mode: Displays Normal, Read, Write, or Read/Write.
Prefetch Next: Displays Disable or Enable.
Prefetch Criteria: Displays Base or Fixed.

2. When you want to modify the setting, click Modify.
The Prefetch Multi Stream (System) dialog displays.

• Mode: Specify the mode:
Read: When you select the Read mode, specify the Prefetch Next 
Enable or Disable.
Write: When you select the Write mode, you cannot specify the 
Prefetch Next.
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• Prefetch Criteria: Specify the pre-fetch criteria.
3. Specify the parameters and click OK.
4. Select the Logical Unit on the Scope.

• Scope: Select System or Logical Unit.
• Mode / Prefetch Information:
LUN: Displays logical unit number.
Mode: Displays Normal, Read, Write, or Read/Write.
Prefetch Next: Displays Disable or Enable.
Prefetch Criteria: Displays Base or Fixed.

5. Select the LUN setting to modify, and click Modify.
The Prefetch Multi Stream (Logical Unit) dialog displays.
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• Logical Unit No.: Displays the logical unit number.
• Mode: Specify the mode:

Read: When you select the Read mode, specify the Prefetch Next 
Enable or Disable. You can specify only Fixed in the Prefetch 
Criteria.
Write: When you select the Write mode, cannot specify the 
Prefetch Next.

• Prefetch Criteria: Specify the pre-fetch criteria.
6. Specify the parameters and click OK.
7. Click Apply on the Tuning Parameter panel.
8. A message displays, stating that the setting is complete. Click OK.

To initialize the Multi Stream parameters:
1. When you want to initialize the multi stream parameters, click Default 

the Tuning Parameter panel.
2. A message displays stating that the setting is complete. Click OK.

Prefetch Parameters
1. On the Tools menu, select Tuning Parameter.

The Tuning Parameter panel displays.
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• Count of Judgment Sequential: Specify the count of judgment 
sequential.

2. Select the LUN you want to modify the prefetch size, and then click 
Modify.
The Prefetch Staging Size dialog displays.

3. Specify Prefetch Size, click OK.
4. Click Apply.
5. The Setting Complete message displays; click OK.

To initialize the Prefetch parameters:
1. When you want to initialize the prefetch parameters, click Default on 

the Prefetch tab.
2. A message displays stating that the setting is complete. Click OK.
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Setting System Tuning Parameters
To customize system tuning parameters:
1. From the Tools menu, select Tuning Parameter.

The Tuning Parameter panel displays.
2. Click the System tab.

• Dirty Data Opportunity: Specify an occasion to de-stage dirty data 
(%).

• Dirty Data Stop Opportunity: Specify an occasion to stop de-
staging dirty data (%).

• Cache Control Mode:?Specify the cache control mode.
• Detailed Trace Mode:?Specify the detailed trace mode.

3. Click Apply.
4. A confirmation message displays. Click OK to apply the settings.

To restore the default system tuning parameters:
1. From the Tools menu, select Tuning Parameter.

The Tuning Parameter panel displays.
2. Click the System tab.
3. Click Default.
4. A confirmation message displays. Click OK to apply the settings.
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ACE Tool
When you use the ACE Tool, you can get a connection diagram of the ENC 
wiring between the additional units and addresses of the additional units 
that have been set.

Automatic Setting
1. From the Tools menu, select the ACE Tool on the Array Unit screen.

The Configuration panel displays.

2. Click Base.
The Base dialog displays.

3. Enter a number of units connected to the RKM/RKAJ(Fibre), RKS/
RKAJ(Fibre) or RKXS.
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• WMS100: The total number of the RKXS and RKAJAT(SATA)/RKAAT 
(SATA) is not more than 7; the RKXS is one.

• AMS200: The total number of the RKS/RKAJs (Fibre) and RKAJATs 
(SATA) is not more than 7; the RKS/RKAJs(Fibre) is one or more.

• AMS500: The total number of the RKM/RKAJs(Fibre) and RKA 
(Fibre)/RKAJATs (SATA)/RKAATs (SATA) is not more than 15; the 
RKM/RKAJs(Fibre) is one or more.

• AMS1000: The total number of the RKAJs(Fibre) and RKA(Fibre)/
RKAJATs (SATA)/RKAATs(SATA) is not more than 30; the 
RKAJs(Fibre) is one or more.

4. Click OK.
The ENC wiring connection diagram and addresses of the additional units 
that have been set are created automatically.

NOTE: The supported expansion cabinets of the WMS100 are currently 
RKAAT/RKAJAT, but select RKAAT for RKAATL and RKAJAT for RKAJATL. It 
is displayed as RKAAT for RKAATL and RKAJAT for RKAJATL.
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5. Click Cable figure.
The Cable Figure displays.

6. Copy and paste the wiring cable figure that has been created when 
necessary. Click End.

7. Click End.
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Cable Figure Detail
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A
Collecting Navigator 2

Diagnostic Information

This appendix provides information on how to collect Navigator 2 
diagnostic information using the Navigator 2 CLI.

Available Diagnostic Information

Acquiring Failure Log Installation or Un-installation
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• Usage of the Hcmdsgetlogs Command
To collect diagnostic information regarding Navigator 2, use the 
hcmdsgetlogs command. Execute the command in the following format 
in the Base\bin directory under the Navigator 2 installed directory. 
(Windows is the default):
C:\Program Files\HiCommand, Linux/Solaris: /opt/Hicommand)

• Command format
Windows:
hcmdsgetlogs /dir DirectoryName [ /type StorageNavigatorModular ]
[ /arc FileName ]
Linux/Solaris:
hcmdsgetlogs -dir DirectoryName [ -type StorageNavigatorModular ]
[ -arc FileName ]

• Options

Available Diagnostic Information
When you execute the hcmdsgetlogs command, the following file is created 
in the directory specified by the /dir option. The following file name is the 
default file name, and it is created with another file name when specifying 
the /arc option.

Table A-1 Diagnostic Options and Arguments

Options and arguments Description

/dir DirectoryName Specify the directory that outputs the diagnostic 
information. The directory must be empty.

/type
StorageNavigatorModular

Specify that only the Navigator 2 diagnostic information 
be collected. If this option is not specified, the command 
also collects diagnostic information about the other 
Hitachi Storage Command products installed.

/arc FileName Specify the name of the diagnostic information file in 
which collected information will be output. If this option 
is not specified, the command crates the files with the 
default names (HiCommand_log.….jar).

Table A-2 Diagnostic Information Filenames

File Name (Default) Description

HiCommand_log.jar HiCommand Suite Common Component and Navigator 2 
specific log

HiCommand_log.hdb.jar Database detailed log

HiCommand_log.db.jar Database file

HiCommand_log.csv.jar Database table data
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Acquiring Failure Log Installation or Un-installation
When a failure occurs in the installation or un-installation, acquire a log of 
the installer or uninstaller using the following procedure.
• When the hcmdsgetlogs command is provided

Acquire the log using the procedure the section A.1.
• When the hcmdsgetlogs command is not provided or execution of the 

command fails
When a failure occurs in the middle of the installation or un-installation, 
the hcmdsgetlogs command may be unable to be used. In this case, 
acquire the following files manually. (An asterisk (“*”) in the file name 
indicates an optional character string. Acquire all files concerned.)
Windows:

C:\hcmds*
C:\snm2inst*
(When Windows is installed in a place other than the drive C, the file 
is created immediately under the root folder of a drive in which 
Windows is installed.)

Linux or Solaris:
/tmp/hcmds*

/tmp/snm2inst*
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B
Performance Output Text

File Information

This appendix provides details on the information obtained when 
acquiring performance information

Working with Acquired Information
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Working with Acquired Information
The following table details acquired information.

A

Selected 
Item List Items Contents

Port Port Port number (The maximum numbers of 
resources

IO Rate (IOPS) Received number of Read/Write commands 
per second

Read Rate (IOPS) Received number of Read commands per 
second

Write Rate (IOPS) Received number of Write commands per 
second

Read Hit (%) Rate of cache-hitting within the received Read 
command

Write Hit (%) Rate of cache-hitting within the received Write 
command

Trans. Rate (MB/s) Transfer size of Read/Write commands per 
second

Read Trans. Rate (MB/s) Transfer size of Read commands per second

Write Trans. Rate (MB/s) Transfer size of Write commands per second

Read CMD Count Received number of Read commands

Write CMD Count Received number of Write commands

Read CMD Hit Count Number of the Read commands that had been 
cache-hit

Write CMD Hit Count Number of the Write commands, which could 
write data immediately to the cache

Read Trans. Size (MB) Transfer size of Read commands

Write Trans. Size (MB) Transfer size of Write commands

CTL CMD IO Rate (IOPS) Received number of Initiator control 
commands per second

Data CMD IO Rate (IOPS) Received number of Initiator data commands 
per second

CTL CMD Trans. Rate (KB/s) Transfer size of Initiator control commands per 
second

Data CMD Trans. Rate (MB/
s) 

Transfer size of Initiator data commands per 
second 

CTL CMD Time (microsec.) Average response time of Initiator commands

Data CMD Time (microsec.) Average response time of Initiator data 
commands

CTL CMD Count Number of Initiator control commands

Data CMD Count Number of Initiator data commands

CTL CMD Trans. Size (KB) Transfer size of Initiator control commands
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Data CMD Trans. Size (MB) Transfer size of Initiator data commands

CTL CMD Max Time 
(microsec.) 

Maximum response time of control commands 
of Initiator

Data CMD Max Time 
(microsec.)

Maximum response time of data commands of 
Initiator

Timeout Error Count t Timeout error coun

Random IO Rate (IOPS) Received number of Random Read/Write 
commands per second

Random Read Rate (IOPS) Received number of Random Read commands 
per second

Random Write Rate (IOPS) Received number of Random Write commands 
per second

Random Trans. Rate (MB/s) Transfer size of Random Read/Write 
commands per second

Random Read Trans. Rate 
(MB/s) 

Transfer size of Random Read commands per 
second 

Random Write Trans. Rate 
(MB/s)

Transfer size of Random Write commands per 
second

Random Read CMD Count Received number of Random Read commands

Random Write CMD Count Received number of Random Write commands

Random Read Trans. Size 
(MB)

Transfer size of Random Read commands

Random Write Trans. Size 
(MB)

Transfer size of Random Write commands

Sequential IO Rate (IOPS) Received number of Sequential Read/Write 
commands per second

Sequential Read Rate (IOPS) Received number of Sequential Read 
commands per second

Sequential Write Rate (IOPS) Received number of Sequential Write 
commands per second

Sequential Trans. Rate 
(MB/s) 

Transfer size of Sequential Read/Write 
commands per second

Sequential Read Trans. Rate 
(MB/s)

Transfer size of Sequential Read commands 
per second

Sequential Write Trans. Rate 
(MB/s) 

Transfer size of Sequential Write commands 
per second 

Sequential Read CMD Count Received number of Sequential Read 
commands 

Sequential Write CMD Count Received number of Sequential Write 
commands

Sequential Read Trans. Size 
(MB)

Transfer size of Sequential Read commands

Sequential Write Trans. Size 
(MB) 

Transfer size of Sequential Write commands

A

Selected 
Item List Items Contents
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XCOPY Rate (IOPS) Received number of XCOPY commands per 
second

XCOPY Read Rate (IOPS) Received number of XCOPY Read commands 
per second

XCOPY Write Rate (IOPS) Received number of XCOPY Write commands 
per second 

XCOPY Read Trans. Rate 
(MB/s)

Transfer size of XCOPY Read commands per 
second

XCOPY Write Trans. Rate 
(MB/s)

Transfer size of XCOPY Write commands per 
second

XCOPY Time (microsec.) Response time of XCOPY commands

XCOPY Max Time (microsec.) Max response time of XCOPY commands

RAID Groups 
DP Pools

RAID Group/DP Pool RAID group/DP pool number that have been 
defined

IO Rate (IOPS) Received number of Read/Write commands 
per second

Read Rate (IOPS) Received number of Read commands per 
second

Write Rate (IOPS) Received number of Write commands per 
second

Read Hit (%) Rate of cache-hitting within the received Read
command

Write Hit (%) Rate of cache-hitting within the received Write 
command

Trans. Rate (MB/s) Transfer size of Read/Write commands per 
second

Read Trans. Rate (MB/s) Transfer size of Read commands per second

Write Trans. Rate (MB/s) Transfer size of Write commands per second

Read CMD Count Received number of Read commands

Write CMD Count Received number of Write commands

Read CMD Hit Count Number of the Read commands that had been 
cache-hit

Write CMD Hit Count Number of the Write commands, which could 
write data immediately to the cache

Read Trans. Size (MB) Transfer size of Read commands

Write Trans. Size (MB) Transfer size of Write commands

Random IO Rate (IOPS) Received number of Random Read/Write 
commands per second

Random Read Rate (IOPS) Received number of Random Read commands 
per second

Random Write Rate (IOPS) Received number of Random Write commands 
per second

Random Trans. Rate (MB/s) Transfer size of Random Read/Write 
commands per second

A

Selected 
Item List Items Contents
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Random Read Trans. Rate 
(MB/s)

Transfer size of Random Read commands per 
second

Random Write Trans. Rate 
(MB/s)

Transfer size of Random Write commands per 
second

Random Read CMD Count Received number of Random Read commands

Random Write CMD Count Received number of Random Write commands

Random Read Trans. Size 
(MB)

Transfer size of Random Read commands

Random Write Trans. Size 
(MB)

Transfer size of Random Write commands

Sequential IO Rate (IOPS) Received number of Sequential Read/Write 
commands per second

Sequential Read Rate (IOPS) Received number of Sequential Read 
commands per second

Sequential Write Rate (IOPS) Received number of Sequential Write 
commands per second

Sequential Trans. Rate 
(MB/s)

Transfer size of Sequential Read/Write 
commands per second

Sequential Read Trans. Rate 
(MB/s)

Transfer size of Sequential Read commands 
per second

Sequential Write Trans. Rate 
(MB/s) 

Transfer size of Sequential Write commands 
per second

Sequential Read CMD Count Received number of Sequential Read 
commands

Sequential Write CMD Count Received number of Sequential Write 
commands

Sequential Read Trans. Size 
(MB)

Transfer size of Sequential Read commands

Sequential Write Trans. Size 
(MB)

Transfer size of Sequential Write commands

XCOPY Rate (IOPS) Received number of XCOPY commands per 
second

XCOPY Read Rate (IOPS) Received number of XCOPY Read commands 
per second

XCOPY Write Rate (IOPS) Received number of XCOPY Write commands 
per second

XCOPY Read Trans. Rate 
(MB/s)

Transfer size of XCOPY Read commands per 
second

XCOPY Write Trans. Rate 
(MB/s) 

Transfer size of XCOPY Write commands per 
second

XCOPY Time (microsec.) Response time of XCOPY commands

XCOPY Max Time (microsec.) Max response time of XCOPY commands

Logical Unit 
DP Pool 

LUN Logical unit number that have been defined

A

Selected 
Item List Items Contents
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IO Rate (IOPS) Received number of Read/Write commands 
per second

Read Rate (IOPS) Received number of Read commands per 
second

Write Rate (IOPS) Received number of Write commands per 
second

Read Hit (%) Rate of cache-hitting within the received Read
command

Write Hit (%) Rate of cache-hitting within the received Write
command

Trans. Rate (MB/s) Transfer size of Read/Write commands per 
second

Read Trans. Rate (MB/s) Transfer size of Read commands per second

Write Trans. Rate (MB/s) Transfer size of Write commands per second

Read CMD Count Received number of Read commands

Write CMD Count Received number of Write commands

Read CMD Hit Count Number of the Read commands that had been 
cache-hit

Write CMD Hit Count Number of the Write commands, which could 
write data immediately to the cache

Read Trans. Size (MB) Transfer size of Read commands

Write Trans. Size (MB) Transfer size of Write commands

Read CMD Hit Count2 Number of the Hit Read Special Path 
commands out of the read commands that 
made cache hits

Read CMD Hit Time 
(microsec.) 

The average response time of the Hit Read 
Special Path commands

Read CMD Hit Max Time 
(microsec.) 

The maximum response time of the Hit Read 
Special Path commands

Write CMD Hit Count2 Number of the Write Special Path commands 
out of the Write commands, which could write 
data immediately to the cache

Write CMD Hit Time 
(microsec.)

The average response time of the Write 
Special Path commands

Write CMD Hit Max Time 
(microsec.)

The maximum response time of the Write 
Special Path commands

Read CMD Miss Count The number of the Miss Read Special Path 
commands out of the Read commands that 
made no cache hits

Read CMD Miss Time 
(microsec.)

The average response time of the Miss Read 
Special Path commands

Read CMD Miss Max Time 
(microsec.) 

The maximum response time of the Miss Read 
Special Path commands

A

Selected 
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Write CMD Miss Count The number of the Random Write Special Path
commands that could complete the high-speed 
process up to the parity generation that is an 
extended process of the Write commands

Write CMD Miss Time 
(microsec.)

The average response time of the Random 
Write Special Path commands

Write CMD Miss Max Time 
(microsec.) 

The maximum response time of the Random 
Write Special Path commands

Read CMD Job Count The number of the Read commands that could 
not perform the high-speed process

Read CMD Job Time 
(microsec.)

The average response time of the Read 
command job

Read CMD Job Max Time 
(microsec.) 

The maximum response time of the Read 
command job

Write CMD Job Count The number of the Write commands that could 
not perform the high-speed process

Write CMD Job Time 
(microsec.)

The average response time of the Write 
command job

Write CMD Job Max Time 
(microsec.)

The maximum response time of the Write 
command job

Read Hit Delay CMD Count 
(<300 ms)

The number of commands, whose response 
time is 100 ms to less than 300 ms, out of the 
Hit Read Special Path commands

Read Hit Delay CMD Count 
(300-499 ms)

The number of commands, whose response 
time is in a range of 300 ms to 499 ms, out of 
the Hit Read Special Path commands

Read Hit Delay CMD Count 
(500-999 ms)

The number of commands, whose response 
time is in a range of 500 ms to 999 ms, out of 
the Hit Read Special Path commands

Read Hit Delay CMD Count 
(1000 ms-) 

The number of commands, whose response 
time is 1000 ms or more, out of the Hit Read 
Special Path commands

Write Hit Delay CMD Count 
(<300 ms) 

The number of commands, whose response 
time is 100 ms to less than 300 ms, out of the 
Write Special Path commands

Write Hit Delay CMD Count 
(300-499 ms)

The number of commands, whose response 
time is in a range of 300 ms to 499 ms, out of 
the Write Special Path commands

Write Hit Delay CMD Count 
(500-999 ms)

The number of commands, whose response 
time is in a range of 500 ms to 999 ms, out of 
the Write Special Path command 

Write Hit Delay CMD Count 
(1000 ms-) 

The number of commands, whose response 
time is 1000 ms or more, out of the Write 
Special Path commands

Read Miss Delay CMD Count 
(<300 ms) 

The number of commands, whose response 
time is 100 ms to less than 300 ms, out of the 
Miss Read Special Path commands

A
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Read Miss Delay CMD Count 
(300-499 ms) 

The number of commands, whose response 
time is in a range of 300 ms to 499 ms, out of 
the Miss Read Special Path commands

Read Miss Delay CMD Count 
(500-999 ms) 

The number of commands, whose response 
time is in a range of 500 ms to 999 ms, out of 
the Miss Read Special Path commands

Read Miss Delay CMD Count 
(1000 ms-) 

The number of commands, whose response 
time is 1000 ms or more, out of the Miss Read 
Special Path commands

Write Miss Delay CMD Count 
(<300 ms) 

The number of commands, whose response 
time is 100 ms to less than 300 ms, out of the 
Random Write Special Path commands

Write Miss Delay CMD Count 
(300-499 ms)

The number of commands, whose response 
time is in a range of 300 ms to 499 ms, out of 
the Random Write Special Path commands

Write Miss Delay CMD Count 
(500-999 ms) 

The number of commands, whose response 
time is in a range of 500 ms to 999 ms, out of 
the Random Write Special Path commands

Write Miss Delay CMD Count 
(1000 ms-) 

The number of commands, whose response 
time is 1000 ms or more, out of the Random 
Write Special Path commands

Read Job Delay CMD Count 
(<300 ms) 

The number of commands, whose response 
time is 100 ms to less than 300 ms, out of the 
Read command job

Read Job Delay CMD Count 
(300-499 ms) 

The number of commands, whose response 
time is in a range of 300 ms to 499 ms, out of 
the Read command job

Read Job Delay CMD Count 
(500-999 ms)

The number of commands, whose response 
time is in a range of 500 ms to 999 ms, out of 
the Read command jo

Read Job Delay CMD Count 
(1000 ms-) 

The number of commands, whose response 
time is 1000 ms or more, out of the Read 
command job

Write Job Delay CMD Count 
(<300 ms)

The number of commands, whose response 
time is 100 ms to less than 300 ms, out of the 
Write command job

Write Job Delay CMD Count 
(300-499 ms) 

The number of commands, whose response 
time is in a range of 300 ms to 499 ms, out of 
the Write command job

Write Job Delay CMD Count 
(500-999 ms)v

The number of commands, whose response 
time is in a range of 500 ms to 999 ms, out of 
the Write command job

Write Job Delay CMD Count 
(1000 ms-) 

The number of commands, whose response 
time is 1000 ms or more, out of the Write 
command job

Tag Count (Logical Unit only) Maximum multiplicity of commands between 
intervals

A
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Average Tag Count (Logical 
Unit only)

Average multiplicity of commands between 
intervals

Data CMD IO Rate (IOPS) Sent number of Initiator data commands per 
second

Data CMD Trans. Rate
(MB/s)

Transfer size of Initiator data commands per 
second

Data CMD Count Received number of Initiator data commands

Data CMD Trans. Size (MB) Transfer size of Initiator data commands

Data CMD Time (microsec.) Response time of Initiator data commands

Data CMD Max Time 
(microsec.)

Max response time of Initiator data commands

Random IO Rate (IOPS) Received number of Random Read/Write 
commands per second

Random Read Rate (IOPS) Received number of Random Read commands 
per second

Random Write Rate (IOPS) Received number of Random Write commands 
per second

Random Trans. Rate (MB/s) Transfer size of Random Read/Write 
commands per second

Random Read Trans. Rate 
(MB/s)

Transfer size of Random Read commands per 
second

Random Write Trans. Rate 
(MB/s)

Transfer size of Random Write commands per 
second

Random Read CMD Count  Received number of Random Read commands

Random Write CMD Count  Received number of Random Write commands

Random Read Trans. Size 
(MB) 

Transfer size of Random Read commands

Random Write Trans. Size 
(MB)

Transfer size of Random Write commands

Sequential IO Rate (IOPS) Received number of Sequential Read/Write 
commands per second

Sequential Read Rate (IOPS) Received number of Sequential Read 
commands per second

Sequential Write Rate (IOPS) Received number of Sequential Write 
commands per second

Sequential Trans. Rate 
(MB/s) 

Transfer size of Sequential Read/Write 
commands per
second

Sequential Read Trans. Rate 
(MB/s)

Transfer size of Sequential Read commands 
per second

Sequential Write Trans. Rate 
(MB/s)

Transfer size of Sequential Write commands 
per second

Sequential Read CMD Count Received number of Sequential Read 
commands

A
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Sequential Write CMD Count Received number of Sequential Write 
commands

Sequential Read Trans. Size 
(MB) 

Transfer size of Sequential Read commands

Sequential Write Trans. Size 
(MB) 

Transfer size of Sequential Write commands

XCOPY Rate (IOPS) Received number of XCOPY commands per 
second 

XCOPY Read Rate (IOPS) Received number of XCOPY Read commands 
per second 

XCOPY Write Rate (IOPS) Received number of XCOPY Write commands 
per second

XCOPY Read Trans. Rate 
(MB/s) 

Transfer size of XCOPY Read commands per 
second

XCOPY Write Trans. Rate 
(MB/s) 

Transfer size of XCOPY Write commands per 
second

XCOPY Time (microsec.) Response time of XCOPY commands

XCOPY Max Time (microsec.) Max response time of XCOPY commands

Total Tag Count Maximum multiplicity of commands between 
intervals

Read Tag Count Maximum multiplicity of Read commands 
between intervals

Write Tag Count Maximum multiplicity of Write commands 
between intervals

Average Total Tag Count Average multiplicity of commands between 
intervals

Average Read Tag Count Average multiplicity of Read commands 
between intervals

Average Write Tag Count Average multiplicity of Write commands 
between intervals

Cache Write Pending Rate (%) Rate of cache usage capacity within the cache 
capacity

Clean Queue Usage Rate (%) Clean cache usage rate

Middle Queue Usage Rate 
(%) 

Middle cache usage rate

Physical Queue Usage Rate 
(%) 

Physical cache usage rate

Total Queue Usage Rate (%) Total cache usage rate

Processor Usage (%) Operation rate of the processor

Host-Cache Bus Usage Rate 
(%) 

The use rate of the bus between the host and 
the cache 

Drive-Cache Bus Usage Rate 
(%)

The use rate of the bus between the drive and 
the cache

A
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Processor-Cache Bus Usage 
Rate (%) 

The use rate of the bus between the processor 
and the cache

Cache (DRR) Bus Usage Rate 
(%)

 The use rate of the bus between the parity 
generation circuit (DRR) and the cache

Dual Bus Usage Rate (%) The use rate of the bus between the controllers

Total Bus Usage Rate (%) The total use rate of the cache bus

Drive Unit Unit number (The maximum numbers of 
resources that can be installed in the 
subsystem are displayed.)

HDU HDU number (The maximum numbers of 
resources that can be installed in the 
subsystem are displayed.)

IO Rate (IOPS) Received number of Read/Write commands 
per second

Read Rate (IOPS) Received number of Read commands per 
second

Write Rate (IOPS) Received number of Write commands per 
second

Trans. Rate (MB/s) Transfer size of Read/Write commands per 
second

Read Trans. Rate (MB/s) Transfer size of Read commands per second

Write Trans. Rate (MB/s) Transfer size of Write commands per second

Online Verify Rate (IOPS) Number of Online Verify commands per second

Read CMD Count Received number of Read commands

Write CMD Count Received number of Write commands

Read Trans. Size (MB) Transfer size of Read commands

Write Trans. Size (MB) Transfer size of Write commands

Online Verify CMD Count  Number of Online Verify commands

Drive 
Operation

Unit Unit number (The maximum numbers of 
resources that can be installed in the 
subsystem are displayed.)

HDU  HDU number (The maximum numbers of 
resources that can be installed in the 
subsystem are displayed.)

Operating Rate (%) Operation rate of the drive

Tag Count Maximum multiplicity of drive commands 
between intervals

Unload Time (min.) Unload time of the drive

Tag Average Average multiplicity of drive commands 
between intervals

Back-end Path  Path number (The maximum numbers of 
resources that can be installed in the 
subsystem are displayed.)

A

Selected 
Item List Items Contents
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IO Rate (IOPS)  Received number of Read/Write commands 
per second

Read Rate (IOPS) Received number of Read commands per 
second

Write Rate (IOPS) Received number of Write commands per 
second

Trans. Rate (MB/s) Transfer size of Read/Write commands per 
second

Read Trans. Rate (MB/s) Transfer size of Read commands per second

Write Trans. Rate (MB/s) Transfer size of Write commands per second

Online Verify Rate (IOPS) Number of Online Verify commands per second

Read CMD Count Received number of Read commands

Write CMD Count Received number of Write commands

Read Trans. Size (MB) Transfer size of Read commands

Write Trans. Size (MB) Transfer size of Write commands

Online Verify CMD Count Number of Online Verify commands

A

Selected 
Item List Items Contents

NOTE: For the cache hit of the Write command, the Write command 
performs the operation (write after) to respond to a host with the status at 
the time of completing write to the cache memory. Therefore, a case where 
write to the cache memory is immediately performed is defined as a hit and 
a case where write to the cache memory is waited for a reason that the 
cache memory is heavily used, etc. is defined as a miss.
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Glossary

This glossary defines the special terms used in this document.
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# 

1000Base-T
A specification for Gigabit Ethernet over copper wire. The standard 
defines 1 Gbps data transfer over distances of up to 100 meters using 
four pairs of Category 5 balanced copper cabling and a 5-level coding 
scheme.

A

abscissa
The horizontal coordinate of a point to in a plane Cartesian coordinate 
system obtained by measuring parallel to the x-axis.

ACK
Acknowledgement code

API
Application Programming Interface.

array
A set of hard disks mounted in a single enclosure and grouped logically 
together to function as one contiguous storage space.

asynchronous
Asynchronous data communications operate between a computer and 
various devices. Data transfers occur intermittently rather than in a 
steady stream. Asynchronous replication does not depend on 
acknowledging the remote write, but it does write to a local log file. 
Synchronous replication depends on receiving an acknowledgement 
code (ACK) from the remote system and the remote system also keeps 
a log file.

ATA
Advanced Technology Attachment, a disk drive implementation that 
integrates the controller on the disk drive.

ATM
Asynchronous Transfer Mode, a cell relay, packet switching network and 
data link layer protocol which encodes data traffic into small (53 bytes; 
48 bytes of data and 5 bytes of header information) fixed-sized cells. 
ATM provides data link layer services that run over Layer 1 links. This 
differs from other technologies based on packet-switched networks 
(such as the Internet Protocol or Ethernet), in which variable sized 
packets are used. ATM is a connection-oriented technology, in which a 
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logical connection is established between the two endpoints before the 
actual data exchange begins.

B

background copy
A physical copy of all tracks from the source volume to the target 
volume.

bind
To assign a value to a symbolic placeholder. For example, when a 
program is bound, or linked, the binder (Bind) replaces the symbolic 
addresses in the code with real machine addresses.

BIOS
Basic Input Output System. Built-in software code that determines the 
functions that a computing device can perform without accessing 
programs from a disk.

bps
Bits per second, the standard measure of data transmission speeds.

BSD syslog protocol
A protocol used for the transmission of event notification messages 
across networks for many years. Originally developed for the University 
of California Berkeley Software Distribution (BSD) TCP/IP system 
implementations, its value to operations and management has led it to 
be ported to other operating systems and to being embedded into 
many other networked devices.

C

Cache
A temporary, high-speed storage mechanism. It is a reserved section of 
main memory or an independent high-speed storage device. Two types 
of caching are found in computers: memory caching and disk caching. 
Memory caches are built into the architecture of microprocessors and 
often computers have external cache memory. Disk caching works like 
memory caching; however, it uses slower, conventional main memory 
that on some devices is called a memory buffer.

cache fast write (CFW)
An attribute of record caching in which the cache fast write access 
function (either Simplex Write or Duplex Write) enables the specified 
record ID to be placed in the volatile control unit cache when a file-type 
macro is issued and the cache is available. If the cache is not available, 
the record is written directly to the DASD surface. A single write is 



Glossary–4

Hitachi Storage Navigator Modular 2 Advanced Settings User’s Guide

CA KD E F G H I J L M N O P Q R S T U V W X Y# B Z
•

# A B C D F G H I L M N R S T

issued to the prime module only or a duplexed write is issued to both 
the prime and the duplicate modules.

Canadian Electroacoustic Community
Canada’s national electroacoustic / computer music / sonic arts 
organization.

Capacity
The amount of information (usually expressed in gigabytes) that can be 
stored on a disk drive. It is the measure of the potential contents of a 
device; the volume it can contain or hold. In communications, capacity 
refers to the maximum possible data transfer rate of a communications 
channel under ideal conditions.

cascade configuration
A cascade configuration is a connection configuration of volume pairs 
Either the P-VOL or S-VOL from a pair belonging to one copy function, 
is used as a P-VOL or S-VOL for the other copy function. TrueCopy 
Extended Distance supports cascading with ShadowImage and 
SnapShot.

CCI
See command control interface.

Challenge Handshake Authentication Protocol
A security protocol that requires users to enter a secret for access.

channel
The link between the central processor and the peripherals. A channel 
can be the physical cabling that connects the nodes on a network, an 
electronic signal traveling over a pathway, or a sub-channel in a carrier 
frequency.

channel adapter (CHA)
Provides the channel interface control functions and inter-cache data 
transfer functions. It is used to convert the data format between count-
key data and fixed block architecture. The CHA contains an internal 
processor and 128 bytes of edit buffer memory. A more modern term 
for channel adapter is front end director (FED). The opposite is back 
end director (BED) which may also be called DKA in some HDS 
manuals.

channel extender
A device used to increase the communication distances between 
channelconnected mainframe computers or between a computer and 
peripheral devices such as workstations, printers, and storage devices. 
Optical fiber channel connections are part of the system.
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CHAP
See Challenge Handshake Authentication Protocol.

CLI
See command line interface.

cluster
A group of disk sectors. The operating system assigns a unique number 
to each cluster and then keeps track of files according to which clusters 
they use.

cluster capacity
The total amount of disk space in a cluster, excluding the space 
required for system overhead and the operating system. Cluster 
capacity is the amount of space available for all archive data, including 
original file data, metadata, and redundant data.

command control interface (CCI)
Hitachi's Command Control Interface software provides command line 
control of Hitachi array and software operations through the use of 
commands issued from a system host. Hitachi’s CCI also provides a 
scripting function for defining multiple operations.

command devices
Dedicated logical volumes that are used only by management software 
such as CCI, to interface with the storage systems. Command devices 
are not used by ordinary applications. Command devices can be shared 
between several hosts.

command line interface (CLI)
A method of interacting with an operating system or software using a 
command line interpreter. With Hitachi’s Storage Navigator Modular 
Command Line Interface, CLI is used to interact with and manage 
Hitachi storage and replication systems.

compression
The process of encoding data to reduce its size. Most IT applications 
use lossless compression, in which a technique is used that preserves 
the entire content of the original data, and from which the original data 
can be reconstructed exactly.

concurrency of S-VOL
Occurs when an S-VOL is synchronized by simultaneously updating an 
S-VOL with P-VOL data AND data cached in the primary host memory. 
Discrepancies in S-VOL data may occur if data is cached in the primary 
host memory between two write operations. This data, which is not 
available on the P-VOL, is not reflected on to the S-VOL. To ensure 
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concurrency of the S-VOL, cached data is written onto the P-VOL 
beforesubsequent remote copy operations take place.

concurrent copy
A management solution that creates data dumps, or copies, while other 
applications are updating that data. This allows end-user processing to 
continue. Concurrent copy allows you to update the data in the files 
being copied, however, the copy or dump of the data it secures does 
not contain any of the intervening updates.

configuration definition file
The configuration definition file describes the system configuration for 
making CCI operational in a TrueCopy Extended Distance Software 
environment. The configuration definition file is a text file created and/
or edited using any standard text editor, and can be defined from the 
PC where the CCI software is installed. The configuration definition file 
describes configuration of new TrueCopy Extended Distance pairs on 
the primary or remote storage system.

consistent internal data
In TrueCopy Extended Distance, after an update to the remote S-VOL 
iscompleted, the updated data is copied to the data pool. If a failure 
occurs during the subsequent update to the S-VOL (for example, an 
accident occurs at the primary site or the line is disconnected), the 
update is lost and the write sequence is not guaranteed. The remote 
storage system can restore the S-VOL using the consistent internal 
data from the previous update cycle that was stored in the data pool.

consistency group (CTG)
A group of two or more logical units in a file system or a logical volume. 
When a file system or a logical volume which stores application data, is 
configured from two or more logical units, these multiple logical units 
are managed as a consistency group (CTG) and treated as a single 
entity. A set of volume pairs can also be managed and operated as a 
consistency group.

consistency of S-VOL
A state in which a reliable copy of S-VOL data from a previous update 
cycle is available at all times on the remote storage system A consistent 
copy of S-VOL data is internally pre-determined during each update 
cycle and maintained in the remote data pool. When remote takeover 
operations are performed, this reliable copy is restored to the S-VOL, 
eliminating any data discrepancies. Data consistency at the remote site 
enables quicker restart of operations upon disaster recovery.

control unit (CU)
CPU component that implements microprocessor instructions.
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count-key data (CKD)
Count-key data is a format for encoding data on hard drives, typically 
used in the mainframe environment. It is a physical disc format (Count, 
Key, Data) introduced by IBM with the Series/360 2311 disks in 1964. 
Countkey- data (CKD) disks format each track as a new file is written 
on that track (all files have at least one track). CKD disks, like SCSI and 
IDE, have sector (count) ID fields and data fields. CKD disks can also 
have a third kind of field between ID and data called a key field.

CRC
Cyclical Redundancy Checking, a scheme for checking the correctness 
of data that has been transmitted or stored and retrieved. A CRC 
consists of a fixed number of bits computed as a function of the data to 
be protected, and appended to the data. When the data is read or 
received, the function is recomputed, and the result is compared to that 
appended to the data.

CSV
Comma-Separated Values.

CTG
See Consistency Group.

cycle time
A user specified time interval used to execute recurring data updates 
for remote copying. Cycle time updates are set for each storage system 
and are calculated based on the number of consistency groups CTG.

cycle update
Involves periodically transferring differential data updates from the P-
VOL to the S-VOL. TrueCopy Extended Distance Software remote 
replication processes are implemented as recurring cycle update 
operations executed in specific time periods (cycles).

D

Dark Fiber
An optical fibre cable that has been physically laid, but has not been 
activated. Fibre optic cable is generally laid in large increments and not 
all the fibres within the cable are activated at the outset.

data pool
One or more disk volumes designated to temporarily store un-
transferred differential data (in the local storage system or snapshots 
of backup data in the remote storage system). The saved snapshots are 
useful for accurate data restoration (of the P-VOL) and faster remote 
takeover processing (using the S-VOL).
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data volume
A volume that stores database information. Other files, such as index 
files and data dictionaries, store administrative information (metadata).

DDL
Data Definition Language.

device emulation
See logical volume image (LVI).

DHCP
Dynamic Host Configuration Protocol, allows a computer to join an 
IPbased network without having a pre-configured IP address. DHCP is a 
protocol that assigns unique IP addresses to devices, then releases and 
renews these addresses as devices leave and re-join the network.

differential data control
The process of continuously monitoring the differences between the 
data on two volumes and determining when to synchronize them.

differential data copy
The process of copying the updated data from the primary volume to 
the secondary volume. The data is updated from the differential data 
control status (the pair volume is under the suspended status) to the 
primary volume.

differential data copy
The process of copying the updated data from the primary volume to 
the secondary volume. The data is updated from the differential data 
control status (the pair volume is under the suspended status) to the 
primary volume.

Differential Management Logical Unit (DM-LU)
The volumes used to manage differential data in a storage system. In a 
TrueCopy Extended Distance system, there may be up to two DM 
logical units configured per storage system. For Copy-on-Write and 
ShadowImage, the DM-LU is an exclusive volume used for storing data 
when the array system is powered down.

differential-data
The original data blocks replaced by writes to the primary volume. In 
Copyon- Write, differential data is stored in the data pool to preserve 
the copy made of the P-VOL to the time of the snapshot.



Glossary–9

Hitachi Storage Navigator Modular 2 Advanced Settings User’s Guide

CA KD E F G H I J L M N O P Q R S T U V W X Y# B Z
•

# A B C D F G H I L M N R S T

direct access storage device (DASD) fast write (DFW)
An attribute of record caching (while DASD Fast Write Access is a 
function of record caching) in which a specified record ID is placed in 
the cache and nonvolatile storage when a file-type macro is issued. If 
the cache is not available or the nonvolatile storage is not available, the 
record is written directly to the DASD surface.

disaster recovery
A set of procedures to recover critical application data and processing 
after a disaster or other failure. Disaster recovery processes include 
failover and failback procedures.

disk array
An enterprise storage system containing multiple disk drives. Also 
referred to as “disk array device” or “disk storage system.”

disk controller unit (DKC)
Consists of Cache and other components except DKU.

DLM
Data Lifecycle Management, the policies, processes, practices, services 
and tools used to align the business value of data with the most 
appropriate and cost-effective storage infrastructure from the time data 
is created through its final disposition. Data is aligned with business 
requirements through management policies and service levels 
associated with performance, availability, recoverability, cost, etc.

DM-LU
See Differential Management-Logical Unit.

DNS manager
The Domain Name System (manager) provides host-name resolution 
services to clients. It also balances requests across all nodes to ensure 
maximum cluster throughput and availability.

Drive operation time
The period of time from when a command is issued to the drive to then 
the command has completed execution. The number of tags is the 
maximum number of tags per second.

dual copy
The process of simultaneously updating a P-VOL and S-VOL while using 
a single write operation.
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duplex
The transmission of data in either one or two directions. Duplex modes 
are full-duplex and half-duplex. Full-duplex is the simultaneous 
transmission of data in two direction. For example, a telephone is a full-
duplex device, because both parties can talk at once. In contrast, a 
walkie-talkie is a halfduplex device because only one party can transmit 
at a time.

DWDM
Dense Wave Division Multiplexing, used to multiplex optical signals of 
several dozen channels.

E

EMI
Electromagnetic interference—a disturbance caused in an electrical 
circuit by electromagnetic radiation emitted from an external source. 
The disturbance may interrupt, obstruct, or degrade the effective 
performance of the circuit.

encryption
The translation of data into a secret code to achieve data security. To 
read an encrypted file, a secret key or password is required for 
decryption.

entire copy
Copies all data in the primary volume to the secondary volume to make 
sure that both volumes are identical.

extender
A converter used to change signals when data is transmitted over long 
distances. For example, changing a fibre channel signal to a signal for 
dark fibre or an Ethernet (IP).

extent
A contiguous area of storage in a computer file system that is reserved 
for writing or storing a file.

F

fabric
The hardware that connects workstations and servers to storage 
devices in a SAN. The SAN fabric enables any-server-to-any-storage 
device connectivity through the use of Fibre Channel switching 
technology.
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failover
The automatic substitution of a functionally equivalent system 
component for a failed one. The term failover is most often applied to 
intelligent controllers connected to the same storage devices and host 
computers. If one of the controllers fails, failover occurs, and the 
survivor takes over its I/O load.

fallback
Refers to the process of restarting business operations at a local site 
using the P-VOL. It takes place after the storage systems have been 
recovered.

Fault tolerance
A system with the ability to continue operating, possibly at a reduced 
level, rather than failing completely, when some part of the system 
fails.

FC
See fibre channel.

FC-AL
Fibre Channel-Arbitrated Loop—fibre channel topology in which devices 
are connected in a one-way loop fashion in a ring topology.

FCIP
See Fibre Channel Internet Protocol.

FCP
Fibre-Channel Protocol.

fibre channel
A gigabit-speed network technology primarily used for storage 
networking.

Fibre Channel Internet Protocol (FCIP)
A tunneling protocol based on the TCP/IP which connects 
geographically distant fibre channel SANs without affecting fibre 
channel and IP protocols.

FIFO
See First In First Out.

firmware
Software embedded into a storage device. It may also be referred to as 
Microcode.
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First In First Out
One way Tuning options in SNM2 can be configured to organize and 
manipulate data relative to time and prioritization. Data that arrives 
first is handled by the subsystem first; data that arrives after is queued 
to be processed after the first batch of data are handled.

fixed block architecture
A model of disks in which storage space is organized as linear, dense 
address spaces of blocks of a fixed size. Abbreviated FBA, fixed block 
architecture is the disk model on which SCSI is predicated.

fixed-content data
An exact digital reproduction of a data file as it existed before the file 
was archived. Fixed-content data cannot be modified or deleted before 
its retention period expires.

full duplex
The concurrent transmission and the reception of data on a single link.

G

gateway
Functions as a node that enables user and application access into other 
networks.

Gbps
Gigabits per second.

Gigabit Ethernet (GbE)
A term describing various technologies for transmitting Ethernet frames 
at a rate of one gigabit per second, as defined by the IEEE 802.3-2005 
standard.

granularity of differential data
Refers to the size or amount of data transferred to the S-VOL during an 
update cycle. Since only the differential data in the P-VOL is transferred 
to the S-VOL, the size of data sent to S-VOL is often the same as that of 
data written to the P-VOL. The amount of differential data that can be 
managed per write command is limited by the difference between the 
number of incoming host write operations (inflow) and outgoing data 
transfers (outflow).

H

HBA
See Host bus adapter. 
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HCA cluster
An implementation of Hitachi Content Archiver. An HCA cluster is both a 
repository that stores terabytes of data and a gateway that enables 
access to that data.

HDD
Hard disk drive.

High Availability (HA) software
An application designed for use during a primary host or disk failure. 
The software switches the failed host to a standby host (fail-over). High 
Availability software must be installed on the primary and secondary 
hosts.

Host Bus Adapter
An I/O adapter that connects a host I/O bus to the memory system of a 
computer.

I

I/O
Input/output.

ICKDSF
Installs, initializes and maintains DASD, either under an operating 
system, or standalone.

IDE
Integrated drive electronics; see also ATA.

Internet Fibre Channel Protocol (iFCP)
A TCP/IP based protocol for connection of fibre channel data storage 
systems using the IP infrastructure together or instead of fibre channel 
switching and routing elements. Allows users to maintain the Fibre 
Channel architecture while gaining the benefits of IP networks.

initial copy
An initial copy operation involves copying all data in the primary 
volume to the secondary volume prior to any update processing. Initial 
copy is performed when a volume pair is created.

initiator
A system component that originates an I/O command over an I/O bus 
or network, such as an I/O adapters or network interface cards.
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initiator ports
A port-type used for main control unit port of Fibre Remote Copy 
function.

internal predetermined data
Also, internally determined data. See consistent internal data.

IOPS
I/O per second.

IOS
Internetwork Operating System.

IP-SAN
Block-level Storage Area Networks over TCP/IP using the iSCSI 
protocol.

iSCSI
Internet-Small Computer Systems Interface, a TCP/IP protocol for 
carrying SCSI commands over IP networks.

iSNS
Internet Storage Name Service, a protocol through which hosts can 
automatically discover and establish sessions with both fibre channel 
and IP-based storage resources in an IP storage network.

J

Java application
A program written in the Java™ programming language that can be 
included in an HTML page. When you use a Java technology-enabled 
browser to view a page that contains an applet, the applet's code is 
transferred to your system and executed by the browser's Java Virtual 
Machine (JVM).

journal volume
A volume that records and stores a log of all events that take place in 
the volume. In the event of a system crash, the journal volume logs are 
used to restore lost data and maintain data integrity.

JRE
Java Runtime Environment.
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L

LAN

Local Area Network. A computer network that spans a relatively small 
area, such as a single building or group of buildings.

link aggregation
A computer networking term which describes using multiple Ethernet 
network cables/ports in parallel to increase the link speed beyond the 
limits of any one single cable or port, and to increase the redundancy 
for higher availability.

load
In UNIX computing, the system load is a measure of the amount of 
work that a computer system is doing.

logical
Describes a user's view of the way data or systems are organized. The 
opposite of logical is physical, which refers to the real organization of a 
system. A logical description of a file is that it is a quantity of data 
collected together in one place. The file appears this way to users. 
Physically, the elements of the file could live in segments across a disk.

logical unit
See logical unit number.

logical unit number (LUN)
An address for an individual disk drive, and by extension, the disk 
device itself. Used in the SCSI protocol as a way to differentiate 
individual disk drives within a common SCSI target device, like a disk 
array. LUNs are normally not entire disk drives but virtual partitions (or 
volumes) of a RAID set.

logical volume
An area on a disk consisting of device files that are logically integrated 
using a volume manager.

logical volume image (LVI)
A feature used to create virtual logical units that are up to 36 times 
larger than the standard OPEN-x logical units.

LU
Logical unit.



Glossary–16

Hitachi Storage Navigator Modular 2 Advanced Settings User’s Guide

CA KD E F G H I J L M N O P Q R S T U V W X Y# B Z
•

# A B C D F G H I L M N R S T

LUN
See logical unit number.

LUN Manager
This storage feature is operated through Storage Navigator Modular 2 
software and manages access paths among host and logical units for 
each port in your array.

LVM
Logical volume manager. In general, logical volume management 
provides a higher-level view of the disk storage on a computer system 
than the traditional view of disks and partitions. This gives the system 
administrator much more flexibility in allocating storage to applications 
and users.

M

mainframe
A large and expensive computer capable of simultaneously supporting 
thousands of users. In this document the term mainframe is used for 
IBM computers (zSeries® and S/390®-based systems). This term also 
marks a distinction between Unix or Windows server computers and the 
larger more, powerful mainframe. A mainframe is also commonly 
referred to as the host, even though any computer host having a 
unique IP address can equally be referred to as a host.

MDB
Master Directory Block.

metadata
In sophisticated data systems, the metadata -- the contextual 
information surrounding the data -- will also be very sophisticated, 
capable of answering many questions that help understand the data.

MIB
Message Information Block

microcode
The lowest-level instructions directly controlling a microprocessor. 
Microcode is generally hardwired and cannot be modified. It is also 
referred to as firmware embedded in a storage subsystem.

Microsoft Cluster Server
Microsoft Cluster Server is a clustering technology that supports 
clustering of two NT servers to provide a single fault-tolerant server.
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Middleware
Software that connects two otherwise separate applications. For 
example, a middleware product can be used to link a database system 
to a Web server. Using forms, users request data from the database; 
then, based on the user's requests and profile, the Web server returns 
dynamic Web pages to the user.

mount
To mount a device or a system means to make a storage device 
available to a host or platform.

mount point
The location in your system where you mount your file systems or 
devices. For a volume that is attached to an empty folder on an NTFS 
file system volume, the empty folder is a mount point. In some systems 
a mount point is simply a directory.

multiple allegiance support
With multiple allegiance support the storage unit can accept concurrent 
I/O requests for a volume from multiple channel paths. Thus, the 
storage unit can process requests from separate FICON hosts in 
parallel, improving throughput and performance.

multiple virtual storage
MVS is an operating system that runs on IBM or compatible mainframe 
computers. The host component works on MVS/ESA (Enterprise 
Systems Architecture) and MVS/XA (Extended Architecture).

Multiplex command
Multiplexing refers to a process where multiple analog message signals 
or digital data streams are combined into one signal. The aim is to 
share an expensive resource.

MU
Mirrored unit.

N

NAS
National Electrical Co

Netboot device
A technology from Apple that enables New World ROM Macs to boot 
from a network.
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Network switch (network attached)
A computer networking device that connects network segments.

NIC
Network Interface Card. An expansion board in a computer that allows 
the computer to connect to a network.

NIS
Network Information Service, Sun Microsystems’ client-server directory 
service protocol for distributing system configuration data such as user 
and host names between computers on a computer network.

node
In networks, a node is a processing location. A node can be a computer 
or other device, such as a printer. Every node has a unique network 
address.

NSC
Network Storage Controller.

NTP
Network Time Protocol, a protocol for synchronizing the clocks of 
computer systems over packet-switched, variable-latency data 
networks. NTP uses UDP port 123 as its transport layer. It is designed 
particularly to resist the effects of variable latency (jitter).

O

OSI
Open Systems Interconnection, a networking industry effort to provide 
common network standards for multi-vendor interoperability.

P

pair
Refers to two logical volumes that are associated with each other for 
data management purposes (e.g., replication, migration). A pair is 
usually composed of a primary or source volume and a secondary or 
target volume as defined by the user.

pair splitting
The operation that splits a pair. When a pair is "Paired", all data written 
to the primary volume is also copied to the secondary volume. When 
the pair is “Split”, the primary volume continues being updated, but 
data in the secondary volume remains as it was at the time of the split, 
until the pair is re-synchronized.
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pair status
Internal status assigned to a volume pair before or after pair 
operations. Pair status transitions occur when pair operations are 
performed or as a result of failures. Pair statuses are used to monitor 
copy operations and detect system failures.

paired volume
Two volumes that are paired in a disk array.

panel
Equivalent to a window.

parity
The technique of checking whether data has been lost or corrupted 
when it's transferred from one place to another, such as between 
storage units or between computers. It is an error detection scheme 
that uses an extra checking bit, called the parity bit, to allow the 
receiver to verify that the data is error free. Parity data in a RAID array 
is data stored on member disks that can be used for regenerating any 
user data that becomes inaccessible.

parity groups
RAID groups can contain single or multiple parity groups where the 
parity group acts as a partition of that container.

path blockade watch
Specifies the time for monitoring blockade in the Fibre Channel paths 
on the main control unit side. The path blockade watch value must be 
from 0 to 45 seconds. This setting is available for the Fibre Channel 
interface only.

pattern file
A table that contains the access attributes of all logical volumes. 
Pattern files enable administrators to change the access attributes of all 
logical volumes quickly and easily.

payload
In communication, telecommunications and information science, the 
payload or mission bit stream is the data, such as a data field, block, or 
stream, being processed or transported — the part that represents user 
information and user overhead information. It may include user-
requested additional information, such as network management and 
accounting information. Note that the payload does not include system 
overhead information for the processing or transportation system.
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PCI
Power Control Interface.

peer-to-peer remote copy (PPRC)
A hardware-based solution for mirroring logical volumes from a primary 
site (the application site) onto the volumes of a secondary site (the 
recovery site).

point-in-time logical copy
A logical copy or snapshot of a volume at a point in time. This enables a 
backup or mirroring application to run concurrently with the system.

point-to-point
A configuration that allows two ports to connect serially.

pool volume
Used to store backup versions of files, archive copies of files, and files 
migrated from other storage.

POSIX
Portable Operating System Interface for UNIX, a set of standards that 
define an application programming interface (API) for software 
designed to run under heterogeneous operating systems.

primary or local site
The host computer where the primary volume of a remote copy pair 
(primary and secondary volume) resides. The term “primary site” is 
also used for host failover operations. In that case, the primary site is 
the host computer where the production applications are running, and 
the secondary site is where the backup applications run when the 
applications on the primary site fail, or where the primary site itself 
fails.

primary volume (P-VOL)
The storage volume in a volume pair. It is used as the source of a copy 
operation. In copy operations a copy source volume is called the P-VOL 
while the copy destination volume is called "S-VOL" (secondary 
volume).

P-VOL
See primary volume.

Q
QOS
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Quality of Service, a networking term that specifies a guaranteed 
throughput level.

queue depth
When a host queues successive commands to the array before 
execution of a previous command can complete, the number of times 
successive commands are issued is called queue depth. When two or 
more hosts are connected to a port of tan array, the number of queue 
commands for the port is increased because the host issues commands 
to each array separately.

quota values
Set for write access enabled users and provide data storage limits for 
that user/volume. Quota values are applied to a snapshot and set for 
the target file system when the snapshot is taken.

R

RAID
An extension of the RAID 5 array. Allows for two simultaneous drive 
failures without downtime or data loss.

RAID 6
An extension of the RAID 5 array that allows for two simultaneous drive 
failures without downtime or data loss.

Recovery Point Objective (RPO)
After a recovery operation, the RPO is the maximum desired time 
period, prior to a disaster, in which changes to data may be lost. This 
measure determines up to what point in time data should be recovered. 
Data changes preceding the disaster are preserved by recovery.

Recovery Time Objective (RTO)
The maximum desired time period allowed to bring one or more 
applications, and associated data back to a correct operational state. It 
defines the time frame within which specific business operations or data 
must be restored to avoid any business disruption.

Redundant paths
The duplication of critical paths with the intention of increasing 
reliability.

Remote Control Unit target port
A port-type used for the remote control unit target port of Fibre Remote 
Copy function. This port allows login of host computers and main 
control units.
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remote or target site
Maintains mirrored data from the primary site.

remote path
A route connecting identical ports on the local storage system and the 
remote storage system. Two remote paths must be set up for each 
storage system (one path for each of the two controllers built in the 
storage system).

remote volume stem
In TrueCopy operations, the remote volume (R-VOL) is a volume 
located in a different subsystem from the primary host subsystem.

repeater
A network device used to regenerate or replicate a signal. A repeater 
relays messages between sub-networks that use different protocols or 
cable types. A repeater cannot do the intelligent routing performed by 
bridges and routers.

resynchronization
Refers to the data copy operations performed between two volumes in 
a pair to bring the volumes back into synchronization. The volumes in a 
pair are synchronized when the data on the primary and secondary 
volumes is identical.

RPO
See Recovery Point Objective.

RTC
Real-time clock.

RTO
See Recovery Time Objective.

S

SAN
Storage Area Network, a network of shared storage devices that 
contain disks for storing data.

SAS
Serial Attached SCSI, an evolution of parallel SCSI into a point-to-point 
serial peripheral interface in which controllers are linked directly to disk 
drives. SAS delivers improved performance over traditional SCSI 
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because SAS enables up to 128 devices of different sizes and types to 
be connected simultaneously.

SATA
Serial ATA is a computer bus technology primarily designed for the 
transfer of data to and from hard disks and optical drives. SATA is the 
evolution of the legacy Advanced Technology Attachment (ATA) 
interface from a parallel bus to serial connection architecture.

SCSI
Small Computer System Interface, a parallel interface standard that 
provides faster data transmission rates than standard serial and parallel 
ports.

secondary volume (S-VOL)
A replica of the primary volume (P-VOL) at the time of a backup and is 
kept on a standby storage system. Recurring differential data updates 
are performed to keep the data in the S-VOL consistent with data in the 
P-VOL.

sequential data striping
Writes data to multiple disk drives in a pre-planned sequence.

server set identifier (SSID)
A code attached to all packets on a wireless network to identify each 
packet as part of that network. The code is a case sensitive text string 
that consists of a maximum of 32 alphanumeric characters. All wireless 
devices attempting to communicate with each other must share the 
same SSID.

service
A set of functions within the Open Systems Interconnection (OSI) 
model. It enables delivery from one OSI layer to the layer above. For 
example, the TCP layer provides a reliable byte-stream service to the 
application layer above it.

SES
SCSI Enclosure Service.

session
A series of communications or exchanges of data between two end 
points that occurs during the span of a single connection. The session 
begins when the connection is established at both ends, and terminates 
when the connection is ended. For some applications each session is 
related to a particular port. In this document a session is the exchange 
of data between groups of primary and secondary volumes.
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sidefile
Holds data that changes or updates while a backup or other duplication 
is performed. The data may later be integrated back into the storage 
device.

SLA
Service Level Agreement.

SMB
Server Message Block, network protocol that allows shared access to 
files, printers, and serial points. SMB also allows clients to access files 
on a remote computer as if they were part of a local file system. See 
also Common Internet File System (CIFS) above.

SMPL
Simplex.

SMTP
Simple Mail Transfer Protocol, a protocol used to receive and store 
email data directly from email servers.

snapshot
A term used to denote a copy of the data and data-file organization on 
a node in a disk file system. A snapshot is a replica of the data as it 
existed at a particular point in time.

SNM2
See Storage Navigator Modular 2.

SNMP
Simple Network Management Protocol, a protocol used to facilitate 
monitoring and management of clusters through an external interface. 
SNMP sends notifications to IP addresses whenever certain types of 
events occur.

software initiator
A software application initiator communicates with a target device. A 
software initiator does not require specialized hardware because all 
processing is done in software, using standard network adapters.

SONET
Synchronous Optical Network.
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source copy
The original location from which data is taken or moved. The source can 
also indicate the node on a network from which data is sent to its 
destination.

SSL
Secure Sockets Layer, a key-based Internet protocol for transmitting 
documents through an encrypted link.

SSL certificate
A file containing the cryptographic keys and signatures used with an 
SSL protocol to verify the authenticity of web sites to protect data sent 
to or from that site.

status transition
The act of changing the pair status of the pair volume.

Storage Navigator Modular 2
A multi-featured scalable storage management application that is used 
to configure and manage the storage functions of Hitachi arrays. Also 
referred to as “Navigator 2”.

Subnet
In computer networks, a subnet or subnetwork is a range of logical 
addresses within the address space that is assigned to an organization. 
Subnetting is a hierarchical partitioning of the network address space of 
an organization (and of the network nodes of an autonomous system) 
into several subnets. Routers constitute borders between subnets. 
Communication to and from a subnet is mediated by one specific port 
of one specific router, at least momentarily.

suspended status
Occurs when the update operation is suspended while maintaining the 
pair status. During suspended status, the differential data control for 
the updated data is performed in the primary volume.

S-VOL
See secondary volume.

S-VOL determination
Independent of update operations, S-VOL determination replicates the 
SVOL on the remote storage system. This process occurs at the end of 
each update cycle and a pre-determined copy of S-VOL data, consistent 
with PVOL data, is maintained on the remote site at all times.
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Switch (such as a hub)
A network infrastructure component to which multiple nodes attach. 
Unlike hubs, switches typically have internal bandwidth that is a 
multiple of link bandwidth, and the ability to rapidly switch node 
connections from one to another. A typical switch can accommodate 
several simultaneous full link bandwidth transmissions between 
different pairs of nodes.

Sysplex
Denotes system complex. This is a processor complex formed by 
connecting a number of processors together into a single unit through 
channel-to-channel adapters or ESCON/FICON fiber optic links. The 
processors are synchronized using a Sysplex Timer and are managed 
as a single system image (SSI1). The Sysplex Timer is an invaluable 
component when systems on multiple CPCs share access to the same 
data.

system reduction
Refers to maintenance tasks that improve system performance in a 
replication environment. These tasks may include pair deletion, 
deletion of command devices, and data pools.

T

takeover processing
Involves transferring critical application processing to the S-VOL on the 
remote standby storage system. The remote S-VOL is immediately 
enabled to process subsequent host I/O operations.

target
Devices that receive iSCSI requests that originate from an iSCSI 
initiator.

target copy
A file, device, or any type of location to which data is moved or copied.

target port
A port-type which differs from an “Initiator Port” or “Remote Control 
Unit Target Port”. The target is used without configuration of Fibre 
Remote Copy. It allows LOGIN of host computers, but does not allow 
LOGIN of MCUs.

target site
See remote or target site.
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TCP (Transmission Control Protocol)
A transportation protocol that is one of the core protocols of the IP 
suite. The Internet protocol exchanges groups of information -- 
packets, which are short sequences of bytes consisting of a header and 
a body. In cases of congestion, the IP can discard packets, or, for 
efficiency reasons, route two consecutive packets differently over the 
internet to the destination, which can result in the packets arriving in 
the wrong order. TCP software provides a simpler interface to 
applications by hiding most of the underlying packet structures, 
rearranging out-of-order packets, minimizing network congestion, and 
re-transmitting discarded packets.

TID
Target ID.

tier architecture
Describes a layered structure of hardware development. Each layer in 
the structure is more complete and is supported more than the layer 
below it. Tier 1 is fully supported computing expected to be production 
quality. Tier 2 platforms are not supported by the security officer and 
release engineering teams. Tier 2 systems are targeted at Tier 1 
support, but are still under development. Tier 3 platforms are 
architectures for which hardware is not or will not be available or which 
are considered legacy systems unlikely to see broad future use. Tier 4 
systems are not supported in any way. Tier 1: Static content, Tier 2: 
Application logic, Tier 3: Database.

TOE
A dedicated chip or adapter that handles much of the TCP/IP processing 
directly in hardware. TCP/IP transmission is inherently a CPU-intensive 
operation. Therefore, using dedicated hardware that can operate in 
parallel with the main processor allows for superior system 
performance. Although all iSCSI HBAs have a TOE, a generic TOE only 
implements TCP/IP, while an iSCSI HBA implements the iSCSI protocol 
in addition to TCP/IP.

track
A ring on a disk where data can be written. For hard disks, tracks 
aggregate into platters. A single track location that cuts through all 
platters is termed a cylinder. Each track can be subdivided into a 
number of sectors allowing the operating system and disk drive to find 
stored information using its track and sector numbers.

Transparent
A failover from one component of a system to another that is 
transparent to the external operating environment. Often used to refer 
to paired disk controllers, one of which exports the other’s virtual disks 
at the same host bus addresses after a failure.
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trap
A program interrupt usually caused by some exceptional situation in a 
user program. In most cases, the OS performs an appropriate action 
and then returns control to the program.

truck size
Represents a fixed sector size for each volume type.

U

UDP
User Diagram Protocol.

User Datagram Protocol (UDP)
One of the core protocols of the Internet protocol suite. Using UDP, 
programs on networked computers can send short messages 
sometimes known as datagrams (using Datagram Sockets) to one 
another. UDP does not guarantee reliability or ordering in the way that 
TCP does. Datagrams may arrive out of order, appear duplicated, or go 
missing without notice. Avoiding the overhead of checking whether 
every packet actually arrived makes UDP faster and more efficient, at 
least for applications that do not need guaranteed delivery. Time-
sensitive applications often use UDP because dropped packets are 
preferable to delayed packets. UDP's stateless nature is also useful for 
servers that answer small queries from huge numbers of clients. Unlike 
TCP, UDP is compatible with packet broadcast (sending to all on local 
network) and multicasting (send to all subscribers).

V

VA
Validation Authority.

Virtual Local Area Network
An option that enables the configuration of custom-size logical device 
images and logical units, which are smaller than standard size devices. 
Virtual LVI/LUN is enables the configuration of custom-size logical 
device images and logical units, which are smaller than standard size 
devices.

virtual volume (V-VOL)
In Copy-on-Write, a secondary volume in which a view of the primary 
volume (P-VOL) is maintained as it existed at the time of the last 
snapshot. The V-VOL contains no data but is composed of pointers to 
data in the PVOL and the data pool. The V-VOL appears as a full volume 
copy to any secondary host.



Glossary–29

Hitachi Storage Navigator Modular 2 Advanced Settings User’s Guide

CA KD E F G H I J L M N O P Q R S T U V W X Y# B Z
•

# A B C D F G H I L M N R S T

VLAN
See Virtual Local Area Network.

volume
A disk array object that most closely resembles a physical disk from the 
operating environment's viewpoint. The basic unit of storage as seen 
from the host.

volume copy
Copies all data from the P-VOL to the S-VOL.

volume pair
Formed by pairing two logical data volumes. It typically consists of one 
primary volume (P-VOL) on the local storage system and one 
secondary volume (S-VOL) on the remote storage systems.

volume signature
An integer that is an element in the master directory block (MDB) 
(volume information block (VIB)). For example, for HFS volumes, this 
field (drSigWord) contains the number $4244.

V-VOL
See virtual volume.

V-VOLTL
Virtual Volume Tape Library.

W

WAN
Wide-Area Network.

WDM
Wavelength-division multiplexing, a technology which multiplexes 
multiple optical carrier signals on a single optical fibre by using 
different wavelengths (colors) of laser light to carry different signals. 
This allows for a multiplication in capacity, in addition to making it 
possible to perform bidirectional communications over one strand of 
fibre.

wide area network
A communications network that is geographically dispersed and that 
includes telecommunications links.
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WMS
Workgroup Modular Storage.

World Wide Name (WWN)
A unique identifier for an open systems host. It consists of a 64-bit 
physical address (the IEEE 48-bit format with a 12-bit extension and a 
4-bit prefix). The WWN is essential for defining the SANtinel™ 
parameters because it determines whether the open systems host is to 
be allowed or denied access to a specified logical unit or a group of 
logical units.

WORM
Write once, read many, a data storage technique in which files are 
protected from being modified, overwritten, or deleted.

write order guarantee
Ensures that data is updated in an S-VOL, in the same order that it is 
updated in the P-VOL, particularly when there are multiple write 
operations in one update cycle. This feature is critical to maintain data 
consistency in the remote S-VOL and is implemented by inserting 
sequence numbers in each update record. Update records are then 
sorted in the cache within the remote system, to assure write 
sequencing.

write workload
The amount of data written to a volume over a specified period of time.
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